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Symantec Technical Support maintains support centers globally. Technical
Support’s primary role is to respond to specific queries about product features
and functionality. The Technical Support group also creates content for our online
Knowledge Base. The Technical Support group works collaboratively with the
other functional areas within Symantec to answer your questions in a timely
fashion. For example, the Technical Support group works with Product Engineering
and Symantec Security Response to provide alerting services and virus definition
updates.

Symantec’s support offerings include the following:

m A range of support options that give you the flexibility to select the right
amount of service for any size organization

m Telephone and/or Web-based support that provides rapid response and
up-to-the-minute information

m Upgrade assurance that delivers software upgrades

m Global support purchased on a regional business hours or 24 hours a day, 7
days a week basis

m Premium service offerings that include Account Management Services

For information about Symantec’s support offerings, you can visit our Web site
at the following URL:

www.symantec.com/business/support/
All support services will be delivered in accordance with your support agreement
and the then-current enterprise technical support policy.

Contacting Technical Support
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Before contacting Technical Support, make sure you have satisfied the system
requirements that are listed in your product documentation. Also, you should be
at the computer on which the problem occurred, in case it is necessary to replicate
the problem.

When you contact Technical Support, please have the following information
available:

m Product release level
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Hardware information

Available memory, disk space, and NIC information

Operating system

Version and patch level

Network topology

Router, gateway, and IP address information

Problem description:

m Error messages and log files

m Troubleshooting that was performed before contacting Symantec

m Recent software configuration changes and network changes

Licensing and registration

If your Symantec product requires registration or a license key, access our technical
support Web page at the following URL:

www.symantec.com/business/support/

Customer service

Customer service information is available at the following URL:

www.symantec.com/business/support/

Customer Service is available to assist with non-technical questions, such as the
following types of issues:

Questions regarding product licensing or serialization

Product registration updates, such as address or name changes

General product information (features, language availability, local dealers)
Latest information about product updates and upgrades

Information about upgrade assurance and support contracts

Information about the Symantec Buying Programs

Advice about Symantec's technical support options

Nontechnical presales questions

Issues that are related to CD-ROMs, DVDs, or manuals
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Support agreement resources

If you want to contact Symantec regarding an existing support agreement, please
contact the support agreement administration team for your region as follows:

Asia-Pacific and Japan customercare_apac@symantec.com
Europe, Middle-East, and Africa semea@symantec.com

North America and Latin America supportsolutions@symantec.com
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Introduction

This chapter includes the following topics:

About NetBackup for VMware

NetBackup for VMware components

Media servers as backup or discovery hosts
Overview of the VMware backup process
NetBackup for VMware license requirement

NetBackup for VMware terminology

About NetBackup for VMware

NetBackup for VMware provides backup and restore of the VMware virtual
machines that run on VMware ESX servers. NetBackup for VMware takes advantage
of VMware vStorage APIs for data protection. The backup process is off-loaded
from the ESX server to a VMware backup host.

NetBackup for VMware does the following:

Performs off-host backup of virtual machines (NetBackup client software is
not required on the virtual machine). Off-host backup reduces the backup
processing load on the VMware host.

Increases the backup speed as compared to standard file-order backup methods,
if the virtual machine is heavily populated with small files.

Automatically creates quiesced snapshots using VSS (Windows only). Creates
quiesced snapshots on Linux if the SYMCquiesce utility is installed.

Uses snapshot technology to keep virtual machines 100% available to users.

Supports VMware vSphere.
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Performs full backups and incremental backups, including block-level
incrementals.

Backs up the full virtual machine.
Backs up the virtual machines even when they are turned off.

Can restore selected files from the backup.

New features for VMware in NetBackup 7.5

The following features are new in NetBackup 7.5:

Streamlined policy configuration for VMware

NetBackup includes a VMware policy type that simplifies policy configuration.
Backup options for VMware are now combined on a new VMware policy tab.
See “Upgrade guidelines for the new VMware policy type” on page 15.

The new VMware policy type uses vStorage to perform the backup (not VCB).
Support for VCB-based backups is still available for NetBackup 7.1 or earlier
clients by means of the FlashBackup-Windows policy type.

See “Support for VCB in NetBackup 7.5” on page 16.

If you upgrade to 7.5 from an earlier NetBackup release and do not use VCB,
you should convert your policies to the new VMware type. You can use the
nbplupgrade command (see next item).

New command (nbplupgrade) to convert a batch of policies from earlier 7.x to
7.5.

For details, see the nbplupgrade man page in the NetBackup Commands
Reference Guide.

Backup media server

NetBackup supports the use of a Windows media server as the backup host or
discovery host. This feature can provide host redundancy and faster backups.
See “Media servers as backup or discovery hosts” on page 20.

Extended capabilities for the Virtual Machine Intelligent Policy

For automatic selection of virtual machines for backup, the policy's Query
Builder adds several new datastore and network keywords for filtering virtual
machines. These keywords provide better integration with NFS and cloud
environments.

See “Query Builder field reference” on page 94.

The Host Properties Resource Limits dialog adds several resource types for
datastore.
See “Setting global limits on the use of VMware resources” on page 44.

NetBackup can send backup related events to the vCenter server.
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See “Viewing NetBackup activity in vSphere Client” on page 119.

m Support for vSphere version 5, including datastore clusters and Storage DRS
affinity rules.
See “Query Builder field reference” on page 94.
See “Virtual Machine Options dialog box” on page 132.

m Application Aware VMware Backup
During virtual machine backup, NetBackup can map the database files that
reside in the virtual machine. This feature enables recovery of individual
database files from the backup. This feature supports Microsoft Exchange
Server, SQL Server, and SharePoint Server.
See “ About the virtual machine backups that include database data”
on page 16.
See “Application protection options (VMware)” on page 56.
For details on restoring database files from a virtual machine backup, refer to
the NetBackup database agent guide for your application.

m Extended support for restore of individual files from Linux virtual machine
backups
Supports ext4 file systems for individual file recovery.
Details are available in the following tech note:
http://www.symantec.com/docs/TECH127089

Upgrade guidelines for the new VMware policy type
Note these guidelines for upgrading to the 7.5 VMware policy type:
m For VCB backups with the ESX servers that are older than 3.5 U2:
m The FlashBackup-Windows policy is required.

m The VCBbackup host (NetBackup Windows client) must be a pre-7.5 version,
for example 7.1.0.x.
See “Support for VCB in NetBackup 7.5” on page 16.

m To use the new VMware policy type, all master servers, media servers, and
clients must be upgraded to 7.5.

m Do not convert any FlashBackup-Windows policies until you have verified that
the current policies work correctly with 7.5.

FlashBackup-Windows policies can be converted in either of the following
ways:

m The NetBackup Administration Console policy editor, by changing the
policy type to VMware.


http://www.symantec.com/docs/TECH127089
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m The nbplupgrade CLI can be used to convert policies in a batch. For details,
see nbplupgrade in the NetBackup Commands Reference Guide.

Support for VCB in NetBackup 7.5

For NetBackup 7.5 environments (master server, media server, and backup host
all at 7.5), VCB backups are not supported. VCB backups are supported only when
the backup host (NetBackup client) is 7.1 or earlier. For VCB-based backups with
7.1 or earlier backup hosts, you can use the FlashBackup-Windows policy type as
described in the NetBackup for VMware Administrator's Guide, version 7.1 or 7.0.

VCBrestores are still supported for 7.5 clients, but will be discontinued in a future
release.

NetBackup will discontinue all VCB support in a future release. Upgrading to
vStorage is recommended.

File-level backup of Windows virtual machines

NetBackup 7.5 backs up the entire VMware virtual machine as virtual disk files.
The backup includes all data files as well as operating system files and VMware
virtual disk files. From the backup, you can recover the guest OS and the entire
virtual machine. Depending on the type of backup and the guest OS file system
type, you can also recover individual files from the same backup.

NetBackup 7.5 environments (master server, media server, and backup host all
at 7.5) do not support file-level backup of Windows virtual machines. Windows
file-level backup of a VMware virtual machine requires VCB. VCB is supported
only for 7.1 and earlier backup hosts (clients).

To use VCB to back up individual Windows files, the backup host must contain a
NetBackup client at 7.1 or earlier. For more information on Windows file-level
backup, refer to the 7.0 or 7.1 version of the NetBackup for VMware Administrator's
Guide.

About the virtual machine backups that include database data

When NetBackup backs up a VMware virtual machine, database data in the virtual
machine is backed up with the rest of the virtual machine. A new feature in
NetBackup 7.5 allows the recovery of individual database files from the backup.
This feature supports Microsoft Exchange Server, SQL Server, and SharePoint
Server.

Note the following:
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To enable restore of individual database files, a NetBackup Windows client
must be installed in the virtual machine during the backup.

NetBackup uses Windows Volume Shadow Copy Service (VSS) to quiesce the
database before it creates a snapshot of the virtual machine.

A full backup is performed of the database data with each backup job, even if
the policy schedule is incremental.

See “Application protection options (VMware)” on page 56.

Features for VMware added in NetBackup 7.1

The following features were added in NetBackup 7.1:

Virtual Machine Intelligent Policy

NetBackup can automatically select virtual machines for backup by means of
filtering rules in the policy. The policy Clients tab includes a Query Builder
for creating the rules. Requires vStorage.

See “About automatic virtual machine selection for NetBackup for VMware”
on page 72.

Limits on NetBackup use of virtual resources

You can limit the number of simultaneous backups that NetBackup performs
on VMware resources, such as vCenter servers or datastores. Applies only to
policies that use automatic selection of virtual machines.

See “Setting global limits on the use of VMware resources” on page 44.

In addition to host name, VMware display name, or UUID, NetBackup can now
back up virtual machines by their DNS host name.

The Browse for Virtual Machines screen allows manual selection of virtual
machines within VMware clusters and vApps.

Restore of individual files from Linux virtual machine backups.
See “NetBackup for VMware: notes on Linux virtual machines” on page 34.

NetBackup for VMware components

Table 1-1 describes the components that NetBackup for VMware uses.
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Table 1-1 Components of NetBackup for VMware
Component Description
Backup host NetBackup for VMware uses a special Windows host that is called a VMware backup host

(formerly called the VMware backup proxy server). The backup host is a NetBackup client
that performs backups on behalf of the virtual machines. The backup host must have access
to the datastores of the virtual machines.

The backup host is the only host on which NetBackup client software is installed. No NetBackup
client software is required on the VMware virtual machines.

Note that the backup host is referred to as the recovery host when it performs a restore.

The backup host can be configured in either of the following ways:

B As a NetBackup Windows client with a connection to separate master and media servers.
The master servers and media servers can be Windows, UNIX, or Linux.

m Or, the NetBackup Windows client and a Windows master and media server can all reside

on the same backup host. In this case, all NetBackup components (servers and client) must
be Windows.

Discovery host

Used for the automatic selection of virtual machines for backup. This host discovers virtual
machines and filters them by means of the selection rules in the policy Query Builder. The
resulting list determines which virtual machines are backed up.

The discovery host can be on any platform that NetBackup supports for master or media
servers. It can also be the same host as the backup host.

You specify this host on the policy Clients tab: Click Select automatically through query,
then NetBackup host to perform automatic virtual machine selection.

Backup media server

A Windows media server that can operate as the backup host.

See “Media servers as backup or discovery hosts” on page 20.

NetBackup client

Installed on the backup host (Windows).

NetBackup master
server

Manages the backups of virtual machines, by means of the NetBackup client that is installed
on the backup host.

NetBackup media
server

Performs the backups to storage on behalf of the NetBackup client.

Virtual machine

Virtual machines provide complete guest operating systems on virtualized hardware. In a
NetBackup policy, a virtual machine is configured as a NetBackup client, even though
NetBackup client software is not installed on the virtual machine.

ESX server

The VMware ESX server presents a virtualized hardware environment to multiple virtual
machines; each virtual machine runs an independent operating system. Users can run
applications in the virtualized OS as if the OS was installed in its own physical computer.
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Table 1-1 Components of NetBackup for VMware (continued)
Component Description
vCenter Server The VMware vCenter Server (or VirtualCenter server) coordinates multiple ESX servers and

workloads. It can migrate virtual machines from one ESX server to another. It also provides
the ability to back up the virtual machines that are turned off.

The vCenter Server is optional in the NetBackup for VMware environment.

Converter server For the backups that were made with VCB, the VMware Converter server assists in full virtual
machine restores to the ESX server. The Converter must be installed on the same host as the
backup host.

Note that the VMware NetBackup Integration Module (VNIM) is not required.
Conflicts can occur between NetBackup for VMware policies and any older
script-based policies that use VNIM.

Figure 1-1 shows a NetBackup for VMware environment on a local network. The
backup host accesses the VMware datastore through the ESX servers.

Figure 1-1 NetBackup for VMware: components on local network

NetBackup master server

UNIX, Linux, or Windows
LAN / WAN

vCenter
server

NetBackup media server
UNIX, Linux, or Windows

ESX
Backup host
NetBackup Windows client. servers ﬁjﬂ

(Can be combined with a
VMware

Windows master/media server)
Virtual machines datastore

OO@
OO

Figure 1-2 shows a NetBackup for VMware environment on a SAN. The backup
host accesses the VMware datastore directly over the SAN.
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Media servers as backup or discovery hosts

Figure 1-2 NetBackup for VMware: components on SAN
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(W X X0
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Media servers as backup or discovery hosts

NetBackup for VMware uses a special Windows host that is called a VMware
backup host. The backup host is a NetBackup client that performs off-host backups
of the virtual machines. The backup host must have access to the datastores of
the virtual machines. The backup host reads the data from the datastore and sends
it over the network to the media server. The media server backs up the data to
storage.

For the policies that automatically select virtual machines, the discovery host
filters virtual machines according to the rules in the policy Query Builder. The
discovery host returns a list of virtual machines to be selected for backup.

As a new feature in NetBackup 7.5, NetBackup can use media servers as backup
hosts and as discovery hosts.

Media servers acting as backup or discovery hosts can provide the following
advantages:

m Host redundancy: If one media server goes down, another media server takes
over.

m Faster backup: The media server can read the data from the datastore and send
the data straight to the storage device. Without media server access to storage
devices, an ordinary backup host must send the backup data over the local
network to the media server.
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Figure 1-3 shows a group of Windows media servers that can also act as backup
or discovery hosts. The media servers can discover virtual machines for automatic
selection, and perform off-host backups and send the backup data directly to
storage.

Figure 1-3 Windows backup media servers

NetBackup master server
UNIX, Linux, or Windows
LAN / WAN

vCenter

storage server

ESX
Windows media servers servers [j

Each has a NetBackup client
Vmware

Virtual machines datastore

OOa
OOa

You can combine the flexibility of backup media servers with a standard feature
of NetBackup: storage unit groups. Create a storage unit group that contains the
storage units that your Windows media servers can access. Any of the media
servers can operate as a backup host.

Note the following requirements:
m To configure media servers as backup hosts: Set the policy VMware backup

host field on the VMware tab to Backup Media Server.
See “VMware backup host selection” on page 52.

m To configure media servers as discovery hosts: Set the policy NetBackup host
to perform automatic virtual machine selection field on the Clients tab to
Backup Media Server.

See “ Options for selecting VMware virtual machines” on page 78.

Overview of the VMware backup process

The following tables describe the phases in the NetBackup backup process (for
vStorage).
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NetBackup for VMware license requirement

Table 1-2

NetBackup backup process with vStorage

Phase

Description

Phase 1

The NetBackup master server initiates the backup.

Phase 2

The NetBackup client on the VMware backup host initiates a VMware
snapshot on the virtual machine.

Phase 3

Windows: VSS synchronizes the file system on the virtual machine.

Linux: The SYMCquiesce utility can quiesce the file system on supported
Linux operating systems.

See “About the SYMCquiesce utility” on page 179.

Phase 4

The VMware server creates a snapshot on the virtual disk datastore.

Phase 5

The NetBackup client reads the snapshot from the datastores and writes
the data to the NetBackup storage unit.

NetBackup for VMware license requirement

NetBackup for VMware requires an Enterprise Client license for each ESX Server.

To protect an application or database, note: an additional license for the
appropriate NetBackup package is needed for each ESX server that hosts the
application or database.

NetBackup for VMware terminology

Table 1-3 lists the terminology that is used in NetBackup for VMware.

For further explanations of VMware terminology, refer to your VMware
documentation.
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Table 1-3 NetBackup for VMware terms
Term Definition
backup host The backup host is a NetBackup client that performs backups on

behalf of the virtual machines. (This host was formerly known as
the VMware backup proxy server.) The backup host is the only
host on which NetBackup client software is installed.

As an option, the backup host can also be configured as a
NetBackup master server or media server.

The backup host is referred to as the recovery host when it
performs a restore.

See “NetBackup for VMware components” on page 17.

backup media server

A media server that operates as a backup host.

datastore

In NetBackup for VMware, the datastore is a disk that contains
the virtual machines files.

datastore cluster

A collection of datastores that can be managed as a single unit.
VMware Storage DRS manages the storage resources of the cluster.

discovery host

Discovers the virtual machines, filters them according to the rules
in the Query Builder, and returns a list of machines to be selected
for backup. The discovery host is used only for automatic selection
of virtual machines.

Can be the same host as the VMware backup host.

See “NetBackup for VMware components” on page 17.

guest OS

An operating system that runs on a virtual machine.

hypervisor

A software virtualization layer that lets different operating
systems run simultaneously on the same physical computer. The
VMware hypervisor is vSphere, which runs on the ESX server
host.
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Table 1-3 NetBackup for VMware terms (continued)
Term Definition
independent disk A virtual disk that cannot be captured with a snapshot. An

independent disk can be configured as either persistent or
temporary.

Note: NetBackup for VMware cannot back up the data on an
independent disk. The backup succeeds but the backup image
contains no data for the independent disk. If you restore the disk
from the backup, the independent disk is restored to its original
allocation size but contains no data. For example, the Windows
swap file can reside on an independent disk, and is consequently
not included in the virtual machine backup.

To back up the data on an independent disk, install a NetBackup
client on the virtual machine.

See “NetBackup for VMware: notes and restrictions” on page 32.

query

The combination of rules in the policy's Query Builder, by which
NetBackup selects virtual machines for backup. A query consists
of one or more rules.

Query Builder

For creating filtering rules for automatic selection of virtual
machines for backup. The Query Builder is on the Clients tab of
the NetBackup policy.

query rule

A single statement in a query, by which NetBackup selects virtual
machines for backup.

An example of a query rule is: Displayname Contains

"finance"

Raw device mapping
(RDM)

Allows a virtual machine to directly access physical disks (on Fibre
Channel or iSCSI). RDM allows the OS and applications in the
virtual machine to have pass-thru access to raw devices.

NetBackup for VMware cannot back up an RDM disk. NetBackup
client software must be installed in the virtual machine.

See “About VMware raw device mapping (RDM)” on page 173.

recovery host

See backup host.

virtual machine

An execution environment that the hypervisor creates for the
computer hardware. The resulting virtualized environment allows
different operating systems to run simultaneously on the same
physical computer.
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Table 1-3 NetBackup for VMware terms (continued)

Term

Definition

virtual network

Alogical network that allows the exchange of data between virtual
machines. A virtual network uses a virtual switch (VMware
vSwitch). A virtual network can be connected to a physical
network.

vmdk file

In a VMware ESX server, one or more vmdk files make up the disk
image or virtual drive in a virtual machine. The . vmdk files contain
the operating system, applications, and data in the virtual
machine.

VMware Consolidated
Backup

An off-host backup application programming interface (API)
created by VMware. Designed to off load backups from the ESX
server. Supported only on NetBackup 7.1 clients and earlier.

VMware Tools

Installed inside each VMware virtual machine. Enhances the
virtual machine performance and adds backup-related
functionality.

VMX datastore

Sometimes called the vmx directory or configuration datastore.
Contains the configuration files that describe the virtual machine,
such as .vmx files. During a backup of a virtual machine snapshot,
vmdk writes are also cached on this datastore. Note that a separate
vmx datastore is not a VMware requirement.

vStorage

VMware vStorage APIs enable data protection features for more
efficient use of storage capacity. NetBackup can use vStorage to
back up the latest vSphere environments as well as to back up
earlier VMware environments.
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Required tasks: overview

This chapter includes the following topics:

m Overview of VMware tasks

m Overview of NetBackup tasks

Overview of VMware tasks

The VMware components including ESX servers and virtual machines must be
set up before you configure NetBackup.

Table 2-1 briefly describes these VMware-specific tasks; further assistance with
these tasks may be found in your VMware documentation.

Table 2-1

VMware tasks

Sequence

Tasks

Phase 1

Set up disk storage on Fibre Channel or iSCSI. The VMware backup host
must be able to access the disk storage.

Phase 2

Install the VMware ESX server and virtual machines.

Phase 3

Install VMware Tools on the virtual machines that you plan to back up.

Phase 4

Optional: install a vCenter (or VirtualCenter) server.

Phase 5

For recovery of VCB backups: Install the VMware Converter server on the
VMware restore host.

The VMware Converter server is not required for vStorage.

Notes:
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Overview of NetBackup tasks

m Ensure that the hardware and the SAN are configured properly. The VMware

datastore where the target virtual machine files exist must be accessible to
the VMware backup host.

Note: A SAN connection between the backup host and the datastore is optional
if you use the NBD transfer type or NBDSSL transfer type.

VMware has specific hardware and configuration requirements. VMware SAN
requirements can be found in the appropriate VMware SAN Configuration
guide.

VMware requires that ESX server names resolve to an IP address. Symantec
highly recommends the use of DNS for the naming resolution among VMware
servers. For DNS configuration instructions for VMware servers, please refer

to the following VMware site:
VMware vSphere Online Library

Overview of NetBackup tasks

Table 2-2 lists the NetBackup configuration tasks for VMware. These tasks are
described in other NetBackup topics and guides, as indicated.

Table 2-2 NetBackup tasks

Sequence Tasks

Phase 1 Install the NetBackup 7.5 master server and media server.
See the NetBackup Installation Guide.
Symantec recommends that the NetBackup media server and the VMware
backup host be installed on the same host.

Phase 2 Install the NetBackup 7.5 Enterprise Client license on the master server,
and install NetBackup client 7.5 software on the VMware backup host.

Phase 3 Add the VMware backup host to your NetBackup configuration.
See “Adding the VMware backup host to NetBackup” on page 39.

Phase 4 Set NetBackup access credentials for the VMware vCenter or VirtualCenter
(if any), or for VMware ESX servers.
See “Adding NetBackup credentials for VMware” on page 40.

Phase 5 Create a NetBackup policy for VMware.

See “Configuring a VMware policy from the Policies utility” on page 48.
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Table 2-2 NetBackup tasks (continued)

Sequence Tasks

Phase 6 Perform a backup or restore.
See “Backing up virtual machines” on page 115.
See “Restoring individual files” on page 145.

See “Restoring the full VMware virtual machine” on page 128.

Phase 7 Recheck the configuration.
See “NetBackup for VMware best practices” on page 151.

See “NetBackup status codes related to VMware” on page 162.
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Notes and prerequisites

This chapter includes the following topics:

NetBackup for VMware prerequisites

NetBackup for VMware: notes and restrictions

NetBackup for VMware: notes on Linux virtual machines
NetBackup character restrictions for virtual machine display names
Notes on the hotadd transport mode

Creating a helper virtual machine for hotadd transport

NetBackup for VMware prerequisites

The following prerequisites apply to NetBackup for VMware:

The VMware components including ESX servers and virtual machines must
be set up before you configure NetBackup.
See “Overview of VMware tasks” on page 27.

The VMware backup host must run Windows 2003, 2008, or 2008 R2. The
supported hardware types are the same as for any NetBackup Windows client.
For further information on supported guest operating systems and VMware
components and versions, refer to the following Symantec tech note:
Support for NetBackup 7.x in virtual environments:
http://www.symantec.com/docs/TECH127089

To use the hotadd transfer type for backup or restore, the VMware backup or
restore host is installed in a virtual machine.

For ESX 3.5 and earlier: You must set up a shadow virtual machine that has
the same name as the backup host but with the (vce-#ELPER) suffix.

See “Creating a helper virtual machine for hotadd transport” on page 37.


http://www.symantec.com/docs/TECH127089
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NetBackup for VMware: notes and restrictions

See “Notes on the hotadd transport mode” on page 35.

NetBackup for VMware: notes and restrictions

Note the following about NetBackup for VMware:

NetBackup for VMware does not work with the VMware NetBackup Integration
Module (VNIM). Conflicts can occur between NetBackup for VMware policies
and any older script-based policies that use VNIM.

See “Notes on troubleshooting NetBackup for VMware” on page 160.

NetBackup for VMware does not support the NetBackup Instant Recovery
feature.

NetBackup for VMware cannot back up the data on an independent disk,
because an independent disk cannot be captured with a snapshot. The backup
succeeds but the backup image contains no data for the independent disk.
To back up the data on an independent disk, install a NetBackup client on the
virtual machine. You can configure NetBackup to back up the virtual machine
and any independent disks as if the client was installed on a physical host. You
can restore the virtual machine and then restore the independent disk as a
separate job.

If a Windows virtual machine includes Veritas Storage Foundation volumes,
the Enable file recovery from VM backup option is not supported.
See “Volume Manager volumes in the virtual machine” on page 69.

VMware virtual machine templates are for cloning virtual machines: They
cannot be powered on and used as functioning VMs. As a result, VMware has
imposed the following restrictions on backup and restore of virtual machine
templates:

m Avirtual machine template cannot be captured in a snapshot. A NetBackup
backup of the template skips the snapshot portion of the job and backs up
the template to the designated storage unit.

m Block level incremental backup (BLIB) cannot be used when backing up a
virtual machine template.

m A virtual machine template cannot be backed up over a SAN. You must
configure the NetBackup policy to use a local network transfer type, such
as nbd. Likewise, the restore of a template must be conducted over a local
network.

Note: You can use the Query Builder in the NetBackup policy to create rules
for automatic selection of virtual machine templates.
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m VMware does not support non-ASCII characters in virtual machine display
names or in other objects that are associated with the virtual machine.
(Examples are annotations, floppy image name, parallel port or serial port file
name, and CD-ROM ISO name.) For the complete list of objects that VMware
does not support with non-ASCII characters, see the following VMware article:
Troubleshooting errors resulting from non-ASCII names (1003866)
http://kb.vmware.com/kb/1003866
In keeping with VMware’s position, NetBackup does not support non-ASCII
characters in display names or in other vSphere objects. Symantec recommends
that you follow VMware's guidelines in naming vSphere objects.

In addition, NetBackup has its own restrictions on characters in display names.
See “NetBackup character restrictions for virtual machine display names”
on page 35.

Note: If the virtual machine display name contains non-ASCII characters, the
backup may succeed but the restore fails. To restore the virtual machine,
configure a restore to an alternate location. On the Recovery Options dialog,
change the display name to contain ASCII characters only.

m Several notes and limitations apply to the automatic selection of virtual
machines for backup (Virtual Machine Intelligent Policy).
See “NetBackup requirements for automatic virtual machine selection”
on page 77.

m Several notes and limitations apply to Linux virtual machines.
See “NetBackup for VMware: notes on Linux virtual machines” on page 34.

m For hotadd backup or restore: The virtual machine to back up (or restore) and
the virtual machine that contains the hotadd backup host must reside in the
same VMware datacenter.

See “Notes on the hotadd transport mode” on page 35.

m NetBackup for VMware does not support the Enable file recovery from VM
backup option for the virtual machines that contain encrypted drives. For
backups of the virtual machines that contain encrypted drives, disable that
option.

m Storage optimization cannot be used if a snapshot exists on the virtual machine
when VMware Changed Block Tracking is turned on.

See “Using VMware's Changed Block Tracking for full backups only” on page 112.
See “About reducing the size of VMware backups” on page 109.
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NetBackup for VMware: notes on Linux virtual machines

If the policy's Primary VM identifier option is set to VM hostname, note:
NetBackup cannot select a VMware virtual machine for backup if it cannot
obtain an IP address for the virtual machine.

See “Restore notes and restrictions” on page 123.

NetBackup for VMware: notes on Linux virtual

machines

The following notes apply to virtual machines with Linux guest operating systems:

On Linux virtual machines, NetBackup requires a special utility (SYMCquiesce)
to quiesce the file system in preparation for taking the snapshot. Without
SYMCquiesce, NetBackup cannot guarantee that data in the file system is in
a consistent state when the snapshot occurs.

See “About the SYMCquiesce utility” on page 179.

See “Installing the SYMCquiesce utility” on page 180.

For the Linux virtual machines that do not have the SYMCquiesce utility: To
guarantee that the file system is consistent at the time of backup, consider
powering down the virtual machine before the backup. When the virtual
machine is powered down, data buffers are flushed to disk and the file system
is consistent.

For a description of file system quiesce, see the NetBackup Snapshot Client
Administrator's Guide.

If the Linux file system was not quiesced before the snapshot, some files may
be inconsistent. Such files can be recovered from the NetBackup.lost+found
directory.

See “About the NetBackup.lost+found directory on Linux” on page 147.

Unmounted LVM2 volumes must start with /dev

If the path of an unmounted LVM2 volume does not start with /dev, the backup
of the virtual machine fails. Note: The path of the volume is set with the "dir"
parameter on the LVM volume configuration file. An example of this
configuration file is /etc/lvm/lvm.conf.

For Linux files or directories, NetBackup for VMware has the same path name
restriction as NetBackup on a Linux physical host. Files or directories with
path names longer than 1023 characters cannot be individually backed up or
restored. Such files can be restored when you restore the entire virtual machine
from a full virtual machine backup.

See “Restore notes and restrictions on Linux” on page 126.
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NetBackup character restrictions for virtual machine
display names

When VMware virtual machines are included in a NetBackup policy, certain
characters are not allowed in the virtual machine display name. These restrictions
apply only if the policy Primary VM identifier option is set to VMware display
name.

If the display name contains the wrong characters, the backup may fail.

For NetBackup, the following characters are allowed in virtual machine display
names:

m Uppercase and lowercase ASCII characters
m Numbers

m Period ()

m Hyphen (-)

m Underscore ()

m Plus sign (+)

m Percent sign (%)

m Left and right parentheses ()

m Spaces

Note: No other characters are allowed.

See “Primary VM identifier options (VMware)” on page 53.

Notes on the hotadd transport mode

NetBackup supports several transport modes for sending snapshot data between
the VMware datastore and the VMware backup host during a backup or restore.

One of those transport modes (hotadd) is used when the VMware backup host is
installed in a virtual machine.

Note the following about the hotadd transport mode:

m Forabackup orrestore, the hotadd transport mode does not support the vimdk
files that are larger than 1 TB. If the .vindk file is larger than 1 TB, the file
cannot be mounted.

m The VMware backup host must be installed in a virtual machine.
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Notes on the hotadd transport mode

m For ESXversions 3.5 and earlier: You must configure a shadow (helper) virtual

machine before the backup starts. The helper virtual machine must have at
least as many SCSI controllers as exist on the virtual machine that you want
to back up.

The helper virtual machine is used internally by the VMware VDDK to attach
the disks temporarily during hotadd backup or restore.

Note: A helper virtual machine is not required for backups of ESX 4.0 (or later)
virtual machines. For earlier ESX versions, a helper virtual machine is required.

See “Creating a helper virtual machine for hotadd transport” on page 37.

The following is a VMware requirement: The virtual machine to back up and
the virtual machine that contains the hotadd backup host must reside in the
same VMware datacenter. The same VMware requirement applies to virtual
machine restore: The virtual machine to restore and the virtual machine that
contains the hotadd restore host must reside in the same VMware datacenter.
For hotadd backup, Symantec recommends at least one hotadd backup host
for each datacenter.

NetBackup does not support IDE disks on the virtual machine.

On the virtual machine to back up, no two disks should have the same name.
(Identical names can occur if the disks reside on different datastores.)

The ESX server (where the backup-host virtual machine resides) must have
access to the datastore of the virtual machines that you want to back up.

The datastore for the backup-host virtual machine must have some free space
before the hotadd backup begins. Otherwise, the backup may fail.

For additional hotadd information, see the following VMware document:
VDDK 5.0 Release Notes

The Enable file recovery from VM backup option does not work with the
hotadd transport mode in the following case: The virtual machine that contains
the backup host is a clone of the virtual machine that is backed up (or vice
versa). In this case, a backup that uses the hotadd transfer mode may appear
to succeed. However, some of the virtual machine volumes may be incorrectly
mapped and cannot be restored.

The converse is also true. The virtual machine that you back up with the hotadd
transport mode cannot be a clone of the virtual machine that contains the
backup host. Furthermore, the two virtual machines must not be clones of the
same parent.

VMware has identified this issue as software defect SR#1442259141. To use
the hotadd transport mode with your backup, do the following: Make sure the


http://www.vmware.com/support/developer/vddk/VDDK-1.2.1-Relnotes.html
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virtual machine that contains the VMware backup host and the virtual machine
you back up are not clones of each other.

Creating a helper virtual machine for hotadd transport

This procedure applies only to ESX versions 3.5 (and earlier) with use of the hotadd
transport mode.

To create a helper virtual machine for hotadd backup or restore
1 Create a virtual machine.
You do not need to assign any drives to the virtual machine.

2  Givethe helper virtual machine the same VMware display name as the virtual
machine where the backup host is installed. Add the (vcB-HELPER) suffix to
the name.

For example, if the virtual machine that contains the backup host is called
bu_host_vM, the name of the helper virtual machine must be the following:

bu host VM(VCB-HELPER)

Note that the complete name including the suffix must not exceed 32
characters.

3 For more information on helper virtual machines, see the following VMware
document:

VMware Virtual Machine Backup Guide (Update 2 and later for ESX Server
3.5, ESX Server 3i version 3.5, VirtualCenter 2.5).
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Configure NetBackup
access to VMware

This chapter includes the following topics:
m Adding the VMware backup host to NetBackup
m Adding NetBackup credentials for VMware

m Changing the host name of a VMware server in NetBackup

Setting privileges for posting events to vCenter

Setting global limits on the use of VMware resources

Adding the VMware backup host to NetBackup

You must add the VMware backup host to your NetBackup configuration.

Note: This procedure is not required for any backup host that is also a master
server or media server.

In the NetBackup Administration Console, do the following.
To add the VMware backup host

1 Click Host Properties > Master Servers, double click the NetBackup master
server, and click VMware Access Hosts.

2 Click Add.

Enter the fully qualified domain name of the VMware backup host, and click
Add.
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4  When you are finished adding hosts, click Close.

5

Click Apply and then OK.

Adding NetBackup credentials for VMware

To back up or restore virtual machines, the NetBackup server requires logon
credentials to the VMware ESX servers or the VMware vCenter servers. In the
NetBackup Administration Console, do the following.

To add NetBackup credentials

1

Click Media and Device Management > Credentials > Virtual Machine
Servers.

Click Actions > New > New Virtual Machine Server.

On the Add Virtual Machine Server dialog, enter the name of a virtual
machine server (vCenter server or ESX server).

Note: Enter the server name in the same format in which it is registered in
DNS and in the VMware server (whether short or fully-qualified).

NetBackup needs access to this server for either of the following reasons:
m To browse the server's virtual machines and back them up.

m To use the server as a target for restoring virtual machines.
Use the next dialog to identify the type of this server (vCenter, ESX, or
ESX for restore only).

In the Credentials pane of the Virtual Machine Server dialog, enter the
following:

Virtual machine server type
Select the type of VMware server that NetBackup needs to access:

m VMware Virtual Center server
Designates a vCenter (or VirtualCenter) server that manages ESX servers.
When you create a policy to back up this server's virtual machines,
NetBackup can browse this server and list its virtual machines. If the
credentials provide full access privileges to the vCenter server, you can
restore virtual machines to this server.
Note: Do not enter logon credentials for the individual ESX servers that
this vCenter server manages. NetBackup needs credentials for the vCenter
only.
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m VMware ESX Server
Designates a standalone ESX server that is not managed by a vCenter
server. NetBackup can browse the ESX server to present a list of its virtual
machines for backup. You can also restore virtual machines to this ESX
server. To use the server as a target for restores, enter the credentials
that provide full access privileges to the ESX server.

m VMware Restore ESX Server
Designates an ESX server to which NetBackup can restore virtual machines.
You must enter the credentials that provide full access privileges to the
server.

Note: NetBackup accesses this type of server for restores only, not for
backups.

Note: For restore, VMware vStorage cannot communicate with the ESX
servers that are earlier than version 3.5 update 2. To restore the virtual
machines that were backed up with vStorage: The target ESX server must
be 3.5 update 2 or later or must be managed by a vCenter server 2.5 update
1 or later.

The restore ESX server type has the following advantages:

m For large environments with hundreds of hosts, NetBackup may not
need full access to the vCenter server. With the restore ESX server
type, you can give NetBackup full access to a single ESX server that is
dedicated to restore.

m SAN-based restores that go directly to a restore ESX server are faster
than restores that go through the vCenter server.

For further information on the restore ESX server, refer to the following

Symantec tech note:

http://www.symantec.com/docs/TECH128513

User name

Enter the user name for the virtual machine server. Note that spaces in user
names are not allowed.

Password
Enter the password (and confirm it) for the virtual machine server.

You can use the For backup host pull-down to select a particular backup host
for which to validate the credentials. Note that a backup host appears in the
pull-down list if it was added to the master server's Host Properties dialog.
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See “Adding the VMware backup host to NetBackup” on page 39.

If For backup host is set to <Any> (the default), NetBackup attempts to
validate the credentials using each backup host in turn. NetBackup continues
checking only until validation succeeds for a particular backup host or the
list of backup hosts is exhausted.

During validation: An invalid user name or password is deleted if you have
entered it for the first time and you do not select a backup host. If validation
fails for any reason, the entry is removed.

If your VMware backup host is running a version of NetBackup that is earlier
than 6.5.4, the credentials cannot be validated. An error message is displayed.
You must verify that the credentials you entered are correct for the VMware
server. If the credentials are correct, you can ignore the error message.

Connect using port number

If the default port number has not been changed on the VMware server, no
port specification is required. In that case, make sure that the Connect using
port number box is not checked.

If the VMware server has been configured to use a different port, click the
Connect using port number box and specify that port number.

Click OK.

If your site has multiple standalone ESX servers, use the Virtual Machine
Server dialog to enter credentials for each ESX server.

See “Setting global limits on the use of VMware resources” on page 44.

Changing the host name of a VMware server in

NetBackup

Use the following procedure if you need to change a VMware server's host name
as it is stored in NetBackup.

Example reasons for changing the VMware server name are the following:

You used a short host name for the server for its NetBackup credentials, and
need to replace that name with the fully qualified host name.

Two hosts currently resolve to the same IP address, and one of them must be
renamed and assigned a new IP address.

To change the host name of a VMware host in NetBackup

1

Remove the current credentials that were entered for the VMware host.

Do the following:
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m In the NetBackup Administration Console, click on Media and Device
Management > Credentials > Virtual Machine Servers.

m Right-click on the credentials definition for the VMware server and select
Delete (or press the Delete key).

Remove the VMware host from the NetBackup EMM database.

Enter the following command:

nbemmcmd -deletehost -machinename VMware server name

-machinetype virtual machine

In the NetBackup Administration Console, re-enter NetBackup's credentials
for the VMware server.

See “Adding NetBackup credentials for VMware” on page 40.

Make sure to enter the correct host name for the VMware server.

See “Setting global limits on the use of VMware resources” on page 44.

Setting privileges for posting events to vCenter

With the Post events to vCenter option, NetBackup can send backup related events
to the vCenter server, to view in vSphere Client.

Note the following requirements:

You must enter the credentials that give NetBackup access to the vCenter
server.

See “Adding NetBackup credentials for VMware” on page 40.

Make sure that the Post events to vCenter option is enabled in the policy.
See “VMware - Advanced Attributes dialog” on page 57.

You must set the correct role privileges in vCenter, as explained in this topic.

Note: If your vCenter role is configured for all privileges, you can skip the
following procedure.

To set privileges for posting events to vCenter

1
2

Go to the vSphere Client Home page on the vCenter server and click Roles.

Right-click on the role for the vCenter user that was entered for the NetBackup
credentials, and click Edit Role.

See “Adding NetBackup credentials for VMware” on page 40.
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3 Inthe Edit Role screen, place a check mark on the Extension privilege, to
include all three extension privileges (Register extension, Unregister
extension, Update extension).

4  Click OK.

Setting global limits on the use of VMware resources

You can use the NetBackup Resource Limit dialog to control the number of
simultaneous backups that can be performed on a VMware resource type. The
settings apply to all NetBackup policies.

For example, to avoid overloading the ESX server, you can place a limit on the
number of concurrent backup jobs per ESX server. To control I/O overhead on the
datastore's array, you can limit the number of concurrent backups per datastore.

Note: The Resource Limit screen applies only to policies that use automatic
selection of virtual machines (Query Builder). If virtual machines are selected
manually on the Browse for Virtual Machines screen, the Resource Limit settings
have no effect.

Note: To limit the number of simultaneous backups per policy, use the Limit jobs
per policy setting on the policy Attributes tab.
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To set limits on the use of VMware resources

1 Inthe NetBackup Administration Console, click Host Properties > Master
Servers and double click the NetBackup master server.
In the Properties screen, scroll down in the left pane and click Resource Limit.
Click in the Resource Limit column to set the maximum NetBackup usage
for the resource type. The settings apply to all policies.
Resource Limit Defaults |
By default, resources have no limit. To set a limit, select resource below and specify a
limit.
Application Resources for selected application
m Resource Type | Resource Limik
wi_enter Mo Limit
snapshat Mo Lirnik
Clusker Mo Limit:
ES¥server Mo Lirnik
WirDatastore i
Datastaore ] =
DatastoreFolder o Lirni
DatastoreType Mo Lirnik
WMrDatastoreMFSHost | Mo Limit
DatastareMFSHost Mo Lirnik
DatastoreClusker Mo Limit:
For each resource type, the default is 0, (No Limit). A resource limit of 4 for
datastore means that NetBackup policies can perform no more than four
simultaneous backups on any particular datastore.
Table 4-1 describes the limits:
Table 4-1 Resource types and limits
Resource type Resource limit
vCenter The maximum number of simultaneous backups per vCenter
server.
snapshot The maximum number of simultaneous snapshot operations
(create or delete) per vCenter.
Cluster The maximum number of simultaneous backups per VMware
cluster.
ESXserver The maximum number of simultaneous backups per ESX
server.
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Table 4-1 Resource types and limits (continued)

Resource type

Resource limit

VMXDatastore The maximum number of simultaneous backups per vimx
datastore.
See “NetBackup for VMware terminology” on page 22.

Datastore The maximum number of simultaneous backups per datastore.

DatastoreFolder The maximum number of simultaneous backups per datastore
folder.

DatastoreType The maximum number of simultaneous backups per datastore
type.

VMXDatastoreNFSHost The maximum number of simultaneous backups per NFS host
of the vmx datastore.

DatastoreNFSHost The maximum number of simultaneous backups per NFS host
of the datastore.

DatastoreCluster The maximum number of simultaneous backups per datastore

cluster.

Other resource-related considerations may be of interest.

See “NetBackup for VMware best practices” on page 151.



Configure NetBackup

policies

for VMware

This chapter includes the following topics:

Configuring a VMware policy from the Policy Wizard
Configuring a VMware policy from the Policies utility
Backup options on the VMware tab

Browse for VMware Virtual Machines

Limiting the VMware servers that NetBackup searches when browsing for
virtual machines

Virtual machine host names and display names must be unique in a master
server's policies

Primary VM identifier option and manual selection of virtual machines
About incremental backups of virtual machines

Configuring incremental backups

Volume Manager volumes in the virtual machine

About older NetBackup policies and pre-7.x backup hosts

Configuring a VMware policy from the Policy Wizard

Use the following procedure.
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To create a backup policy by means of the Policy Configuration Wizard

1

A U~ W N

In the NetBackup Administration Console (on the NetBackup master server),
click on the name of the master server.

Click Create a Policy.

Under Create a backup policy for, click VMware and Hyper-V.

Enter a name for the policy.

Click VMware as the virtual machine type.

Select the backup host from the VMware backup host drop-down list.

Instead of a particular host, you can select Backup Media Server. This option
enables the use of one or more Windows media servers as the backup host,
for host redundancy and faster backups.

Note: The individual backup hosts (not the media servers) are defined in the
Administration Console in the following location:

Host Properties > Master servers > double-click the master server > Master
Server Properties > VMware Access Hosts.

Click Next.
Follow the remaining panels in the wizard.

The wizard creates the policy according to your selections.

Configuring a VMware policy from the Policies utility

You can create a NetBackup policy (full or incremental) to back up the virtual
machine in either of two ways:

Use the Policies utility of the NetBackup Administration Console (described
in this topic).

Use the Policy Configuration Wizard.
See “Configuring a VMware policy from the Policy Wizard ” on page 47.
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To configure a policy to back up the virtual machine

1

In the NetBackup Administration Console, click Policies and select Actions
> New > New Policy.

Select the VMware policy type.

The VMware policy type uses vStorage to perform the backup (not VCB). For
VCB-based backup, select the FlashBackup-Windows policy type. Note that
NetBackup 7.5 supports VCB backup only for NetBackup 7.1 clients and earlier.
For more information on FlashBackup-Windows and VCB backup, see the
NetBackup 7.1 for VMware Administrator's Guide:

http://www.symantec.com/docs/DOC3663
If you are using the Java Administration Console, click Apply.

VMware backup options are available on the VMware tab (described later in
this procedure).

Select a policy storage unit or storage unit group.

Storage unit groups are described in the NetBackup Administrator’s Guide,
Volume I.

In most cases, you can leave the Disable client-side deduplication option at
the default (unchecked).

The Disable client-side deduplication option is described in the NetBackup
Administrator's Guide, Volume I.
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6 Click the VMware tab.

Add New Policy - dd-test [<]

Attﬂbutssl & Schedu\ssl B Ehentsl () Backup Selections A YMuware |

W ware backup host:

r~ Optimization: Application Protection
Enimary VM identifier ™ Enable Exchange Recovery
I¥ Enable file recavery from M backup IVM hosthame d I=| Tiuricete logs
[~ Enable block-level incremental backup Diphaned snapshat handing: [~ Enahle SOL Server Recovery
¥ Ezclude deleted blocks IF\stVE NBU j ™| Truncate Jogs
IV Exglude swaping and paging files I™ Enable ShareFaint Recovery
— Tramsport Mod;

Select the transport mode(s) pou want to use by checking the checkbox and
uge the move up and move down buttans to reorder the selected transport modes.

zanr- Lze san to mave vitual disk data Mave Up |
hotadd- Use virtual disk files from NetBackup server

wbd- Do nat encrpt the virtual disk data for over-the-network transfers Mave Dawn |
wbdssl- Encrypt the vitual disk data for aver-the-netwark transfers

Advanced

akK I Cancel I Help |

Use this dialog to set VMware-related options.
See “Backup options on the VMware tab” on page 51.
7 Use the Schedules tab to define a schedule (click New).

On the Schedules Attributes tab, you can select Full backup, Differential
Incremental Backup, or Cumulative Incremental Backup.

Note that incremental backups require one of the following selections on the
policy VMware tab:

m Enable file recovery from VM backup, or

m Enable block-level incremental backup.
Enable block-level incremental backup requires an ESX server 4.0 and
a virtual machine at vmx-07 or later.
The following topic contains additional information.
See “About incremental backups of virtual machines” on page 68.
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8 Use the Clients tab to select the virtual machines to back up.
You can specify virtual machines in either of two ways:
Use Select manually, The Browse for VMware Virtual Machines screen appears.

and click New. You can type the host name in the Enter the VMware
hostname field, or click Browse and select virtual machine.

Note: The Backup Selections tab is set to
ALL_LOCAL _DRIVES. Individual drives cannot be specified.

See “Browse for VMware Virtual Machines” on page 61.

Use Select With this option, NetBackup can automatically select virtual
automatically machines for backup based on the filtering criteria that you
through query enter. The following topics explain how to specify the criteria:

See “About automatic virtual machine selection for
NetBackup for VMware” on page 72.

See “Configuring automatic virtual machine selection”
on page 81.

Note: The Backup Selections tab is filled in with the filtering
rules from the query. NetBackup uses the

ALL LOCAL_DRIVES directive to back up the virtual
machines.

Note: In the NetBackup Java Administration Console, the Install Software
option is for installing NetBackup client software on trusting UNIX clients.
This option does not apply to virtual machines.

9 Whenyouclick Apply or OK on the policy Attributes tab, a validation process
checks the policy and reports any errors. If you click Close, no validation is
performed.

Backup options on the VMware tab

In the Administration Console, the VMware tab appears when you select VMware
as the policy type.

The following options apply to the VMware policy type.
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Backup options on the VMware tab

VMware backup host selection
The VMware backup host is a NetBackup client that performs backups on behalf

of the virtual machines.
Table 5-1 VMware backup host selection
Option Description
Backup Media Server This option allows a Windows media server that is selected in the policy

to operate as the backup host. (Selection of the media server is determined
by the specified storage unit.) To operate as the backup host, the Windows
media server must contain NetBackup client software.

Note: The storage unit that is specified in the policy must be unique to
your Windows media servers. If the storage unit is also available on a UNIX
media server, the snapshot cannot succeed.

Note: When the Backup Media Server option is selected, NetBackup
cannot determine a host to perform policy validation. To validate the
policy, temporarily select one of the possible media servers as the backup
host (do not select Backup Media Server). When the policy validates
successfully, reset the backup host to Backup Media Server.

See “Media servers as backup or discovery hosts” on page 20.

backup _host_name

Select a particular backup host to perform the backup. (See the note after
this table.)

Note: The backup hosts (but not backup media servers) must be identified in the
Administration Console as follows: Go to Host Properties > Master servers >
double-click the master server > Master Server Properties > VMware Access

Hosts.

See “Adding the VMware backup host to NetBackup” on page 39.

Optimizations options (VMware)

The following options set the type and scope of the VMware virtual machine

backup.
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Table 5-2 Optimizations
Option Description
Enable file recovery This option allows restore of individual files from the backup. With or without this option,
from VM backup you can restore the entire virtual machine.

You can also use this option for incremental backups: in the policy schedule, select
differential incremental backup or cumulative incremental backup.

To perform a VMware backup to a deduplication storage unit, select this option. This
option provides the best deduplication rates.

To back up a virtual machine that contains Veritas Storage Foundation Volume Manager
volumes, disable this option. Also make sure that the Exclude deleted blocks option is

disabled.
Enable block-level For block-level backups of the virtual machine. This option reduces the size of the backup
incremental backup image.

See “Block-level backup (BLIB): full vs incremental” on page 110.

Exclude deleted blocks | Reduces the size of the backup image by excluding any unused or deleted blocks within
the file system on the virtual machine. This option supports the following file systems:
Windows NTFS, and Linux ext2, ext3, and ext4.

This option uses proprietary mapping technology to identify vacant sectors (allocated
but empty) within the file system.

See “About reducing the size of VMware backups” on page 109.

To back up a virtual machine that contains Veritas Storage Foundation Volume Manager
volumes, disable this option. Also make sure that the Enable file recovery from VM
backup option is disabled.

Exclude swapping and | Reduces the size of the backup image by excluding the data in the guest OS system paging
paging files file (Windows) or the swap file (Linux).

Note: This option does not exclude the swapping and paging files from the backup: it
only excludes the data in those files. If the files are restored, they are restored as empty
files.

Primary VM identifier options (VMware)

This setting specifies the type of name by which NetBackup recognizes virtual
machines when it selects them for backup.
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Table 5-3 Primary VM identifier

Option

Description

VM hostname

The network host name for the virtual machine. (This option is the default.) NetBackup
obtains the host name by means of a reverse lookup on the virtual machine's IP
address. If no host name can be found, the IP address is used as the host name.

VMware display name

The name of the virtual machine as displayed in the VMware interface. A display
name is assigned to the virtual machine when the virtual machine is created.

When virtual machines are included in a NetBackup policy, restrictions apply to the
characters that are allowed in the virtual machine display name.

See “NetBackup character restrictions for virtual machine display names” on page 35.

Note: The restrictions also apply to other vSphere objects, such as floppy image
name, parallel port or serial port file name, and CD-ROM ISO name.

Each display name must be unique in your VMware environment.
See “NetBackup for VMware: notes and restrictions” on page 32.

See “Restoring individual files” on page 145.

VMware BIOS UUID

The ID assigned to the virtual machine when the virtual machine is created. This ID
may or may not be unique, depending on whether the virtual machine has been
duplicated. This option is included for compatibility with the existing policies that
use the older VM UUID identifier.

VM DNS Name

The VMware DNS Name of the virtual machine. In vSphere Client, this name appears
on the virtual machine's Summary tab.

Note: This name may or may not be associated with the virtual machine’s IP address.
VMware Tools obtains this name from the host name that is configured in the virtual
machine. For further information on this name, refer to the documentation for the
guest operating system.

VM instance UUID

The globally unique ID assigned to the virtual machine when the virtual machine is
created. This ID uniquely identifies the virtual machine within a vCenter server. Even
if the virtual machine has been duplicated (such as within a vCloud), only the original
virtual machine retains this instance ID. (The virtual machine duplicates are assigned
different instance UUIDs.)

This option applies only to backup hosts (NetBackup clients) at 7.5 or later. If your
backup host is 7.5 or later, this option is recommended instead of the VMware BIOS
UUID option.

Note: VM instance UUIDs are not available for standalone ESX 3.5 or ESXi 3.5 servers
or for servers that VirtualCenter 2.5 manages.




Configure NetBackup policies for VMware
Backup options on the VMware tab

Orphaned snapshot handling options (VMware)

This option specifies the action that NetBackup takes when a snapshot is
discovered before NetBackup creates a new snapshot for the virtual machine
backup. After it creates a snapshot, NetBackup usually deletes the snapshot when
the backup completes. If snapshots are not automatically deleted (whether created
by NetBackup or not), the performance of the virtual machine may eventually
decline.

Undeleted snapshots can cause restore failures due to lack of disk space. If the
virtual machine was configured on multiple datastores and a leftover snapshot
existed on the virtual machine when it was backed up, note: NetBackup tries to
restore all .vmdk files to the snapshot datastore. As a result, the datastore may
not have enough space for the .vmdk files, and the restore fails. (For a successful
restore, you can restore the virtual machine to an alternate location. Use the
Storage Destination dialog in the Virtual Machine Recovery dialogs to select a
datastore for the .vidk files.)

Table 5-4 Orphaned snapshot handling: Options
Option Description
Ignore NetBackup ignores any existing virtual machine snapshots (including snapshots previously
created by NetBackup) and proceeds with snapshot creation and the backup.
Abort If any snapshot exists on the virtual machine, NetBackup aborts the job for that virtual machine
only.
Remove NBU If a virtual machine snapshot exists that a NetBackup backup previously created: NetBackup

removes the old snapshot, creates an updated snapshot, and proceeds with the virtual machine
backup. (This option is the default.)

Transport modes options (VMware)

The transport modes determine how the snapshot data travels from the VMware
datastore to the VMware backup host. The appropriate mode depends in part on
the type of network that connects the VMware datastore to the VMware backup
host.

By default, all modes are selected. NetBackup tries each transport mode in order,
from top to bottom. It uses the first mode that succeeds for all disks in the virtual
machine.
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Table 5-5 Transport Modes

Mode Description

san For unencrypted transfer over Fibre Channel (SAN) or iSCSI.

hotadd Lets you run the VMware backup host in a virtual machine. This feature requires ESX 3.5 Update2
or later.
See “Notes on the hotadd transport mode” on page 35.
For instructions on this transport mode and on installing the backup host in a VMware virtual
machine, refer to your VMware documentation.

nbd For unencrypted transfer over a local network that uses the Network Block Device (NBD) driver
protocol. This mode of transfer is usually slower than Fibre Channel.

nbdssl For encrypted transfer (SSL) over a local network that uses the Network Block Device (NBD) driver
protocol. This mode of transfer is usually slower than Fibre Channel.

Move Up, Use these buttons to change the order in which NetBackup tries each selected mode. Highlight a

Move Down | mode and click Move Up or Move Down.

For example: assume that all four transport modes are selected, and the order is san, hotadd, nbd,
and nbdssl. If one of the virtual disks cannot be accessed using san, the san transport mode is not
used for any of the virtual machine’s disks. NetBackup then tries to use the hotadd mode for all the
disks. NetBackup continues to try each mode until it finds one that succeeds for all the disks.

Application protection options (VMware)

To enable file-level recovery of database data that resides in the virtual machine,
select from the following options. These options apply to full backups of the virtual
machine; they do not apply to incremental backups.

Table 5-6 Application Protection options
Database option Description
Enable Exchange This option enables recovery of the Exchange databases or mailbox messages from the

Recovery

virtual machine backups. If this option is disabled, you can recover the entire virtual machine
from the backup, but you cannot recover the databases or mailbox messages individually.

To use the Enable Exchange Recovery option, note:

m The Enable file recovery from VM backup option must be enabled.
m The Enable block-level incremental backup option must be disabled.

For more information, refer to the NetBackup for Microsoft Exchange Server Administrator's
Guide.
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Table 5-6 Application Protection options (continued)

Database option

Description

Truncate logs

For Exchange, this option truncates the transaction logs when the snapshot of the virtual
machine is complete. Truncating the logs frees up disk space in the virtual machine.

Note: To use this option, install the Symantec VSS provider on the virtual machine. For
instructions on how to install the Symantec VSS provider, refer to the NetBackup for
Microsoft Exchange Server Administrator's Guide.

If you do not select Truncate logs, the logs are not truncated.

Enable SQL Server
Recovery

This option enables recovery of individual files from Microsoft SQL data in the virtual
machine backup. If this option is disabled, you can recover the entire virtual machine from
the backup, but you cannot recover the SQL files individually.

To use the Enable SQL Server Recovery option, note:

m The Enable file recovery from VM backup option must be enabled.
m The Enable block-level incremental backup option must be disabled.

For more information, refer to the NetBackup for Microsoft SQL Server Administrator's
Guide.

Truncate logs

For SQL Server, this option truncates the transaction logs when the backup occurs.
Truncating the logs frees up disk space in the virtual machine.

If you do not select Truncate logs, the logs are not truncated.

Enable SharePoint
Recovery

This option enables recovery of SharePoint objects from the virtual machine backup. If this
option is disabled, you can recover the entire virtual machine from the backup, but you
cannot recover the SharePoint objects individually.

To use the Enable SharePoint Recovery option, note:

m The Enable file recovery from VM backup option must be enabled.
m The Enable block-level incremental backup option must be disabled.

For more information, refer to the NetBackup for Microsoft SharePoint Server Administrator's
Guide.

VMware - Advanced Attributes dialog

This dialog appears when you click Advanced on the VMware policy tab.

You can use the VMware Advanced Attributes dialog to set the following additional
parameters for VMware backup. In most situations, the best settings are the
defaults.

57



58 | Configure NetBackup policies for VMware
Backup options on the VMware tab

Table 5-7 VMware Advanced Attributes

Configuration
parameter

Description

Virtual machine
quiesce

This option is enabled by default. In the great majority of cases, you should accept the default.

1/0 on the virtual machine is quiesced before NetBackup creates the snapshot. Without quiescing
file activity, data consistency in the snapshot cannot be guaranteed. If not consistent, the backed
up data may be of little or no value.

If this option is disabled, the snapshot is created without quiescing I/O on the virtual machine.
In this case, you must perform your own checks for data consistency in the backup data.

Caution: Symantec does not recommend that you disable quiesce. In most cases, this option
should be enabled.

Note: To use this option, VMware Tools must be installed on the virtual machine.

Note: To use this option with Linux virtual machines, you must also install the SYMCquiesce
utility.

See “Installing the SYMCquiesce utility” on page 180.

Virtual disk
selection

Determines the kind of disks on the virtual machine that are included in the backup. This option
can reduce the size of the backup, but should be used with care. These options are intended
only for the virtual machines that have multiple virtual disks.

The following options are available:

m Include all disks
Backs up all virtual disks that are configured for the virtual machine.

m Exclude boot disk
The virtual machine's boot disk (for example the C drive) is not included in the backup. Any
other disks (such as D) are backed up. Consider this option if you have another means of
recreating the boot disk, such as a virtual machine template for boot drives.
See “About the Exclude disk options for Virtual disk selection” on page 60.

Note: A virtual machine that is restored from this backup cannot start up. Data files are
available in the restored data disks.

m Exclude data disks
The virtual machine's data disks (for example the D drive) are not included in the backup
for this policy. Only the boot disk is backed up. Consider this option only if you have a
different policy that backs up the data disks.
See “About the Exclude disk options for Virtual disk selection” on page 60.
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Table 5-7 VMware Advanced Attributes (continued)

Configuration
parameter

Description

Ignore diskless
VMs

This option directs NetBackup not to back up any virtual machine that has no vindk file assigned
to it.

Note that virtual machines without vmdk files can occur in a VMware vCenter Site Recovery
Manager (SRM) environment. In an SRM environment, a replicated virtual machine in passive
mode may have no vindk file. If NetBackup attempts to back up a replicated virtual machine
that has no vindk file, the backup fails (status 156). This error indicates that the virtual machine
is in an unusual state and backup is impossible.

Post events to
vCenter

Enables NetBackup to send backup related events to the vCenter server. The events appear in
vSphere Client under Home > Inventory > Hosts and Clusters, Tasks & Events tab. More
information is available on how to view the events:

Note: To post events to vCenter, NetBackup must perform the backup through a vCenter server.
If NetBackup accesses the ESX server directly, the backup information cannot be displayed in
vSphere Client.

See “Viewing NetBackup activity in vSphere Client” on page 119.
You must set the required permissions in vCenter:
See “Setting privileges for posting events to vCenter” on page 43.

This option also records the date and time of the last successful backup of the virtual machine.
The date and time appear in vSphere Client on the Summary tab as a custom attribute under
Annotations. The attribute is labeled NB_LAST BACKUP.

For Post events to vCenter, the following options are available:

m All Events
NetBackup posts an event to vCenter server on each backup success or failure. This setting
is the default.

m No Events
Disables the Post events to vCenter option. NetBackup does not post any events to the
vCenter server.

m Error Events
NetBackup posts an event to the vCenter server only for backup failures.

Note: If a vSphere administrator created an attribute named NB_LAST BACKUP of type Global,
NetBackup cannot post backup events to that attribute. You must remove the NB_LAST_BACKUP
attribute from vSphere. Make sure that Post events to vCenter is set to All Events or Error
Events. At the next backup, NetBackup creates a NB_LAST_BACKUP attribute of type Virtual
Machine and posts events to that attribute.
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About the Exclude disk options for Virtual disk selection

The VMware - Advanced Attributes dialog has an option called Virtual disk
selection. The default setting is Include all disks. You should use this setting in
most cases.

The other options are Exclude boot disk and Exclude data disks. These options
are intended for the virtual machines that have multiple virtual disks. You should
use these options with care.

To exclude a boot disk or data disk, note the following requirements:
m The virtual machine must have more than one disk.
m NetBackup must be able to identify the boot disk.

m The boot disk must not be part of a managed volume (Windows LDM or Linux
LVM). The boot disk must be fully contained on a single disk.

The boot disk must include the following:

m The boot partition.

m The system directory (Windows system directory or Linux boot directory).
m The full swap file (Windows pagefile.sys or Linux swap partition).
Important! The exclude disk options are meant only for the following cases:

m  Excludebootdisk: Consider this option if you have another means of recreating
the boot disk, such as a virtual machine template for boot drives. If Exclude
boot disk is enabled, the policy does not back up the boot disk.

Note: When the virtual machine is restored from the backup, the virtual
machine data for the boot disk may be missing or incomplete.

Note the following about Exclude boot disk:

m If the virtual machine has a boot disk but has no other disks, the boot disk
is backed up. It is not excluded.

m If the virtual machine's boot disk is an independent disk, but the virtual
machine has no other disks, the boot drive is backed up. The restored boot
drive however contains no data, because NetBackup cannot back up the
data in an independent disk.

m If the virtual machine has a boot drive and an independent drive, the boot
drive is not backed up. Only the independent drive is included in the backup.
Since NetBackup cannot back up the data in an independent disk, the
restored independent disk contains no data. Refer to the explanation on
independent disks in the following topic:
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See “NetBackup for VMware terminology” on page 22.

m Adding a virtual disk and changing this option before the next backup can
have unexpected results.
See “Virtual disk selection options: examples to avoid” on page 61.

m Excludedatadisks: Consider this option if you have a different policy or other
backup program that backs up the data disks. If Exclude data disks is enabled
in a policy, that policy does not back up the data disks.

Note the following about Exclude data disks:

m If the virtual machine has only one disk, such as C, the C drive is backed
up. It is not excluded.

m If the virtual machine's boot disk is an independent disk, and the virtual
machine has a separate data disk, the boot disk is backed up. The restored
boot disk however contains no data, because NetBackup cannot back up
the data in an independent disk.

Caution: Use of the exclude disk options can have unintended consequences if
these rules are not followed.

The following topic contains important guidance on the exclude disk options:

See “Virtual disk selection options: examples to avoid” on page 61.

Virtual disk selection options: examples to avoid

You should use the Virtual disk selection option with care. For example, if you
add a disk to the virtual machine and change the Virtual disk selection setting,
note: The next backup may not capture the virtual machine in the state that you
intended. You should back up the entire virtual machine (Include all disks) before
using Virtual disk selection to exclude a disk from future backups.

Note: When you change an exclude disk option to disabled, do a full backup (Virtual
diskselection set to Include all disks) before the next incremental or differential
backup.

Browse for VMware Virtual Machines

When you configure a NetBackup policy, you can use the Browse for Virtual
Machines screen to select virtual machines for backup. You can enter the virtual
machine's host name manually or browse and select it from a list.
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As an alternative, NetBackup can automatically select virtual machines based on
arange of criteria.

See “About automatic virtual machine selection for NetBackup for VMware”

on page 72.
7 Browse for Virtual Machines
" Enter the VM hostname:
& Browse and select Virtual Machine Last Update: |12f?,|f2010 2:22:13PM
B E_| Hosts and Clusters = .. | ... | DNS Name ..._| Platform
| minn... vmx-07
el BMaccoz... 423... winLong... OFF minn... vmx-07
[ﬁ BMaccoz. .. 423... winLong... QOFF minn... vmx-07
il BMaccoz... 423... winLong... OFF minn... vmx-07
[l BMaccoz... 423... winLong... OFF minn... vmx-07
il BMaccoz... 423... winLong... OFF minn... vmx-07
dustvapp el BMaccoz... 423... winLong... OFF minn... vmx-07
zarl [ﬁzar.. zarvm2 zarvm2.... 564... 10.80... winLong... OFF minn... vmx-07
- @zar. zarvm3 zarvm3.... 584.. 10.80... winlong... ON minn... vmx-07
4 » i BMaccoz... 32bit-w2... 423... winLong... OFF minn... vmx-07 ﬂ

Mo. of Virtual Machines selected: 29

Client name selection: VM hostname

0K I Cancel Help I

#

m Enter the VM hostname

Click this option if you want to manually enter the name of a virtual machine.
The format of the name depends on your system. It may be the fully qualified
name or another name, depending on your network configuration and how
the name is defined in the guest OS. If NetBackup cannot find the name you
enter, policy validation fails.

To enter a host name, make sure that Browse and select Virtual Machine is
not selected.

Browse and select Virtual Machine

Click this option to discover vCenter servers, clusters, datacenters, vApps, and
ESX servers (shown in the left pane). You can select virtual machines from a
list (in the right pane).

NetBackup uses the following icons for vSphere objects:

vCenter server

Datacenter

ﬂqj Cluster
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e VApD

ESX server

@] Virtual machine

The virtual machines that are contained in a VMware vApp are displayed in
the right pane along with other virtual machines.

The virtual machine names that are listed may be derived from a cache file.
Use of the cache file is faster than rediscovering the virtual machines on the
network if your site has a large number of virtual machines.

If NetBackup cannot obtain the IP address of the virtual machine, the host
name and IP address are displayed as NONE.

Note that virtual machine host names or display names must be unique within
a master server's policies:

See “Virtual machine host names and display names must be unique in a master
server's policies” on page 66.

Last Update

Toupdate the cache file and re-display virtual machines, click the refresh icon
to the right of the Last Update field. This field shows the date and time of the
most recent cache file that contains the names of virtual machines.

For NetBackup to access the virtual machines, note the following:

m The NetBackup master server must have credentials for the VMware vCenter
or ESX server(s).
See “Adding NetBackup credentials for VMware” on page 40.

m DNS problems may prevent or slow down discovery of the virtual machines.
See “Preventing browsing delays caused by DNS problems” on page 158.

m To limit the search to particular vCenter or ESX servers, you can create a
BACKUP registry entry as an exclude list. Excluding unneeded servers can
dramatically speed up the search for virtual machines.

See “Limiting the VMware servers that NetBackup searches when browsing
for virtual machines” on page 65.

m The browsing timeout value must not be set too low.
See “Changing the browsing timeout for virtual machine discovery”
on page 159.

63



64 | Configure NetBackup policies for VMware
Browse for VMware Virtual Machines

m VM Host Name, Display Name, UUID, etc.
When you select an ESX server in the left pane, information about its virtual
machines appears in columns in the right pane. You can change the settings
and arrangement of these columns by right-clicking on any of the column
headers.
The columns are the following:

VM Host Name The host name of the virtual machine.

Display Name The display name of the virtual machine.

UUID The UUID of the virtual machine.

VM DNS Name The VMware "DNS Name" of the virtual machine. In
vSphere Client, this name appears on the virtual machine's
Summary tab.

See “Primary VM identifier options (VMware)” on page 53.
IP Address The IP address of the virtual machine.

oS The guest OS system as defined when the virtual machine
was created.

Data Store The datastore where the virtual machine configuration
files are stored. If the datastore is in a datastore cluster,
NetBackup displays the name of the datastore (not the
name of the cluster).

Power The power on/off status of the virtual machine when it
was last discovered.

RDM Status Shows whether the virtual machine has a physical disk in
raw device mapping mode (RDM) or has an independent
drive.

Platform The VMware release version of the virtual machine

(vimx-04, vinx-07, or vinx-08).

Discovered Timestamp The time and date at which the virtual machine's UUID
was initially discovered and cached.

Change Tracking Support Shows whether the virtual machine supports the VMware
Changed Block Tracking feature (for BLIB). Changed Block
Tracking requires ESX server 4.0 and a virtual machine
at vmx-07 or later.

ESX Host The ESX server in which the virtual machine resides (also
appears in the left pane).
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Data Center The datacenter that contains the virtual machine (also
appears in the left pane).

Virtual Center Name The vCenter server that manages the ESX server (also
appears in the left pane).

The virtual machines you selected are listed in the Clients tab.

Wirtual maching selection:
£ Select manually

" Select automatically through querny

Client name | Haridware | Operating Spstermn
zarvm1.min.com w07 wint et nterpriselGuest
Zarvmz. min.com w07 winLonghormGuest

Limiting the VMware servers that NetBackup searches
when browsing for virtual machines

As part of creating a NetBackup policy, you must specify which virtual machines
to back up. One approach is to let NetBackup search the network and list all
available virtual machines. However, if your VMware environment contains many
VMware servers and virtual machines, it may take too long to search and list all
of them. For example, consider an environment with 10 vCenter servers. To back
up the virtual machines on one of the 10 vCenter servers, browsing virtual
machines on all 10 servers is unnecessary.

To speed up browsing, you can exclude particular VMware servers from the search.
When it probes the network for virtual machines, NetBackup queries only the
VMware servers that are not named in the exclude list for the backup-host.

To limit the VMware servers that NetBackup discovers, per backup host

1 On the Windows desktop of the backup host, click Start > Run and enter
regedit.

2 Tobe on the safe side, make a backup of the current registry (File > Export).

Go to HKEY_LOCAL_MACHINE > SOFTWARE > Veritas > NetBackup >
CurrentVersion > Config and create a key called Backup.

4  Right-click in the right pane and click New > String Value. Enter
excludeVMservers as the name.
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5 Right-click the excludevMservers name and click Modify.

6 Inthe EditString dialog, enter acomma-delimited list of the VMware servers
that are NOT to be queried when NetBackup browses the network. Do not
enter spaces. You can enter vCenter servers and individual ESX servers.

Edit String EE

YWalug name:

IE-':-:I:|L.II:|E-'"'.-"M TEIVES

Walue data:

Q. Cancel

Note: The exclude list is used on the next backup. If any bpfis processes are
running, the exclude list has no effect on them.

The exclude list applies only to this backup host. The servers are not queried
when NetBackup browses for virtual machines to list on the policy's Browse
for Virtual Machines dialog of the NetBackup Administration Console.

As an alternative, NetBackup can automatically select virtual machines based on
arange of criteria.

See “About automatic virtual machine selection for NetBackup for VMware”
on page 72.

Virtual machine host names and display names must
be unique in a master server's policies

Certain VMware environments do not require unique names for virtual machines.
For instance, virtual machines within a vCenter server can have the same host or
display names as virtual machines in another vCenter server. The same is true of
datacenters, which are logical groupings of virtual resources within a vCenter
server. Virtual machine host names or display names must be unique within a
datacenter, but need not be unique between two datacenters on the same vCenter.
Avirtual machine named VM1 can exist in datacenter A. Another virtual machine
(also named VM1) can exist in datacenter B, on the same vCenter server.
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Identically named virtual machines however present a problem in the following
case: the same NetBackup master server is configured to back up the virtual
machines by means of the same host name or display name. The virtual machines
that are backed up by a particular NetBackup master server must be uniquely
identified across all of its policies.

To back up the two virtual machines named VM1, do one of the following:
m Change their VMware names so they are unique in the master server's policies.

m Configure the policies to identify the virtual machines by their UUIDs. Use
the type of UUID that is appropriate for your virtual machine environment.
See “Primary VM identifier options (VMware)” on page 53.

Primary VM identifier option and manual selection
of virtual machines

This topic applies to the manual selection of virtual machines on the NetBackup
Browse for VMware Virtual Machines screen.

A change to the policy's Primary VM identifier value can affect backups. If you
change this option, you may have to delete the virtual machine selections on the
Clients tab and re-enter them. Otherwise, NetBackup may no longer be able to
identify the virtual machines to back up.

For example, the host names in the Clients tab cannot be used and the virtual
machines are not backed up in the following case:

m If you change the Primary VM identifier from VM hostname to VM display
name, and

m The display names of the virtual machines are different from the host names.

In this case, delete the host name entries on the Clients tab and browse the network
to select the virtual machines by display name.

See “Browse for VMware Virtual Machines” on page 61.

Note: When creating virtual machines, use the same name for both host name
and display name. If the Primary VM identifier is changed, the existing entries
on the Clients tab still work.

If the policy selects virtual machines automatically, refer to the following topic:

See “Effect of Primary VM identifier parameter on Selection column in Test Query
results” on page 104.
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About incremental backups of virtual machines

NetBackup enables full virtual machine and file-level incrementals in the same
backup (the Enable file recovery from VM backup option).

Better support for incremental backup is available when you use vStorage and
BLIB (Enable block-level incremental backup). BLIB requires ESX 4.x and virtual
machines at vimx-07 or later.

Note: Individual file recovery is supported from full backups and from incremental
backups, as long as the Enable file recovery from VM backup policy option is
enabled.

Note: In earlier releases of NetBackup for VMware, incremental backups had to
be based on timestamps, not on archive bit. This requirement has been removed
from NetBackup 7.5. For incremental backups, you do not have to configure the
client on the VMware backup host for timestamps .

Configuring incremental backups

Use the following procedure for virtual machine backup.
To configure incremental backup of a virtual machine (vStorage)
1 Inthe NetBackup policy Attributes tab, select the VMware policy type.
2 Onthe VMware tab, select the VMware backup host.
3 Optional: for BLIB, select Enable block-level incremental backup.
4  Select Enable file recovery from VM backup.
More information is available on the VMware options.
See “Backup options on the VMware tab” on page 51.
Click OK.

On the Schedules tab, select Differential Incremental Backup or Cumulative
Incremental Backup.

7 Fillin the Clients tab.
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Volume Manager volumes in the virtual machine

To back up a virtual machine that contains Veritas Storage Foundation Volume
Manager volumes, make sure the following options on the policy's VMware tab
are disabled:

Enable file recovery from VM backup
Exclude deleted blocks.

Note: Restore of selected files from a backup of the full virtual machine is not
supported if the virtual machine contains Storage Foundation Volume Manager
volumes.

See “NetBackup for VMware: notes and restrictions” on page 32.

About older NetBackup policies and pre-7.x backup
hosts

A NetBackup 7.x master server can use the policies that were created for NetBackup
6.5.x. NetBackup however does not convert the 6.5.x options to 7.x options. It uses
the policies as is, without modification or conversion.

Even if the policies are updated to the 7.x options, a 6.5.x backup host ignores
those options. The backup host must be updated to 7.x to recognize and use the
7.x policy options.
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Configure automatic
selection of virtual
machines for backup

This chapter includes the following topics:

m About automatic virtual machine selection for NetBackup for VMware
m The basics of a NetBackup query rule

m Important notes on automatic virtual machine selection

m NetBackup requirements for automatic virtual machine selection
m Automatic virtual machine selection: Task overview

m Options for selecting VMware virtual machines

m Configuring automatic virtual machine selection

m Editing an existing query in Basic Mode

m Using the Query Builder in Advanced Mode

m AND vs OR in queries

m Examples for the NetBackup Query Builder

m The IsSet operator in queries

m Multiple VMware policies that work together

m Order of operations in queries (precedence rules)

m Parentheses in compound queries
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m Query rules for resource pools

m Query rules for datacenter folders (HostFolder)
m Query Builder field reference

m Test Query screen

m Test Query: Failed virtual machines

m Effect of Primary VM identifier parameter on Selection column in Test Query
results

m Effect of Primary VM identifier parameter on VM Name column in Test query
results

About automatic virtual machine selection for
NetBackup for VMware

Instead of manually selecting the virtual machines for backup, you can configure
NetBackup to automatically select virtual machines based on a range of criteria.
You specify the criteria (rules) in the Query Builder on the NetBackup policy
Clients tab. NetBackup creates a list of the virtual machines that currently meet
the rules and adds those virtual machines to the backup.

This feature is called the Virtual Machine Intelligent Policy.
Automatic selection of virtual machines has the following advantages:

m Simplifies the policy configuration for sites with large virtual environments.
You do not need to manually select virtual machines from a long list of hosts:
NetBackup selects all the virtual machines that meet the selection rules in the
policy's Query Builder.

m Allows the backup list to stay up-to-date with changes in the virtual
environment.
Eliminates the need to revise the backup list whenever a virtual machine is
added or removed.

m Virtual machine selection takes place dynamically at the time of the backup.

Examples of automatic virtual machine selection are the following:
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Table 6-1 Examples for automatic virtual machine selection
Example Description
Add new virtual machines At the next backup, the policy can automatically

discover the virtual machines that have recently
been added to the environment. If the virtual
machines match the query rules that you
configure in the policy, they are automatically

backed up.
Limit the backup list to the virtual If some of your virtual machines are occasionally
machines that are currently powered | powered off, NetBackup can be configured to
on automatically exclude those from the backup list.

Among the virtual machines it discovers,
NetBackup backs up only the virtual machines
that are powered on.

Back up virtual machines based on Examples of physical boundaries are vCenter
physical boundaries servers, ESX servers, datastores, and clusters. For
example, a query rule can select all the virtual
machines in a particular ESX server, so the policy
backs up only those virtual machines.

Back up virtual machines based on Examples of logical boundaries are folders, vApps,
logical boundaries templates, and resource pools. For example, a
query rule can select all the virtual machines in
a particular folder, so the policy backs up only
those virtual machines.

The basics of a NetBackup query rule

For automatic virtual machine selection, NetBackup uses query rules to determine
which VMware virtual machines to select for backup. You create the rules in the
Query Builder, on the Clients tab of the policy.

A query rule consists of the following:

m Akeyword, such as Displayname or Datacenter (many keywords are available).
For example: For automatic selection of the virtual machines with the display
names that contain certain characters, you need the Displayname keyword
in the rule.

m An operator, such as Contains, StartsWith, or Equal.
The operator describes how NetBackup analyzes the keyword. For example:
Displayname StartsWith tells NetBackup to look for the display names that
start with particular characters.
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m Values for the keyword.
For the Displayname keyword, a value might be "prod". In that case, NetBackup
looks for the virtual machines that have the display names that include the
characters prod.

m Anoptional joining element (AND, AND NOT, OR, OR NOT) to refine or expand
the query.

The policy uses these elements to discover and select virtual machines for backup.

Table 6-2 contains examples of rules.

Table 6-2 Examples of rules
Rule Description
Displayname Contains "vm" NetBackup selects the virtual machines that have the

characters vm anywhere in their display names.

Displayname EndsWith "vm" NetBackup selects the virtual machines that have the
characters vm at the end of their display names.

Datacenter AnyOf NetBackup selects the virtual machines that use
"datacenter1”,"datacenter2" datacenterl or datacenter2.
Powerstate Equal poweredOn NetBackup selects only the virtual machines that are

currently powered on.

Important notes on automatic virtual machine
selection

The Virtual Machine Intelligent Policy feature in NetBackup is a different approach
to VMware virtual machine selection in the policy. It represents a paradigm shift
in the way you select virtual machines for backup. As with all major changes, the
effective use of this feature requires forethought, preparation, and care.
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Table 6-3 Important notes on automatic virtual machine selection!
Note! Explanation
Create rules carefully.... Instead of manually selecting virtual machines for backup, you create guidelines for

automatic selection of virtual machines. The guidelines are called rules; you enter
the rules in the policy's query builder.

You make the rules, and NetBackup follows them.

If the rules state: Back up all virtual machines with a host name that contains "prod",
NetBackup does that. Any virtual machine that is added to the environment with a
host name containing "prod" is automatically selected and backed up when the policy
runs. Virtual machines with the names that do not contain "prod" are not backed up.
To have other virtual machines automatically backed up, you must change the query
rules (or create additional policies).

Changes to the virtual If many virtual machines are temporarily added to your environment and happen to
environment can affect fall within the scope of the query rules, they are backed up. The backups can therefore
backup times. run much longer than expected.

Test the query rules. Test the query rules ahead of time. The policy includes a Test Query function for that
purpose. It's important to verify that your query operates as expected. Otherwise,
the query may inadvertently select too many or too few virtual machines.

As an alternative, you can use the nbdiscover command to test a query. Refer to
the NetBackup Commands Reference Guide.

Note also: The policy's Primary VM identifier parameter can affect the automatic
selection process.

See “Effect of Primary VM identifier parameter on Selection column in Test Query
results” on page 104.
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Table 6-3

Important notes on automatic virtual machine selection! (continued)

Note!

Explanation

A query test does not create
the backup list. NetBackup
creates the backup list when
the backup runs.

Query test
Backup
list
Backup
execution

The automatic selection process is dynamic. Changes in the virtual environment may
affect which virtual machines the query rules choose when the backup runs.

Note: If virtual machine changes occur, the virtual machines that are selected for
backup may not be identical to those listed in your query test results.

The policy does not display a
list of the virtual machines
that are to be backed up.

Use the Activity Monitor or
OpsCenter.

If you select virtual machines manually (with the Browse for Virtual machines screen),
the selected virtual machines are listed on the policy Clients tab. But when you use
the query builder for automatic selection, the selected virtual machines are not listed
on the Clients tab.

For a list of the virtual machines that were backed up, use the NetBackup Activity
Monitor or the OpsCenter web interface.

See “Using the Activity Monitor to monitor virtual machine backups” on page 117.

See “Using OpsCenter to report on virtual machine backups” on page 122.




Configure automatic selection of virtual machines for backup | 77
NetBackup requirements for automatic virtual machine selection

Table 6-3 Important notes on automatic virtual machine selection! (continued)

Note! Explanation

When you save the policy, | When you save a policy, policy validation does not consult the query rules and select
the query rules are not virtual machines for backup. Because of the potential for changes in the virtual
validated. environment, virtual machine selection must wait until the backup runs. As a result,
when you save the policy, NetBackup does not check the policy attributes against a
backup list. If the query rules select the virtual machines that are incompatible with
apolicy attribute, policy validation cannot flag that fact. The incompatibility becomes
%1‘ apparent when NetBackup determines the backup list at the time of the backup.
=

Take for example a policy that is configured for Enable block-level incremental
Policy backup (BLIB). BLIB works only with ESX 4.0 virtual machines at version vimx-07 or
later. If the query rules select a virtual machine at a version earlier than vmx-07, the
policy cannot back up that virtual machine. The mismatch between the policy and
the virtual machine is revealed when the backup runs, not when the policy is validated.
The Activity Monitor's job details log indicates which virtual machines can or cannot
be backed up.

NetBackup requirements for automatic virtual
machine selection

Note the following requirements for automatic selection of VMware virtual
machines:

m vStorage is required for automatic discovery of virtual machines.

m Automatic virtual machine selection requires no additional license beyond the
NetBackup Enterprise Client license.

m Refer to the following Symantec document for updates on NetBackup support
requirements:
Support for NetBackup 7.x in virtual environments
http://www.symantec.com/docs/TECH127089

Automatic virtual machine selection: Task overview

This topic is a high-level overview of how to set up a NetBackup policy for
automatic selection of VMware virtual machines. Follow the links in the table for
more details.


http://www.symantec.com/docs/TECH127089
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Table 6-4 Automatic selection of virtual machines: overview of the tasks
Steps to configure automatic Description and notes
selection
Configure a VMware policy Use the policy Attributes tab.
See “Configuring a VMware policy from the Policies utility” on page 48.
Set rules for virtual machine On the policy Clients tab, click Select automatically through query.

selection in the policy Query Builder Choose a host for virtual machine selection (default is the VMware backup
host).

To add rules, use the Query Builder drop-down fields.

See “Configuring automatic virtual machine selection” on page 81.

See “ Options for selecting VMware virtual machines” on page 78.

Test the rules Click Test Query in the Query Builder on the Clients tab. Virtual machines
are labeled as included or excluded, based on the rules.

Note: The list of virtual machines is not saved in the Clients tab.

Note: The query rules are also displayed in the Backup Selections tab. The
backup selections are pre-set to All_ LOCAL_DRIVES (not displayed).

As an alternative, you can use the nbdiscover command to test a query.
Refer to the NetBackup Commands Reference Guide.

Execute a backup When the policy executes, NetBackup consults the rules in the Query Builder,
creates a list of virtual machines, and backs them up.

Check the backup To see which virtual machines were backed up, use the Activity Monitor, or
run a Virtual Client Summary report in OpsCenter.

See “Using the Activity Monitor to monitor virtual machine backups”
on page 117.

See “Using OpsCenter to report on virtual machine backups” on page 122.

Options for selecting VMware virtual machines

This topic describes the options on the policy Clients tab or on the Automatic
Discovery Options panel of the Policy Wizard.

You can use these options to manually select virtual machines, or to configure
NetBackup to select virtual machines automatically. For automatic selection, you
specify the selection criteria (rules) in the policy's Query Builder. When the backup
jobruns, NetBackup discovers the virtual machines that currently meet the criteria
and backs up those virtual machines.
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A procedure is available.

See “Configuring automatic virtual machine selection” on page 81.

Table 6-5 Virtual machine selection (not available on the Automatic Discovery
Options wizard panel)

Option Description
Select manually Click this option and click New to manually enter virtual machines names, or to browse

and select them from a list.

See “Browse for VMware Virtual Machines” on page 61.

Note: The rest of the fields and options are for automatic selection of virtual machines.
Select automatically | Click this option to allow NetBackup to automatically select virtual machines for backup
through query based on the rules that you enter in the Query Builder.
NetBackup host to This host discovers virtual machines and automatically selects them for backup based on
perform automatic your query rules. The resulting list determines which virtual machines are backed up.
v1rtua.l machine To designate your media servers as discovery hosts, select Backup Media Server from the
selection

pull-down.

Table 6-6 Query Builder
Option Description
Query Builder (Join, | Use these pull-down fields to define rules for automatic selection of virtual machines. From
Field, Operator, left to right, each pull-down refines the rule.
Values) Click the plus sign to add the rule to the Query pane.

Click the reset icon (curved arrow) to blank out the pull-down fields.

See “Query Builder field reference” on page 94.

See “Examples for the NetBackup Query Builder” on page 86.
Advanced Places the Query Builder in Advanced Mode for manual entry of rules.

See “Using the Query Builder in Advanced Mode” on page 84.

See “Query Builder field reference” on page 94.

See “Examples for the NetBackup Query Builder” on page 86.
Basic Returns the Query Builder from Advanced Mode to Basic Mode.

See “Query Builder field reference” on page 94.
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Table 6-6 Query Builder (continued)
Option Description
Edit Use this option to change an existing query rule when in Basic Mode, as follows:
m  Click the rule and then click Edit.
B Make new selections in the Query Builder pull-down fields.
m Click the save option (diskette icon).
Remove Deletes a query rule when in Basic Mode. Click on the rule and then click Remove.
Test Query Click this option to test which virtual machines NetBackup selects based on the rules in
the Query Builder.
Note: This test option does not create the backup list for the policy. When the next backup
runs from this policy, NetBackup re-discovers virtual machines and consults the query
rules. At that time, NetBackup backs up the virtual machines that match the rules.
See “Test Query screen” on page 101.
As an alternative, you can use the nbdi scover command to test a query. Refer to the
NetBackup Commands Reference Guide.
Reuse VM selection | Sets the refresh rate of an internal cache of the query results. NetBackup uses the cache
query results for: to determine which virtual machines to select at the time of the backup. The cache speeds

up the selection of virtual machines without burdening the vCenter server at each scheduled
backup.

A faster cache refresh rate synchronizes the cache with the changes recorded in vCenter,
such as the addition or removal of virtual machines. However, each cache refresh consumes
vCenter resources.

With a slower refresh rate, new virtual machines may not be included immediately in the
next backup. New or changed virtual machines are included when the cache is refreshed.
Note that fewer vCenter resources are consumed with a slower refresh rate.

The default is eight hours. For eight hours, NetBackup uses the cache and does not attempt
to rediscover virtual machines. Changes to the virtual environment do not affect the cache
during that period. After eight hours, the next execution of the policy causes NetBackup
to rediscover virtual machines. If any changes match a rule in the query, the list of selected
virtual machines is modified accordingly.

Note: The cache is refreshed before the next scheduled backup whenever the policy is
changed and saved.

More information is available on the Reuse VM selection query results for: option:

See “About the Reuse VM selection query results option” on page 171.
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Configuring automatic virtual machine selection

NetBackup can automatically select VMware virtual machines for backup based
on the criteria that you enter. You specify the criteria (rules) in the Query Builder
on the NetBackup policy Clients tab. You can set up rules to include certain virtual
machines for backup, or to exclude virtual machines.

When the backup job runs, NetBackup creates a list of the virtual machines that
currently meet the query rules and backs them up.

The following is an initial view of the policy Clients tab with Select automatically
through query selected.

Figure 6-1 Policy Clients tab for automatic selection of virtual machines
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The Query Builder can operate in Basic Mode or in Advanced Mode.

To configure automatic virtual machine selection in Basic Mode
1 Onthe policy Attributes tab, specify the following:
m VMware for the policy type.
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m On the VMware policy tab, select a VMware backup host.

2 Review the other options on the VMware tab.
See “Backup options on the VMware tab” on page 51.
Make other policy selections as needed (for example, create a Schedule).
Click the Clients tab, and click Select automatically through query.

If you selected virtual machines in the Browse for Virtual Machines dialog,
those virtual machines are removed from the policy.

5 To create a rule, make selections from the pull-down menus.

For the first rule, you can start with the Field pull-down, depending on the
type of rule. (For the first rule, the only selections available for the Join field
are blank (none), or NOT.)

- Query Builder
oin: Field: Operatar: aluefs):
. |Annotation -
Query (Basic | oo
e datacenter |

datacenterpath
datastore -
Displayname
esxserver
hastfolder
netwitk
FEsOUrCEpoal h

For the Value(s) field: you can click the folder icon to browse for values, enter
the value manually, or in some cases use the Value(s) drop-down. The
characters you enter in the Values field must be enclosed in single quotes or
double quotes. Note that browsing for values may take some time in large
virtual environments.

See “Query Builder field reference” on page 94.

GQuery Builder

Join: Field: Operator: i
j powerstate j IEqua\ j oweredOl
"Query {Basic Mode)

LT |
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Click the plus sign to add the rule to the Query pane.

Query Builder
Jain: Field: Operator: Walue(s):

I j powerstate j IEqua\ j IpoweredOn j :I gl

Query (Basic Mode,

Create more rules as needed.
See “Query Builder field reference” on page 94.
See “Examples for the NetBackup Query Builder” on page 86.

To see which virtual machines NetBackup currently selects based on your
query, click Test Query.

On the Test Query screen, the Virtual machines in your current environment
that match the rules for selection in the policy are labeled INCLUDED. Note
however that the Test Query option does not create the backup list for the
policy. When the next backup runs from this policy, NetBackup re-discovers
virtual machines and consults the query rules. At that time, NetBackup backs
up the virtual machines that match the query rules.

The list of virtual machines is saved but the virtual machines are not displayed
in the policy's Clients tab.

See “Test Query screen” on page 101.

You can specify how long NetBackup uses the latest query results as the
backup list for future executions of the policy. Set the time period in Reuse
VM selection query results for.

The default is eight hours.
More information is available on this setting:
See “About the Reuse VM selection query results option” on page 171.

To create queries manually (Advanced Mode) instead of using the pull-down
menus, click Advanced.

See “Using the Query Builder in Advanced Mode” on page 84.
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Editing an existing query in Basic Mode

To edit an existing query in Basic Mode

1
2
3
4

Click on the query rule you want to change and click Edit.
Make selections in the pull-down menus.
Click the save option (diskette icon).

To delete a rule, click on it and click Remove.

See “Using the Query Builder in Advanced Mode” on page 84.

Using the Query Builder in Advanced Mode

The Query Builder's Advanced Mode provides more flexibility in crafting rules
for virtual machine selection, including the use of parentheses for grouping.

To use the Query Builder in Advanced Mode

1

Set up a VMware policy and specify a VMware backup host or backup media
server.

For assistance, you can refer to the first few steps of the following procedure:
See “Configuring automatic virtual machine selection” on page 81.

Click the Clients tab.

Click Select automatically through query.

Beneath the Query Builder pane, click Advanced.

Note that the following appears at the start of the query:

vmware:/?filter=
This string must be the first entry in the query. It should appear only once,
no matter how many rules are added in the Query pane.

You can use the Query Builder drop-down menus to add query rules. You can
also type in rules manually.

Here are a few example queries:
vmware:/?filter=VMFolder Contains "mango"
vmware:/?filter=Datastore StartsWith "Acc" OR Datastore StartsWith "Prod"

vmware:/?filter=vCenter Contains "ROS" AND ESXserver Equal "VM_test1"
AND Powerstate Equal poweredOn
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6 Toinsert a rule between existing rules, place the cursor where you want the
new rule to start and type it in.

When you create a rule with the drown-down menus, it appears at the end of
the query. You can cut and paste it into the proper location.

7 To establish the proper order of evaluation in compound queries, use
parentheses to group rules as needed. Compound queries contain two or more
rules, joined by AND, AND NOT, OR, or OR NOT.

More information is available on the use of parentheses and on the order of
precedence.

See “AND vs OR in queries” on page 85.
See “Order of operations in queries (precedence rules)” on page 89.

See “Parentheses in compound queries” on page 91.

AND vs OR in queries

The Join field in the Query Builder provides connectors for joining rules (AND,
AND NOT, OR, OR NOT). The effect of AND versus OR in the Query Builder may
not be obvious at first glance.

In essence, AND and OR work in this way:

m AND limits or restricts the scope of the query.

m ORopens up the query to an additional possibility, expanding the scope of the
query.

Note: Do not use AND to join the rules that are intended to include additional
virtual machines in the backup list. For instance, AND cannot be used to mean
"include virtual machine X AND virtual machine Y."

For example: To include the virtual machines that have either "vm1" or "vm2" in
their names, use OR to join the rules:

Displayname Contains "wvml"

OR Displayname Contains "vm2"
If you use AND to join these rules:

Displayname Contains "vml"
AND Displayname Contains "vm2"

the result is different: the backup list includes only the virtual machines that have
both vinl and vm2 in their names (such as "acmevmlvmz2"). A virtual machine
with the name "acmevm1" is not included in the backup.
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Table 6-7 provides examples with AND and OR.

Table 6-7

Queries with AND, OR

Query

Description

Displayname Contains "vm1"

OR Displayname Contains "vm2"

This query selects any virtual machine that has either vm1 or vm2 in its
display name. For example, this query selects both "seabizvm1" and
"seabizvm2" for backup.

vCenter Equal "vCenterServer_1"
AND Datacenter Equal "dc_A"

AND ESXserver Equal "prod"

AND VMHostName Contains "manu"

This query is very specific. Virtual machines with the host names that
contain "manu" are included in the backup only if: they reside in vCenter
server "vCenterServer_1", datacenter "dc_A", and ESX server "prod".

The virtual machines that do not reside in that hierarchy are not included.
For example: if a virtual machine resides in "vCenterServer_1" and
datacenter "dc_A", but not in ESX server "prod", that virtual machine is
not included.

vCenter Equal "vCenterServer_1"
OR Datacenter Equal "dc_A"
OR ESXserver Equal "prod"

OR VMHostName Contains "manu"”

This query uses the same keywords and values, but combines them with
OR. The result may be a much larger list of virtual machines.

A virtual machine that meets any of these rules is included:

m  Any virtual machines in vCenter "vCenterServer_1". Their host names,
datacenter, or ESX server do not matter.

B Any virtual machines in datacenter "dc_A". Their host names or server
do not matter.

B Any virtual machines in ESXserver "prod". Their host names, datacenter,
or vCenter server do not matter.

B Any virtual machines with a host name that contains "manu". Their
server or datacenter do not matter.

Examples for the NetBackup Query Builder

The following table provides example query rules.

To use the Query Builder, you must click Select automatically through query on
the Client tab.
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Query Builder examples

Example query

Query result when backup job executes

No query rules specified (Query pane is empty)

All virtual machines are added to the backup list. Exceptions are
those that do not have a host name, or that have invalid characters
in the display name.

See “Effect of Primary VM identifier parameter on Selection column
in Test Query results” on page 104.

Displayname Contains "prod"

Allvirtual machines with the display names that contain the string
"prod" are added to the backup list.

See “Effect of Primary VM identifier parameter on Selection column
in Test Query results” on page 104.

powerstate Equal "poweredOn"

Any virtual machine that is powered on is added to the backup list.

VMGuestOS Equal "windows7Guest"

All virtual machines with a guest OS of Windows 7 are added to
the backup list.

DisplayName AnyOf "grayfox7”,"grayfox9"

The virtual machines named "grayfox7”and "grayfox9" are added
to the backup list. (Note that each value must be enclosed in its
own quotes, with a comma in between.)

powerstate Equal "poweredOn"
AND Datastore Equal "Storage_1"
AND VMGuestOS Equal "rhel4Guest"

In datastore Storage_1: any virtual machine that is powered on and
has a guest OS of Red Hat Linux 4 is added to the backup list.

vCenter Equal "vCenterServer_1"

AND ESXserver Contains "prod"

In the vCenter server vCenterServer_1, virtual machines that are
in ESX servers with names containing "prod" are added to the
backup list.

Cluster Equal "VMcluster_1"

AND ESXserver AnyOf
"ESX_1","ESX_2","ESX_3"

AND VMHostName Contains "Finance"

In cluster VMcluster_1, all virtual machines with the host names
that contain "Finance", in ESX servers ESX_1, ESX_2, ESX_3, are
added to the backup list.

VMFolder StartsWith "Prod"
OR VMFolder NotEqual "VM_test"

For any folder whose name starts with "Prod" or whose name is
not "VM_test", add its virtual machines to the backup list.

Examples with IsSet

See “The IsSet operator in queries” on page 88.

Click Advanced to see the query rule in Advanced Mode. Only Advanced Mode
supports the use of parentheses for grouping sets of rules.

See “Using the Query Builder in Advanced Mode” on page 84.
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The IsSet operator in queries

In a query, you can use the IsSet operator to ensure that certain virtual machines
are included or excluded from the backup.

For example: if the Primary VM identifier parameter is set to VM hostname,
NetBackup is unable to identify virtual machines for backup that do not have a
host name. You can use IsSet to exclude such virtual machines from the backup
list.

Table 6-9 Examples of queries with the IsSet operator

Query rules with IsSet operator Effect of the query on virtual machine selection

Cluster Contains "dev"

INCLUDED: Any virtual machine in a cluster that has a name that contains
the string "dev" if the virtual machine also has a VMware DNS name.

AND VMDNSName IsSet
EXCLUDED: Any virtual machines that do not have a VMware DNS Name.
Without VMDNSName IsSet in this query, virtual machines without a DNS
name cannot be excluded. They would be listed as FAILED.

Displayname Contains "prod" INCLUDED: Any virtual machine with a display name that contains the

AND VMHostName IsSet string "prod" if the virtual machine also has a host name.

EXCLUDED: Any virtual machines that do not have host names.

Without VMHostName IsSet in this query, virtual machines without a host
name cannot be excluded. They would be listed as FAILED.

The policy's Primary VM identifier parameter has an important effect on which
virtual machines NetBackup can back up. This parameter affects the test query
results.

See “Effect of Primary VM identifier parameter on Selection column in Test Query
results” on page 104.

Multiple VMware policies that work together

If your virtual environment has many virtual machines with inconsistent naming
conventions, you may need multiple policies working in tandem. It may be difficult
to create a single policy that automatically selects all the virtual machines that
you want to back up.

For this situation, configure several policies such that each policy backs up a
portion of the environment. One policy backs up a particular set or group of virtual
machines, such as those that have host names. A second policy backs up a different
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group of virtual machines that were not backed up by the first policy, and so forth.
When all the policies have run, all the virtual machines are backed up.

The following table describes policies that are designed to back up the virtual
environment in three phases. Note that each policy relies on a different setting
for the Primary VM identifier parameter.

Table 6-10 Three policies that back up virtual machines in phases
Policy Query Builder rules Backup result
First policy VMHostName IsSet This policy backs up all virtual machines that have a
Primary VM identifier host name. Any virtual machines that do not have a

parameter: VM hostname

host name are excluded from the backup.

Second policy
Primary VM identifier

parameter: VM display name | 'TRUE'

NOT VMHostName IsSet This policy backs up all virtual machines that do not
have a host name but that do have a valid display name.
Any virtual machines that do not have a host name or
a valid display name are excluded from the backup.

AND VMHasVDSName Equal

See “NetBackup character restrictions for virtual
machine display names” on page 35.

Third policy

Primary VM identifier
parameter: VM UUID

NOT VMHostName IsSet This policy backs up the virtual machines that were
not backed up by the first two policies. This policy
selects the virtual machines that do not have a host
name or a valid display name, but that do have a UUID.

AND NOT VMHasVDSName
Equal 'TRUE'

More information is available on the Primary VM identifier parameter and its
effect on virtual machine selection.

See “Effect of Primary VM identifier parameter on Selection column in Test Query
results” on page 104.

Order of operations in queries (precedence rules)

The information in this topic is for advanced users who understand precedence
in programming languages. In the Query Builder, the order in which operations
occur can determine which virtual machines are selected and backed up.

The following table lists the order of operations, or precedence, from highest to
lowest (7 is the highest). For example, an operation with a precedence of 6 (such
as Contains) is evaluated before an operation with a precedence of 5 (such as
Greater).
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Table 6-11
Operation Description Precedence
Ix Produces the value 0 if x is true (nonzero) and |7
the value 1 if x is false (0).
x Contains y Does y exist somewhere in x 6
x StartsWith y Does x start with 'y 6
x EndsWith y Does x end with 'y 6
x AnyOf list Does x appear in list 6
x Greater y Is x greater than 'y 5
x GreaterEqual y Is x greater than or equal to y 5
x Lessy Isxless thany 5
x LessEqual y Is x less than or equal to y 5
x Equal y Isxequaltoy 4
x NotEqual y Is x not equal toy 4
Not x operator produces the value 0 if x is true 3
(nonzero) and the value 1 if x is false (0).
x Andy True if both x and y are true 2
xORy True if either x or y are true 1
Note the following:

m AND has a higher precedence than OR.

In the Query Builder's Advanced Mode, you can use parentheses to change the
order of evaluation in the rules that use AND or OR.

See “Parentheses in compound queries” on page 91.

m Inthe Query Builder's Advanced Mode, you can combine two or more operations
in a single rule without AND or OR to join them. Precedence determines the
order in which the operations are evaluated within the rule.

Example of a rule that includes three operations:

-

Displayname StartsWith “L” NotEqual Displayname contains “x

This rule selects the following virtual machines:
Virtual machines with the names that start with L.
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Virtual machines with the names that do not start with L but that do contain
X.

Explanation: The StartsWith and Contains operations have a precedence of 6,
whereas NotEqual has a lower precedence of 3. Starting on the left, the
StartsWith operation is evaluated first and the Contains operation is evaluated
next. The last operation to be evaluated is Not Equal.

See “Using the Query Builder in Advanced Mode” on page 84.

Parentheses in compound queries

You can use the Query Builder to make precise queries containing as many rules
as necessary to identify the appropriate virtual machines. In a query such as
powerstate Equal "poweredOn", the result of the query is easy to predict: only the
virtual machines that are powered on are included in the backup. But if several
rules are combined with AND and OR, the result may not be obvious. This kind of
query is called a compound query. Compound queries contain two or more rules,
joined by AND, AND NOT, OR, or OR NOT.

The order in which the Query Builder evaluates compound rules affects the
outcome of the query. Grouping the rules with parentheses can change the order
of evaluation and thus the outcome of the query.

The examples in the following table demonstrate how the Query Builder evaluates
compound queries with and without parentheses.

Note: Only the Query Builder's Advanced Mode supports the use of parentheses.

Table 6-12 Examples of compound queries with and without parentheses

Example query

The following virtual machines are selected

ESXServer Equal "ESX001" OR Folder | All virtual machines under ESX001 (regardless of power state), and virtual
Equal "FolderEngA" AND powerstate | machines under FolderEngA that are powered on.

Equal ON

To select only the virtual machines that are powered on in the ESX server
and in the folder, use parentheses (see next example).

(ESXServer Equal "ESX001" OR Folder | All the virtual machines that are powered on in ESX001 and in FolderEngA.

Equal "FolderEngA") AND powerstate

Equal ON
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Query rules for resource pools

If the resource pool that you query is nested, the choice of Operator determines
which virtual machines in the resource pool hierarchy are discovered.

For example, assume the following hierarchy of resource pools that contain virtual
machines:

Res/ResourcePool 1
VM1
VM2

/ResourcePool 2

VM3

VM4

/ResourcePool 3
VM5
VM6

where ResourcePool _1 contains virtual machines VM1 and VM2, and so forth.

The following table shows the query results with the Contains, Equal, StartsWith,
and EndsWith operators. (Other operators can be used.)

Note: If you want the query to include all virtual machines in a hierarchy of nested
resource pools, do not use Equal as the Operator.

Table 6-13

Example rules for nested resource pools

Query rule

Included virtual machines

Resourcepool Contains "Res/ResourcePool_1"

Includes all the virtual machines in the three resource
pools (VM1 through VM6).

Resourcepool Equal "Res/ResourcePool 1"

Includes only the virtual machines that are in
ResourcePool_1 (VM1, VM2). Virtual machines in the
sub-pools are not included (VM3 through VM6).

Resourcepool Equal "Res/ResourcePool_1/ResourcePool_2"

Includes only the virtual machines that are in
ResourcePool_2 (VM3, VM4).

Resourcepool StartsWith "Res/ResourcePool"

Includes all the virtual machines in the three resource
pools (VM1 through VM6).

Resourcepool StartsWith
"Res/ResourcePool_1/ResourcePool 2"

Includes only the virtual machines that are in
ResourcePool_2 and 3. Virtual machines in
ResourcePool_1 are not included.




Configure automatic selection of virtual machines for backup | 93
Query rules for datacenter folders (HostFolder)

Table 6-13 Example rules for nested resource pools (continued)
Query rule Included virtual machines
Resourcepool EndsWith "ResourcePool 2" Includes the virtual machines in ResourcePool_2 (VM3,
VM4) but not in ResourcePool_1 or 3.

These examples also apply to host folders.

See “Query rules for datacenter folders (HostFolder)” on page 93.

Query rules for datacenter folders (HostFolder)

In NetBackup terminology, a host folder is a folder that has been defined within
a VMware datacenter. A host folder can contain ESX servers or clusters, as well
as other folders. For example:

Folder 1

ESX1

ESX2

subfolder A
ESX3
ESX4

subfolder B
ESX_5
ESX_6

If you want NetBackup to select all the virtual machines within the top-level folder
and any subfolders, use the Contains or StartsWith operator. For example:

HostFolder Contains "Folder_ 1"

Note: If you want the query to include all virtual machines in the hierarchy of
folders, do not use Equal as the Operator.

If you want NetBackup to select the virtual machines within a subfolder only (such
as subfolder_A), use the Contains or Equal operator. For example:

HostFolder Equal "Folder_1/subfolder_A"

In this case, NetBackup includes only the virtual machines that reside on servers
ESX3 and ESX4.

For host folders, these operators work the same as they do for resource pools. For
further query builder examples, refer to the following topic (substitute host folder
for resource pool in the examples):
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See “Query rules for resource pools” on page 92.

Query Builder field reference

Table 6-14 describes the drop-down fields and options for creating rules in the

Query Builder.

Table 6-14

Query Builder drop-down options: Join, Field, Operator, Value(s)

Query Builder
drop-down fields

Description

Join

Selects a connector to join rules.

For the first rule, choices are blank (none) or NOT. After you add a
rule, the available connectors are AND, AND NOT, OR, OR NOT.

Field

Selects a parameter on which to build the rule. Select one from the
list (scroll down for additional parameters).

You can type the first character to speed up selection. For example,
on entering “d”, the list moves to first entry starting with "d". Another
entry of "d" moves through the list to the next entry starting with "d".
The selected entry is automatically filled in.

See Table 6-15 on page 95.

Operator

Selects an operator. The available operators depend on the parameter
that is selected for Field.

See Table 6-16 on page 100.

Value(s)

Specifies a value for the Field parameter.

The Value field allows manual entry. It may also be a drop-down,
depending on the selections that are made in the other fields.

For manual entry, you can specify multiple comma-separated values.

See Table 6-17 on page 101.

I,

Allows browsing for specific values, depending on the selections that
are made in the other drop-down fields.

Adds the current drop-down selections to the Query pane as a new
rule.
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Table 6-14 Query Builder drop-down options: Join, Field, Operator, Value(s)
(continued)
Query Builder Description

drop-down fields

@

Blanks out the drop-down fields.

Field (keywords)

Table 6-15 describes the keywords available in the Field drop-down. The table
also indicates whether the values for each keyword (in the Values field) are

case-sensitive.

Note that the inclusion or exclusion of virtual machines is not determined by the
Field keyword alone, but depends on the rule you construct: the combination of
Join, Field, Operator, and Value(s).

Table 6-15 Keywords in the Field drop-down
Field keyword Data type Description
Annotation Alphanumeric | The text that is added to virtual machine annotations in vSphere
string Client.
Values are case-sensitive.
Cluster Alphanumeric | The name of the cluster (a group of ESX servers) that the virtual
string machine is configured in.
Values are not case-sensitive.
Note: A virtual machine may be assigned to an ESX server that is
not in a cluster.
Note also that in VMware, a cluster name need only be unique within
a datacenter path.
Datacenter Alphanumeric | The name of the VMware datacenter.
string Values are not case-sensitive.
DatacenterPath Alphanumeric | The folder structure that defines the path to a datacenter. Use this
string option if the datacenter name that you want to filter on is not unique
in your environment.
Values are case-sensitive.
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Table 6-15 Keywords in the Field drop-down (continued)
Field keyword Data type Description
Datastore Alphanumeric | The name of the datastore.
string Values are case-sensitive.
Note: Multiple ESX servers can share access to the same datastore.
Also, a datastore name can be duplicated between multiple ESX
servers. Use DatacenterPath or ESXserver to uniquely identify the
datacenter.
DatastoreCluster Alphanumeric | The name of the datastore cluster that contains the datastores.
string Values are not case-sensitive.
DatastoreFolder Alphanumeric | The name of the folder that contains the datastores.
string Values are not case-sensitive.
DatastoreNFSHost Alphanumeric | The name of the datastore's NFS host.
string Values are not case-sensitive.
DatastoreNFSPath Alphanumeric | The folder structure that defines the path to an NFS datastore. Use
string this option if the NFS host name of the datastore that you want to
filter on is not unique in your environment.
Values are not case-sensitive.
DatastoreType Alphanumeric | The type of the datastore. Values are NFS or VMFS.
string Values are not case-sensitive.
Displayname Alphanumeric | The virtual machine's display name.
string Values are not case-sensitive.
ESXserver Alphanumeric | The name of the ESX server.
string Values are not case-sensitive.
The ESX host name must match the name as defined in the vCenter
server.
HostFolder Alphanumeric | The folder path between the datacenter level and a cluster, ESX hosts,
string or a subfolder.

Values are not case-sensitive.

See “Query rules for datacenter folders (HostFolder)” on page 93.
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Table 6-15 Keywords in the Field drop-down (continued)
Field keyword Data type Description
Network Alphanumeric | The name of the network switch (on an ESX server) or distributed
string switch.
Values are not case-sensitive.
NetworkFolder Alphanumeric | The name of the folder that contains the network.
string Values are not case-sensitive.
Powerstate Alphabetic The power state of the virtual machine.
Values are poweredOff, poweredOn, suspended.
Resourcepool Alphanumeric | The name of the resource pool. (A resource pool is similar to a vApp.)
string Values are not case-sensitive.
If aresource pool contains other resource pools (sub-pools), the choice
of Operator determines whether virtual machines in the sub-pools
are included.
See “Query rules for resource pools” on page 92.
Template Boolean TRUE if the virtual machine is a virtual machine template.
vApp Alphanumeric | The name of the vApp.
string

Values are not case-sensitive.

A vApp is a collection of virtual machines. vApps can also contain
resource pools and other vApps. vApps are components of standalone
ESX servers or of clusters.

Like vSphere Client, NetBackup refers only to the top level of a vApp
that contains sub vApps.

For the following rule:
vApp Equal "vappl"

if vapp1 has a sub vApp named "vapp2", any virtual machines in
vappl or vapp2 are included. You cannot make a rule that refers
specifically to vapp2.
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Table 6-15 Keywords in the Field drop-down (continued)
Field keyword Data type Description
vCenter Alphanumeric | The name of the vCenter server.
string Values are not case-sensitive.
The vCenter name that is specified in the Query Builder must match
the name as entered in the Administration Console for NetBackup
credentials. (Mediaand Device Management > Credentials > Virtual
Machine Servers.)
Note that a fully qualified domain name is recommended.
VMDNSName Alphanumeric | The virtual machine DNS name in vSphere Client.
string Values are not case-sensitive.
VMFolder Alphanumeric | The folder structure (within a datacenter) to a virtual machine folder,
string including all subfolders.
Values are not case-sensitive.
Examples are:
/clusters/discovered virtual machine
/standalone/folder1/folder2
VMGuestOS Alphanumeric | The virtual machine guest OS type that is recorded in vSphere Client.
string Values are case-sensitive.
VMHasIDE Boolean TRUE if the virtual machine has IDE drives.
VMHasMDS Boolean TRUE if the virtual machine has multiple datastores.
You can use this keyword to select any virtual machine that is
configured to use more than one datastore.
VMHasRDM Boolean TRUE if the virtual machine uses Raw Device Mapping (RDM).
VMHasSnap Boolean TRUE if a VMware snapshot of the virtual machine is currently active.
VMHasVDSName Boolean TRUE if the virtual machine has a display name that is valid for use
as the host name.
VMHostName Alphanumeric | The virtual machine name that is derived from a reverse lookup of
string its IP address.

Values are not case-sensitive.
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Table 6-15 Keywords in the Field drop-down (continued)
Field keyword Data type Description
VMIsConn Boolean TRUE if the virtual machine is connected and available.
For example: If a virtual machine's ESX server is down, that virtual
machine is not connected.
VMVersion Alphanumeric | The VMware version of the virtual machine.
string Values are case-sensitive.
For example: vimx-04, vinx-07, vinx-08.
VMXDatastore Alphanumeric | The name of the vmx datastore (sometimes called the vimx directory
string or configuration datastore).
Values are case-sensitive.
More information on the vimx datastore is available.
See “NetBackup for VMware terminology” on page 22.
VMXDatastoreFolder Alphanumeric | The name of the folder that contains the vmx datastores.
string Values are not case-sensitive.
VMXDatastoreNFSHost Alphanumeric | The name of the vimx datastore's NFS host.
string Values are not case-sensitive.
VMXDatastoreNFSPath Alphanumeric | The folder structure that defines the path to a vmx NFS datastore.
string Use this option if the NFS host name of the datastore that you want
to filter on is not unique in your environment.
Values are not case-sensitive.
VMXDatastoreType Alphanumeric | The type of the vmx datastore. Values are NFS or VMFS.
string Values are not case-sensitive.
[vSphere custom Alphanumeric | The value of a custom attribute that is set in vSphere Client for one
attributes] string or more virtual machines.
Note: in vSphere Client, the attribute must have a value for at least
one virtual machine. The attribute type must be Virtual Machine.
The values are case-sensitive.
Operators

Table 6-16 describes the operators available in the Operator drop-down.
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Table 6-16 Operators in the Operator drop-down

Operator Description

AnyOf Matches any of the specified values in the Value(s) field.
For example: If the ESX servers in the Value(s) field are "ESX01","ESX02,"ESX03", AnyOf matches
any ESX server that has one of those names. If the names of your servers are not identical to
any of the specified values, no match occurs. A server named ESX01A is not a match.

Contains Matches the value in the Value(s) field wherever that value occurs in the string.
For example: If the Value(s) entry is "dev", Contains matches strings such as "01dev", "01dev99",
"devOP", and "Development_machine".

EndsWith Matches the value in the Value(s) field when it occurs at the end of a string.
For example: If the Value(s) entry is "dev", EndsWith matches the string "01dev" but not
"01dev99", "devOP", or "Development_machine".

Equal Matches only the value that is specified in the Value(s) field.
For example: If the display name to search for is "VMtest27", Equal matches virtual machine
names such as VMTest27 or vimtest27 or vimTEST27, and so forth. The name VMtest28 is not
matched.

Greater Matches any value that is greater than the specified Value(s), according to the ASCII collating
sequence.

GreaterEqual Matches any value that is greater than or equal to the specified Value(s), according to the ASCII
collating sequence.

IsSet Determines whether a value is returned for the Field keyword. Use IsSet with another rule as
a condition, to ensure that the query selects the appropriate virtual machines.
Note that you do not make an entry under Value(s) for a rule that uses IsSet.
See “The IsSet operator in queries” on page 88.
See “Effect of Primary VM identifier parameter on Selection column in Test Query results”
on page 104.
See “Test Query: Failed virtual machines” on page 103.

Less Matches any value that is less than the specified Value(s), according to the ASCII collating
sequence.

LessEqual Matches any value that is less than or equal to the specified Value(s), according to the ASCII
collating sequence.

NotEqual Matches any value that is not equal to the value in the Value(s) field.
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Table 6-16 Operators in the Operator drop-down (continued)
Operator Description
StartsWith Matches the value in the Value(s) field when it occurs at the start of a string.
For example: If the Value(s) entry is "box", StartsWith matches the string "box_car" but not
"flatbox".
Value(s)
Table 6-17 describes the characters that can be entered in the Value(s) field. The
Field keyword determines case sensitivity.
Note: The character string you enter in the Value(s) field must be enclosed in
single quotes or double quotes.
Table 6-17 Characters you can enter for Value(s)
Character types String characters allowed
Alphanumerics AtoZ,atoz0to9, - (minus sign), and special characters.
Note: Decimal numbers only.
Wildcards * (asterisk) matches everything.

For example: "*prod*" matches the string "prod" preceded or followed by any characters.
? (question mark) matches any single character.

For example: "prod??" matches the string "prod" followed by any two characters.

Escape character

\ (backslash) escapes the wildcard or meta-character that follows it.

For example: To search for a string that contains an asterisk (such as test*), enter "test\*"

Quotation marks

Note: The characters you enter in Value(s) must be enclosed in single or double quotes.

To search for a string that contains quotation marks, either escape each quote (\") or enclose
the entire string in the opposite type of quotes.

For example: To search for a string that includes double quotes (such as "name"), enter
""name"' (enclosing it in single quotes) or "\"name\""

m

Test Query screen

This screen lists the virtual machines that NetBackup discovered in your virtual
environment when you clicked Test Query. Later changes in the virtual
environment may affect which virtual machines match the query rules. For
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example: if virtual machines are added, the test results may not be identical to
the virtual machines that are selected for backup when the backup runs.

When the next backup runs from this policy, the following occur: NetBackup
re-discovers virtual machines, consults the query rules, and backs up the virtual
machines that match the rules.

The list of backed up virtual machines is saved but the virtual machines are not
displayed in the policy's Clients tab. You can use the Activity Monitor to view the
virtual machine jobs, or you can run a Virtual Client Summary report in
OpsCenter.

Note: An alternative to the Test Query screen is the nbdiscover command. For
more information, see the NetBackup Commands Reference Guide.

See “Using the Activity Monitor to monitor virtual machine backups” on page 117.
See “Using OpsCenter to report on virtual machine backups” on page 122.

The Test Query function runs in the background. You can continue to configure
the policy while the test runs. Any changes you make in the Query Builder however
are not included in the currently running test. You must re-initiate the test to see
the results of your Query Builder changes.

Testing query Lists the rules in the Query Builder that were used in this test. The rules are specified in the Query
for policy Builder on the policy Clients tab.

Test query VM Name: Shows the display name of all discovered virtual machines.

results

Selection: Lists the virtual machines that were discovered, as follows:

INCLUDED: The virtual machine matches the rules in the query.

EXCLUDED: The virtual machine does not match the rules in the query.

FAILED: The virtual machine cannot be selected for backup because of a host name problem
or other error. Also, the query cannot exclude the virtual machine. An explanation appears at
the bottom of the Test Query screen. For example:

VM does not have a host name to use as a
client name, display name =

See “Test Query: Failed virtual machines” on page 103.
The operator IsSet can be used to filter out such virtual machines. More information is available
on IsSet.

See Table 6-16 on page 100.
See “The IsSet operator in queries” on page 88.
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The bottom of the screen gives a tally of how many virtual machines were included, excluded, or
failed in the test.

See “Using the Activity Monitor to monitor virtual machine backups” on page 117.

See “About automatic virtual machine selection for NetBackup for VMware”
on page 72.

See “Configuring automatic virtual machine selection” on page 81.

Test Query: Failed virtual machines

If the query rules cannot exclude a virtual machine, and that virtual machine
cannot be selected for backup, it is marked as FAILED. The virtual machine is
listed as not run in the job details log.

For example: the virtual machine does not have the type of name specified by the
Primary VM identifier parameter (such as host name or display name). Or the
virtual machine name contains invalid characters. In any case, a virtual machine
that is listed as FAILED should be investigated: it may be one that you want to
back up.

To see the reason for the failure, click on the virtual machine in the Test Query
Results. An explanation appears at the bottom of the screen.

For example:
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Test Query - dd

WM seleckion status is as per current WM environment, Query resulk may vary with any change in the
Wi environment

Testing query For policy: dd

vnware; 7filker=vApp Contains "vapp_tesk3"

—Test Query Resulks

W1 [ame | Selection ;l
EMkorl EXCLUDED I
EMkorlO E%CLUDED
fibit-rhS EXCLUDED

% iMew Yirkual Machine FAILED

&9 EMkorS FAILED

&3EMkor 1 FAILED

EIEMkarl2 FAILED -

3 il

M Failed
WM does nok have a host name to use as a client name, display name = [Mew Yirkual Maching], server

Included: O Excluded: 166 Failed: 4

Close I Help

Explanation: The virtual machine that is listed as New Virtual Machine in the
example does not have a VMware host name. In the NetBackup policy, on the
VMware tab, the Primary VM identifier parameter may be set to VM hostname.
In that case, NetBackup cannot refer to the virtual machine by its host name and
thus cannot back it up.

You can fix this problem in a couple of ways:
m Use vSphere Client to configure a host name for the virtual machine.

m To exclude the virtual machines that have no host name, construct a query
with the IsSet operator.

See “The IsSet operator in queries” on page 88.

Effect of Primary VM identifier parameter on
Selection column in Test Query results

The NetBackup policy's Primary VM identifier parameter tells NetBackup how
to identify virtual machines. For example, if the parameter is set to VM hostname,
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NetBackup identifies virtual machines by their host names. If they do not have a
host name, the policy cannot back them up.

The Primary VM identifier parameter has a direct effect on the query test results.
Note that for each virtual machine, the query test result is one of three possibilities:
INCLUDED, EXCLUDED, or FAILED.

If NetBackup cannot identify a virtual machine according to the Primary VM
identifier parameter, one of two test results can occur:

m If the virtual machine is filtered out by the query rules, it is listed as
EXCLUDED.

m If the virtual machine is not filtered out by the query rules, it is listed as
FAILED.

The following table gives the test query results from example combinations
of the Primary VM identifier parameter and a query rule.

Table 6-18 Effect of Primary VM identifier parameter and query rules on test
query results

Primary VM
identifier setting on
VMware policy tab

Query rule in Query Test query result
Builder

VM hostname

VMHostName Contains "VM" | INCLUDED: Any virtual machines with a host name that
contains "VM". Since the Primary VM identifier parameter
tells NetBackup to select the virtual machine by host name,
it can back up the virtual machines.

EXCLUDED: All other virtual machines.

VM hostname

Displayname Contains "VM" | INCLUDED: Any virtual machines that have a host name and
that have a display name that contains "VM".

EXCLUDED: Any virtual machines that have a host name,
but that do not have a display name containing "VM".

FAILED: Any virtual machines that do not have a host name.
Since the Primary VM identifier parameter is set to VM
hostname, NetBackup cannot select the virtual machine for
backup.

VM hostname

Displayname Contains "VM" | INCLUDED: Any virtual machines that have a host name and

AND VMHostName IsSet that have a display name that contains "VM".

EXCLUDED: All other virtual machines. The IsSet rule means
that if a virtual machine does not have a host name, it is
excluded.
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Table 6-18 Effect of Primary VM identifier parameter and query rules on test
query results (continued)

Primary VM
identifier setting on
VMware policy tab

Query rule in Query
Builder

Test query result

VM hostname Displayname Contains "VM" | INCLUDED:
AND VMHostName IsSet m Any virtual machines that have a host name and that
OR Annotation Contains have a} display nar'ne tha.t contains "VM".
"test" m  Any virtual machines without a host name that have an
annotation that contains "test".
AND NOT VMHostName
EXCLUDED: All other virtual machines.
IsSet
VM display name Displayname Contains "VM" | INCLUDED: Any virtual machines with the display names
that contain "VM". Since the Primary VM identifier parameter
tells NetBackup to select the virtual machine by display name,
it can back up the virtual machines.
EXCLUDED: All other virtual machines.
VM display name VMHostName Contains "VM" | INCLUDED: Any virtual machines that have a display name

and that have a host name that contains "VM".

EXCLUDED: Any virtual machines that have a display name,
but that do not have a host name containing "VM".

FAILED: Any virtual machines that do not have a display
name. Since the Primary VM identifier parameter is set to
VM display name, NetBackup cannot select those virtual
machines for backup.

Effect of Primary VM identifier parameter on VM
Name column in Test query results

The policy's Primary VM identifier parameter affects the type of virtual machine
name that appears in the VM Name column of the Test Query screen, as follows:

m Ifavirtual machine is EXCLUDED or FAILED, it is listed according to its virtual
machine display name. The Primary VM identifier parameter does not matter.

m But if a virtual machine is listed as INCLUDED, note: The name that appears
under VM Name is the type of name that is specified on the Primary VM

identifier parameter.

For example: If the Primary VM identifier parameter is VM hostname, the
included virtual machine is listed according to its host name. Even if the query
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rule specified Display name (such as Displayname Equal "vml"), the virtual
machine appears on the Test Query screen by its host name.

See “Primary VM identifier options (VMware)” on page 53.
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Reduce the size of backups

This chapter includes the following topics:

m About reducing the size of VMware backups
m Block-level backup (BLIB): full vs incremental
m Deleting a vSphere Client snapshot

m Using VMware's Changed Block Tracking for full backups only

About reducing the size of VMware backups

NetBackup provides the following options for reducing the backup size for a
VMware virtual machine:
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Block level
incremental backup
(BLIB)

Exclusion of deleted
blocks.

BLIB reduces the size of backups (full and incremental) by tracking block-level changes.
Only the blocks that have changed since the last full or incremental are included in the
backup. For incremental backups, this option applies to cumulative and to differential
backups.

BLIB works with VMware’s Changed Block Tracking in vSphere to track block-level changes
in the virtual machine.

To enable BLIB, click Enable block-level incremental backup in the NetBackup policy
VMware tab. NetBackup uses BLIB for storage optimization when the backup runs.

Note: The first backup you run with BLIB must be a full backup.

See “Block-level backup (BLIB): full vs incremental” on page 110.
Note the following about block level incremental backups:

m Works only with ESX 4.0 or later virtual machines at version vimx-07 or later.
B Requires vStorage (cannot be used in VCB-based backups).

Note: If you have used the vSphere Client interface to manually create a snapshot of the
virtual machine and that snapshot is currently active, you may have to delete the snapshot.

See “Deleting a vSphere Client snapshot” on page 111.
See “Using VMware's Changed Block Tracking for full backups only” on page 112.

Reduces the size of virtual machine backups by excluding any deleted sectors in the file
system on the virtual machine.

To enable this option, click Exclude deleted blocks on the policy VMware tab.
Refer to Exclude deleted blocks in the following topic:

See “Optimizations options (VMware)” on page 52.

Block-level backup (BLIB): full vs incremental

When you use the Enable block-level incremental backup option in the policy,
NetBackup uses VMware's Changed Block Tracking feature to reduce the backup
size. Since this option works at the block level (not at the file level), it applies only
to backups of the entire virtual machine. It cannot be used when the policy backup
selections list specifies individual files.

This option reduces the size of full backups as well as the size of incremental
backups, as follows.
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Table 7-1 Block-level backup of the virtual machine: full vs incremental

schedule

Type of backup

Optimization that is used in backup

Backup of entire virtual machine,
with full schedule

Backs up only the blocks that have changed since the
.vmdk was created.

Backup of entire virtual machine,
with incremental schedule

Backs up only the blocks that have changed since the
last backup, as follows:

m For cumulative incrementals, BLIB backs up only
the blocks that changed since the last full backup.

m For differential incrementals, BLIB backs up only
the blocks that changed since the previous backup
of any kind.

Deleting a vSphere Client snapshot

To use BLIB with NetBackup for VMware, you must delete an existing vSphere
Client snapshot if both of the following are true:

m You used the vSphere Client interface to manually create a snapshot of the
virtual machine and that snapshot is currently active.

m A NetBackup policy with the Enable block-level incremental backup feature
had never been used to back up the virtual machine before you started the

vSphere Client snapshot.

In this case, NetBackup cannot enable BLIB for the virtual machine. You must
delete the vSphere Client snapshot. Then, when the NetBackup policy runs, BLIB

is enabled.

More information is available on NetBackup block-level backups:

To delete a vSphere Client snapshot

1 Inthe vSphere Client interface, right-click on the virtual machine and select
Snapshot > Snapshot Manager.

Select the snapshot and click Delete.

To back up the virtual machine with BLIB, you can now run a NetBackup
policy that uses Enable block-level incremental backup.

NetBackup backups from this policy continue to use storage optimization,
even if you manually create a snapshot of the virtual machine using vSphere

Client.
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Using VMware's Changed Block Tracking for full
backups only

The Enable block-level incremental backup option (BLIB) in the NetBackup
VMware policy applies to full backups and incremental backups. BLIB skips blocks
on the virtual disk that are unmodified since the last backup. If you want to skip
unmodified blocks during full backups but not incrementals, do not configure the
policy for BLIB. Instead, enable changed block tracking by means of the vSphere
Client interface.

To enable changed block tracking for full backups only (vSphere Client interface)
1 Inthe vSphere Client interface, power off the virtual machine.
2 Select the virtual machine, then click Edit settings.

3 Obtain the hard drive controller and disk numbers (SCSI and IDE) for each
virtual drive on the virtual machine.

To find the controller number and disk numbers, do the following:

m Click the Hardware tab.

m Click on each hard disk. Its controller number and disk number (SCSI or
IDE) appear under Virtual Device Node, in the form scst (x.x) or
IDE (X.X). Make a note of each.

4  Click the Options tab. Under Advanced, General, click Configuration

Parameters.
@ zavm - w2k8 - ¥irtual Machine Properties W=l

Hardware ~Options |Resources I Wirbual Machine Yersion: 7
Settings | Summary | r—Settings
General Options zaravmz - weka I™ Disable acceleration
wApp Options Disabled .
Wiware Taals Syskem Defaul 7" Enable logging
Power Management Standby
Advanced —Debuaging and Statistic:

General Normal | & I

CPUID Mask, Expose Mx flagta ... (MR (OB

MemaryCPU Hotplug Disabled/Disabled " Record Debugging Information

Baat Options Delay 0 ms " Record|Statistics

Paravirtualization Disabled

Fibre Channel MPTY Mone € Record Statistics and Debugaing Infarmation

CPUJMMU Yirtualization Autoratic

Swapfile Lacation Use default settings i Configuration Parameters

Click the Configuration Parameters button to edit the
advanced configuration settings,
Configuration Parameters. ..

5 On the Configuration Parameters screen, click Add Row.
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Enter ctkEnabled in the Name column and enter true for the Value.
For each virtual drive on the virtual machine, enter a Name in the form:
scsiX:X.ctkEnabled

or

ideX:X.ctkEnabled

where x: x represents the controller number and disk number of each disk as
found on the Hardware tab.

For example: scsi0:0.ctkEnabled for the first diskand scsi0:1.ctkEnabled
for the second disk. (The numbers for your disks may be different.)

Enter true for the Value of each disk entry.
Click OK.
Power on the virtual machine.

Now you can use vSphere Client to take a snapshot of the virtual machine.
NetBackup can apply vStorage optimization (changed block tracking) to future
backups of the virtual machine.
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Back up virtual machines

This chapter includes the following topics:

m Backing up virtual machines

m Using the Activity Monitor to monitor virtual machine backups
m Viewing NetBackup activity in vSphere Client

m Using OpsCenter to report on virtual machine backups

Backing up virtual machines

Virtual machine backups initiate from a NetBackup policy. You can start the
backup manually from a policy, or have it run automatically according to a schedule
that is defined in the policy.

To create the policy, you can use the Policies utility in the NetBackup
Administration Console, or the Policy Configuration Wizard .

See “Configuring a VMware policy from the Policies utility” on page 48.
See “Configuring a VMware policy from the Policy Wizard ” on page 47.

For further information on policies and backup schedules, see the "Creating backup
policies" chapter of the NetBackup Administrator's Guide, Volume I.
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To back up a virtual machine manually from an existing policy

1 Click on Policies in the NetBackup Administration Console, select the policy,
and click Actions > Manual Backup.

7|:] Policies - ped - NetBackup Administration Console
File Edit ‘iew | Actions Help

TERr=a b
|8 = é@gowtoNewPoﬂty.”
ped e, Activate sed: 3 Policies

»

lalvy B2 B w58

5 ped (Master Sery 4@ Deactivate Jame [ pat... [ Type
= g Activity Manil W;ncrypttest - MS-windows-NT
=3} NetBackup M £ T —— :Fbtest - FlashBackup-Windows
+-E) Reports [fgy" Host Properties best --
-, Policies
[#- (=] Storage
g Catalog
E ﬂ Host Properties
=B Media and Device Management
23] Device Monitor
- R Media
F. g Devices
#-§2 Credentials
] @ Wault Management
) --.’g_j Access Management

FlashBackup-Win

The Manual Backup dialog appears.

Manual Backup E |

Start backup of policy: trio

Schedules: Clienks:
: =
Differential-Inc riowmz

ricwrnd

ricvrd

Select a schedule and one or more clients ko start the backup.,

To stark a backup for all clients, press O without selecting any clients.

(a4 I Cancel Help
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Select the type of schedule for the backup.

Select the clients (virtual machines) to back up.

If the policy was configured for automatic selection of virtual machines, the
Clients pane shows the VMware backup host rather than the virtual machines.

Click OK to start the backup.

To see the job progress, click Activity Monitor in the NetBackup
Administration Console.

It may take a few moments for the job to appear in the Activity Monitor. Do
not start another backup if a job does not immediately appear. If the job does
not show up after a few moments, close and restart the NetBackup
Administration Console.

Note that your VMware backup request launches more than one job. The first
job automatically creates and deletes snapshots. This job has a dash (-) in the
Schedule column. The second job backs up the virtual machine files from the
snapshot.

Using the Activity Monitor to monitor virtual machine

backups

You can use the NetBackup Activity Monitor to keep track of the VMware virtual
machines that a policy backs up.

To monitor the virtual machines that a policy backs up

1
2

Click Activity Monitor in the left pane of the Administration Console.

Note each job as it appears by row.

If the policy selects virtual machines automatically (based on a query), the
backup consists of three generations of jobs:

The first job is the discovery of the virtual machines.

The discovery job starts one or more child jobs to take a snapshot of each
virtual machine.

Each snapshot job starts a child job to back up each virtual machine.
So the job flow is as follows:

discovery job --> snapshot job --> backup job
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3 Totrace the discovery job to the virtual machine backup jobs, note the Job
ID and the Parent Job ID columns.

lue: 109 Jobs (3 Queued 9 Active O Wating for Retry 0 Suspended 0 Incomplete 97 Dane)

JobID [ Parent Job 1D [ Type [ons... (5] status [ Pl [ Schedue [ clent
¥ 115 108 Backup Done 0 tacco incr BMarc...
¥ 114 107 Backup Done 0 tacco incr BMacc. ..
¥ 112 103 Backup Done 0 tacco incr BMacc...
.4 111 105 Backup Done 0 tacco incr BMacc...
b4 110 102 Backup Done 0 tacco incr BMacc...
¥ 109 104 Backup Done 0 tacco iner BMace...
¥ 108 101 Backup Done: 0 tacca - BMact...
b4 107 101 Backup Done 0 tacco B BMacc...
b 4 106 101 Backup Done 0 tacco - BMact...
* 105 101 Backup Done 0 tacco - BMacc...
¥ 104 101 Backup Done 0 tacco - BMacc...
b4 103 101 Backup Done 0 tacco - BMacc...
* 102 101 Backup Done 0 tacco - BMacc...
¥ 101 101 Backup Done 0 tacco B Juebeck.

In this sample screen, job 113 is a virtual machine backup (grandchild). (Note
that each virtual machine backup job includes the name of its schedule in the
Schedule column.) Its parent job was 106, the snapshot job. Job 101 (the
discovery job) was the parent of 106.

In this example, any job with a parent ID of 101 is a snapshot job for 101. Jobs
109 through 115 are the virtual machine backups that originated from 101.

4  Right-click on the job row and click Details.

On the Job Details screen, click the Detailed Status tab for more information
on the job.

5 If the Job ID or the Parent Job ID column is not displayed in the Activity
Monitor, display them as follows:

m Right click anywhere in the column header row and click Columns >
Layout.

m Click the row for the heading that you want to display (such as Job ID).

m Use the following icons at the top of the screen to show the heading:

= Sets the State to Show.

14—+l

= + — Moves the row up or down in the list (farther to the left or
=T|i=+ right in the Activity Monitor).

m Click OK. The Job ID and Parent Job ID columns should now be visible in
the Activity Monitor.
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Viewing NetBackup activity in vSphere Client

NetBackup can record backup activity for virtual machines in VMware vCenter.
You can view the events in vSphere Client at the level of any parent object (such
as folder, datacenter, cluster, or host). You can also view the events for the entire
virtual machine.

Make sure that the policy's Post events to vCenter option is enabled:
See “VMware - Advanced Attributes dialog” on page 57.

To view backup events and the last backup time in vSphere Client

1 Open vSphere Client and connect to the VMware server.

2 Go to Home > Inventory > Hosts and Clusters.

3 Select the object (such as datacenter, host, or virtual machine) and click the
Tasks & Events tab.

4  Click the Events view.
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5 Inthe Description, Type or Target contains field, enter NetBackup.

If some NetBackup events do not appear, the events display limit may have
been reached in vSphere Client. The maximum number of events that vSphere
Client can display is 1000 (the default is 100).

See “To change the events display limit in vSphere Client” on page 121.

Wiew:  Tasks| [Events scheduled Tasks

Show all entries = Description, Type or Target contains: « [netback Clear
Description | Type | Date Time < | Task | Target | User |
@ MetBackup: Snapshat create Failed For & eror 10/5/2011 &:01:11 AM kirka... Administrator

kirkorcl _template, {Client
s&.com; Master se,com;
Palicy tman; Schedule f; —
Type FULL)
MetBackup: Backup successful For kir ko kiny @ info 10512011 6:52:39 AM 41 k.. Administrator
{Job 66; Client se.cam; Master se.com
Palicy tman; Schedule f;
Type FULL; Duration O brs O min 50 sec)
@ MetBackup: Backup successful For kird_clone, @ info 10/5/2011 £:49:19 AM G k.. Administrator
| {Job 45; Client se.cam; Master se.com; | i
4 »

Event Details

=

Type: info User: Administrator Time: 10/5/2011 6:52:39 AM Target: kir ko tiny
Drescription:

@ 10/5/2011 6:52:39 AM, MNetBackup: Backup successful For kir to tiny, {Job 66; Client se.com;
Master se.com; Palicy tman; Schedule F; Type FULL; Duration O brs O min S0 sec)

Felated Events:  Show

Each NetBackup event includes the following details:

Description Shows the NetBackup operation that succeeded or failed, and
includes policy details and duration. When you click on the
row of the event, the Event Details pane shows the same
information.

Type The types are info for a successful operation, and error for a
failed operation.

Date Time The date and time of the event.
Task Not used.
Target The virtual machine that was backed up.

User The user that ran the backup.
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Viewing NetBackup activity in vSphere Client

To see the date and time of the last backup for a particular virtual machine,
select the virtual machine and click the Summary tab.

The timestamp of the last backup is listed for the NB_LAST BACKUP attribute,
under Annotations:

SUmMmary

General Resources
Guest 05 Microsoft Windows Server 2008 (32-bit) Consurned Host CPU: 63 MHz
VI Version: 7 Consumed Host Memary: 1055.00 MB
P 2Pl Active Guest Memary: 81.00 MB
MEmary: 1024 ME Refresh Storage Usage
Memary Overhead: 76.75 MB Provisioned Storage: 13.30 TB
Y¥Mware Tools: /. Running (Out-of-date) hot-shared Storage: 7.34TB
IP Addresses: Used Storage: 7.347TB

Storage < | status Drive Type |

DS Mame; EMal @ ams2500_th & Alert Mon-530
EWC Mode: Mf&

e I . | »
State: Powered On T = =
Host: al.carn erwor | ales | =
Active Tasks: Remove snapshot 8 vitualtachine G5... Standard port Group
wSphere HA Protection: (3 Mfa &2 1| | _Pl

Commands ¥™ Storage Profiles
[ open Console Refresh

M Shorage Profiles:
Prafiles Compliance:

Annotations
& Edit
I ME LAST BACK.., "Sat Ock 29 22:23:07 2011 I
testpreview:
Motes: ;I

Virtual Machines tab.

7 To see the date and time of the last backup for all virtual machines, click the

To change the events display limit in vSphere Client

In vSphere Client, click the Edit > Client Settings > Lists tab.

Use the Page size field to change the size.
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Using OpsCenter to report on virtual machine backups

To use OpsCenter to obtain a backup report on VMware virtual machines

1

Start the OpsCenter console in a Web browser.

On a system that has a network connection to the OpsCenter server, enter
the following in a browser:

http://host.domain/opscenter

where host.domain is the fully qualified domain name or IP address of the
OpsCenter server.

Click the Reports tab.

Click Client Reports > Virtual Client Summary.

The Virtual Client Summary report is described in the Symantec OpsCenter
Administrator's Guide.



Restore virtual machines

This chapter includes the following topics:

Restore notes and restrictions

Restore notes and restrictions on Linux

Restoring the full VMware virtual machine

About restore of individual files

Restoring individual files

About the NetBackup.lost+found directory on Linux

If the recovery host is not at the same NetBackup release level as the backup
host

Restore notes and restrictions

Before you begin the restore, note the following:

Unless a NetBackup client is installed on the virtual machine, you must do the
restore from the NetBackup master server.

To restore files to the original virtual machine location, the destination must
be specified as the virtual machine's host name (not display name or UUID).

To restore directly to an ESX server, the name that is specified for the restore
must match the ESX server’s official host name. The name must be in the same
format in which it is registered in DNS and in the VMware server (whether
short or fully-qualified).

See “Adding NetBackup credentials for VMware” on page 40.

The restore fails if ESX servers are configured with short host names and the
backup and restore are done through a vCenter server.
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See “The restore fails if ESX servers use short host names and backups and
restores use a vCenter server” on page 166.

Cross-platform restore of individual files is not supported. You can restore
Windows files to Windows guest operating systems but not to Linux. You can
restore Linux files to supported Linux guest operating systems but not to
Windows.

If the virtual machine was backed up by its display name or UUID, and the
display name differs from the host name, note: You must specify the correct
destination client for the restore. Use the Specify NetBackup Machines and
Policy Type dialog in the NetBackup Backup, Archive, and Restore interface.
See “Invalid client error when you restore files using NetBackup BAR interface
installed on the virtual machine” on page 170.

Restore of individual files from a backup of the full virtual machine is not
supported if the virtual machine contains Storage Foundation Volume Manager
volumes.

To restore Windows NTFS-encrypted files individually, you must install a
NetBackup client on the virtual machine.

See “NetBackup for VMware best practices” on page 151.

For virtual machine restores, VMware supports the NBDSSL transport mode
only for vStorage backups of vSphere 4.1 and later environments. Backups of
the VMware systems that are earlier than vSphere 4.1 cannot be restored using
the NBDSSL transport mode.

If the attempt to restore a full virtual machine fails while using the SAN
transport type, try the NBD transport type instead.

VMware does not support the restore of virtual machines directly to an ESX
5.x server that vCenter manages. To restore the virtual machine, select the
vCenter server as the destination.

As an alternative, you can set up an independent ESX server to be used for
restores. You must add NetBackup restore credentials for that ESX server by
means of the VMware restore ESX server server type.

See “Adding NetBackup credentials for VMware” on page 40.

For the SAN transport mode, the job may be slow when you restore to a vCenter
Server. For greater speed, designate a VMware restore ESX server as the
destination for the restore.

See “Adding NetBackup credentials for VMware” on page 40.

A restore by means of the SAN transport mode may be slow in other
circumstances. The following VMware article provides details:
Best practices when using SAN transport for backup and restore


http://kb.vmware.com/selfservice/microsites/search.do?language=en_US&cmd=displayKC&externalId=1035096
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The APIs in VMware's Virtual Disk Development Kit (VDDK) contain the
following limitation: the maximum write speed during virtual machine restore
is roughly one third of the hardware's maximum speed. The following Symantec
tech note contains further information:

Two causes of slow NetBackup for VMware restore performance
http://www.symantec.com/docs/TECH169860

If the restore host is on Windows Server 2008 and you use the SAN transport
mode for the restore, the SAN luns must be online. Refer to the information
on status code 5 in the following section:

See “NetBackup status codes related to VMware” on page 162.

When restoring large files, make sure that no snapshots are active on the
destination virtual machine. Otherwise, the files are restored to the VMware
configuration datastore, which may be too small to contain the files you want
to restore. In that case, the restore fails.

The configuration datastore (sometimes called the vmx directory) contains
the configuration files that describe the virtual machine, such as * . vmx files.
Note that active snapshots of vindk files are also stored on the configuration
datastore.

If you cancel the virtual machine restore before it completes, the
not-fully-restored virtual machine remains at the target location. NetBackup
does not delete the incomplete virtual machine when the restore job is canceled.
You must manually remove the incomplete virtual machine.

If the virtual machine display name contains non-ASCII characters, the backup
may succeed but the restore fails. To restore the virtual machine, you must
change the display name to contain ASCII characters only and retry the restore.

To restore a virtual machine that was backed up with VCB, you must use the
VMware Converter and a staging host in the following case:

m The virtual machine was backed up through a vCenter 4.0 or later server,
and

m The folder structure on the vCenter server has changed since the time of
the backup.
Because of the changed folder structure on the vCenter server, the
automated restore procedure does not work. Restore the virtual machine
files to a staging computer and use the VMware Converter to manually
restore the files.

Note the following limitations regarding VCB and VMware Converter
Standalone:

m VMware Converter Standalone 4.0.1 is the last revision to support VCB.
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m For a virtual machine that was backed up with VCB, VMware Converter
Standalone cannot restore the VM to a vCenter server that contains vApps.
Touse Converter Standalone, you must restore the virtual machine directly
to an ESX or ESXi server. For more information, refer to the VMware
knowledge base:

VMware Knowledge Base (1034316)
NetBackup support for VCB will be discontinued in a future release.

m See “NetBackup for VMware: notes and restrictions” on page 32.

Restore notes and restrictions on Linux

Before you begin the restore, note the following:

m Cross-platform restore of individual files is not supported. You can restore

Linux files to supported Linux guest operating systems but not to Windows.

If the Linux file system was not quiesced before the snapshot, some files may
be inconsistent. Such files can be recovered from the NetBackup.lost+found
directory.

See “About the NetBackup.lost+found directory on Linux” on page 147.

See “About the SYMCquiesce utility” on page 179.

To migrate an ext2 or ext3 file system to ext4, note: Make sure to follow the
instructions under "Converting an ext3 filesystem to ext4" on the following
page of the Ext4 wiki:
https;//ext4.wikikernel.org/index php/Ext4 Howto#Converting an_ext3 filesystem to_ext4
If you do not follow these instructions, data in a newly created ext4 file is not
promptly flushed from memory to disk. As a result, NetBackup cannot back
up the data of recently created files in the ext4 file system. (The NetBackup
snapshot captures the file as zero length.)

As aworkaround for the file systems that were not correctly migrated, do one
of the following:

m Run the Linux sync command on the ext4 file system before starting each
backup.

m Install the NetBackup SYMCquiesce utility for VMware. This utility is
described in the "SYMCquiesce utility for Linux virtual machines" appendix.
The SYMCquiesce utility quiesces the Linux file system, to guarantee that
all data has been flushed from memory to disk.

For Linux virtual machines, NetBackup cannot restore individual files from
software RAID volumes. The files are restored when you restore the entire
virtual machine.


http://kb.vmware.com/selfservice/microsites/search.do?language=en_US&cmd=displayKC&externalId=1034316
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The Linux ext4 file system includes a persistent pre-allocation feature, to
guarantee disk space for files without padding the allocated space with zeros.
When NetBackup restores a pre-allocated file (to any supported ext file system),
the file loses its preallocation and is restored as a sparse file. The restored
sparse file is only as large as the last byte that was written to the original file.
Note also that subsequent writes to the sparse file may be non-contiguous.

NetBackup supports backup and restore of Linux LVM2 volumes, including
individual file restore from an LVM2 volume. Note however that NetBackup
does not support individual file restore from a snapshot that was created by
means of the snapshot feature in LVM2. If an LVM2 snapshot exists at the
time of the backup, the data in the snapshot is captured in the backup. The
data can be restored along with the rest of the virtual machine data when you
recover the entire virtual machine.

NetBackup supports backup of Linux FIFO files and socket files. NetBackup
does not support restoring FIFO files and socket files individually. FIFO files
and socket files can be restored along with the rest of the virtual machine data
when you recover the entire virtual machine.

For Linux virtual machines, the ext2, ext3, and ext4 file systems are supported
for individual file restore. If a partition uses some other file system, the backup
succeeds but files in that partition cannot be individually restored. To allow
NetBackup to present mount points for restore in the Backup, Archive, and
Restore interface, note: The "/" (root) partition must be formatted with ext2,
ext3, or ext4.

See “Mount points not available when restoring files from a Linux virtual
machine” on page 169.

When you restore Linux files individually to an NFS-shared device on a Linux
virtual machine, NetBackup can only restore the file data and attributes. The
extended attributes cannot be restored to NFS-shared devices.

For a virtual machine that is running a Linux guest operating system: When
you restore a virtual machine (to its original location or different location),
the ESX server assigns the virtual machine a new (virtual) MAC address. After
you restart the virtual machine, you may have to configure its MAC address.
For instance, the original MAC address of the virtual machine may be in a
configuration file that has to be updated.

Refer to your VMware documentation for more details.

For Linux, additional notes apply.
See “NetBackup for VMware: notes on Linux virtual machines” on page 34.
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Restoring the full VMware virtual machine

To restore the full virtual machine

1
2

Start the NetBackup Backup, Archive, and Restore interface (BAR).
Specify the source client and destination client and type of policy:

In the Java interface, on the Restore Files tab, click the restore icon (hand
symbol in the upper right).

In the Windows interface: Click Files > Specify NetBackup Machines and
Policy Type.

Specify the following:

Server to use for The NetBackup master server that directed the backup
backupandrestores

Source client for The VMware virtual machine that was backed up.

restores Enter the type of name that was selected for the Primary VM

identifier option on the policy VMware tab. For example, if
the Primary VM identifier option is set to VM host name, enter
the virtual machine's host name.

Destination client  This field is ignored. The destination for the restore is specified

for restores in a different screen as explained in a later procedure.
Policy type for The type of policy that made the backup.
restores

Select the type of restore:

In the Java interface, on the Restore Files tab, select Restore type > Virtual
Machine Backups.

In the Windows interface, click the down arrow on the Select for Restore
option. Select Restore from Virtual Machine Backup. A restore window
displays the backups available for restore.

Select the virtual machine backup to restore.
In the Java interface, do the following:

m Onthe RestoreFiles tab, specify the Start date and End date within which
to search for the backup. Click either of the calendar options.

m Specify root (/) in the Browse directory field and press Enter.

m Click on the root directory that is displayed under Directory Structure.
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NetBackup server Source client Destination client Policy type:
Master Server vimd.com vm4.com VMware

Backup Files [ Restore Files | Task Progress

Restore type:
|Vir[ual Machine Backups |v‘

Keyword phrase: Start date: End date:
<none: 07/30/2011 17:29:54 12/30/2011 23:59:59
Browse directory: 1
Directory Structure :i Contents of selected directory
== 4 Name | Backup Date | size(Bytesy |  Modified  [Schedule T..|  Polic
vm4. vmdk 08/31/2011 17:29:54 35651584KE  08/31/2011 ... Full Backup dd
1 1 I IC
| & Preview | | Restore... |

In the Windows interface, in the NetBackup History pane, click on the
VMware backup. Then click on the item that is displayed under All Folders.
You cannot select individual files. You must select the entire virtual machine.
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MetBackup History

% 2011

aug

— 16

i [l

é All Folders Contents of “wme'

’R':ﬂ ----- v Mame | Time Backed Up | Attributes | Size: I Time Modified |
,@ L v vk, 8/16/2011 4:40:40PM  -shr 35651554KE  §/16/2011 4:141:15 PM

6  Select restore options.
In the Java interface, click Restore.
In the Windows interface, click Actions > Restore.

The type of dialog that appears next depends on how NetBackup performed
the backup (by means of vStorage or VCB).

See “Virtual Machine Recovery dialog boxes (restore to original location)”
on page 130.

See “Virtual Machine Recovery dialogs boxes (restore to alternate location)”
on page 134.

See “Restore Marked Files dialog box (VMware with VCB)” on page 141.

See “About restore of the virtual machine from a VCB backup” on page 140.

Virtual Machine Recovery dialog boxes (restore to original location)

If NetBackup used VMware vStorage to back up the virtual machine, the Virtual
Machine Recovery dialog boxes appear when you start the restore.

Recovery Destination dialog box

You can select the type of destination for the virtual machine recovery: the original
location or alternate location.

This dialog includes the following:

m Original settings of the virtual machine when it was backed up
Shows the configuration of the virtual machine at the time of the backup.
When you restore the virtual machine to its original location, these
configuration settings are used and cannot be changed.
When you restore to an alternate location (not to the original location), you
can change these settings after you click Next.

m Recover virtual machine to
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Select Original location or Alternate location.

Recovery Options dialog box
Select the recovery host and transport mode, as follows:

m Destination setting
Shows the configuration of the virtual machine at the time of backup. These
settings are applied to the virtual machine when it is restored.

m NetBackup Recovery Host
The host that performs the recovery. The default is the host that performed
the backup (the backup host).
In most cases, you can use the host that performed the backup. Selecting a
different host as the recovery host can result in a slow restore or a failed
restore, depending on the transport mode. For example, if the host that
performed the backup used a SAN connection to access the datastore, but the
host you select as recovery host does not have SAN access to the datastore,
the restore fails if you select the SAN transport mode.

m Transport Modes
Determines how the restore data is sent from the recovery host to the VMware
datastore. The appropriate option depends in part on the type of network that
connects the VMware datastore to the recovery host.
The default is the type that the backup used.

san For unencrypted transfer over Fibre Channel (SAN) or iSCSI.

nbd For unencrypted transfer over a local network that uses the Network
Block Device (NBD) driver protocol. This mode of transfer is usually
slower than Fibre Channel.

nbdssl For encrypted transfer (SSL) over a local network that uses the Network
Block Device (NBD) driver protocol. This mode of transfer is usually
slower than Fibre Channel.

hotadd Requires that the recovery host is in a virtual machine. This feature
requires ESX 3.5 Update2 or later.

For instructions on this transport mode and on installing the recovery
host in a VMware virtual machine, refer to your VMware
documentation.



132

Restore virtual machines

Restoring the full VMware virtual machine

Move Up, Use these buttons to change the order in which NetBackup tries each
Move Down  selected mode. Highlight a mode and click Move Up or Move Down.

For example: Assume that all four transport modes are selected, and
the order is san, hotadd, nbd, and nbdssl. If one of the virtual disks
cannot be accessed using san, the san transport mode is not used for
any of the virtual machine’s disks. NetBackup then tries to use the
hotadd mode for all the disks. NetBackup continues to try each mode
until it finds one that succeeds for all the disks.

Virtual Machine Options dialog box
Virtual Machine Options:

m Restore UUID xxx instead of creating a new UUID

Retains the UUID of the original virtual machine (note that the UUID is a
globally unique identifier). The virtual machine is restored with the same UUID
that it had before the restore.

Note the following:

m If a virtual machine with the same display name but with a different UUID
exists at the target restore location, the restore fails. You must either delete
the existing virtual machine and run the restore, or keep the existing virtual
machine and abandon the attempt to restore.

m If you do not want to keep the existing virtual machine, you can do one of
the following: Remove the existing virtual machine, or log into the ESX
server and remove the directory where the virtual machine resides.

Overwrite the existing virtual machine

If a virtual machine with the same display name exists at the destination, that
virtual machine must be deleted before the restore begins. Otherwise, the
restore fails. Select this option to have the virtual machine deleted.

Remove backing information for devices like DVD/CD-ROM drives, serial
or parallel ports

If a virtual machine had an iso file that was mounted on a CD when the virtual
machine was backed up, note: the iso file must be available on the target ESX
server when you restore the virtual machine. If the iso file is not available on
the ESX server, the restore fails.

This option restores the virtual machine without restoring an iso file that was
mounted when the virtual machine was backed up.

m Remove network interfaces
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Removes any network interfaces from the restored virtual machine. Select
this option if the network connections on the destination virtual machine have
changed since the backup was made.

m Power on virtual machine after recovery
Select this option to have the recovered virtual machine automatically powered
on when the recovery is complete.

m Override default job priority
Place a check mark in this box to override the default priority.

m Job Priority
Use this field to set a higher priority.

m Restore storage DRS configuration
If the virtual machine resided in a datastore cluster and was configured with
VMware DRS, this option restores the DRS configuration. If this option is not
selected, the DRS configuration is not restored. (Examples of DRS configuration
are vindk affinity rules and anti-affinity rules.)
If the virtual machine was not in a datastore cluster and was not configured
with VMware DRS, this option is grayed out.

m Allow partial configuration update
Allows some of the DRS configuration to be restored even if other portions of
that configuration cannot be restored.
If problems exist with portions of the DRS configuration and this option is not
enabled, NetBackup does not restore any of the DRS configuration.

m Retain original hardware version
This option restores the virtual machine with its original hardware version
(such as 4). It retains the original version even if the target ESX server by
default uses a later hardware version (such as 7 or 8).
If this option is disabled, the restored virtual machine is converted to the
default hardware version that the ESX server uses.
If the virtual machine is hardware version 7 or 8 and you restore to a vSphere
pre-4.0 server, note: The restore fails if you enable this option. If you disable
this option, the restore succeeds if VMware Tools is able to convert the virtual
machine's hardware version to an earlier version.

Format of restored virtual disks:

m Original provisioning
Restores the virtual machine's virtual disks with their original provisioning.

m Thick Provision Lazy Zeroed
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Configures the restored virtual disks in the thick format. The virtual disk space
is allocated when the disk is created. This option restores the populated blocks,
but initializes vacant blocks with zeros later, on demand.

m Thick Provision Eager Zeroed
Configures the restored virtual disks in the thick format. Restores the populated
blocks and immediately initializes vacant blocks with zeros (eager zeroed).
Creation of the virtual disks may take more time with this option. However, if
the restore occurs over a SAN, the eager zeroed feature may speed up the
restore by reducing network communication with the vCenter server.

m Thin Provisioning
Configures the restored virtual disks in the thin format. Restores the populated
blocks but does not initialize vacant blocks or commit them.
Thin provisioning saves disk space through dynamic growth of the vmdk file.
The vindk files are no larger than the space that the data on the virtual machine
requires. The virtual disks automatically increase in size as needed.
Refer to the following Symantec document for more support details on thin
provisioned disks:
Support for NetBackup 7.x in virtual environments
For more information on virtual disk provisioning, refer to VMware's
documentation.

Perform Recovery dialog box
Review the settings that are to be applied to the restored virtual machine.

m Recovery settings
Lists several settings that are used for the recovery.

m Run Pre-Recovery Check
Click this option to verify credentials, available space on the datastore, and
other important requirements.

m Start Recovery
Starts the recovery of the virtual machine.

Virtual Machine Recovery dialogs boxes (restore to alternate location)

If NetBackup used vStorage to back up the virtual machine, the Virtual Machine
Recovery dialog boxes appear when you start the restore.

Recovery Destination dialog box (restore to alternate location)

m Original settings of the virtual machine when it was backed up
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Shows the configuration of the virtual machine at the time of the backup.
When restoring to an alternate location (not to the original location), you can
change these settings after you click Next.

m Recover virtual machine to
Select Alternate location.

Recovery Options dialog box (restore to alternate location)

The Recovery Options dialog initially displays the original virtual machine settings
that were recorded in the NetBackup catalog when the virtual machine was backed
up. Before accepting any default values, you may have to verify that the original
hosts or servers are still available.

The dialog contains the following fields:

m NetBackup Recovery Host
The recovery host transfers the virtual machine files to the VMware destination
that is specified in other fields on this dialog. The default for the recovery host
is the backup host that backed up the virtual machine.

Consider the following when selecting a recovery host:

m To use the original VMware backup host for the recovery, verify that the
backup host still exists. The original backup host may have been removed
or reconfigured after the backup occurred.

m The current processing load on the host that you want to use may be a
factor. The recovery host undergoes significant I/O activity when it restores
a virtual machine.

m The network connection between the recovery host and the destination
datastore may limit the type and speed of data transmission. For example,
to use the SAN transport mode, the recovery host must have access to the
appropriate luns in the datastore.

m Transport Modes
Determines how the data is sent from the recovery host to the VMware
datastore. The appropriate mode depends on the type of connection between
the NetBackup recovery host and the VMware datastore.
More information is available about these options.
See “Recovery Options dialog box” on page 131.

m vCenter Server
Specifies the vCenter server for the restored virtual machine. To use the
original vCenter Server (the default), verify that the original vCenter server
still exists.

135



136

Restore virtual machines

Restoring the full VMware virtual machine

To use a different vCenter Server, consider whether it is compatible with the
virtual machine you want to restore. For example: If you attempt to restore a
vmx-07 virtual machine to a vSphere server that is earlier than 4.0, note:
VMware Tools converts the virtual machine to an earlier hardware version.
In other cases, you can use the Retain original hardware version option on
the Virtual Machine Options dialog.

The restore may finish faster if you use the SAN transport mode with a restore
ESX server (bypassing any vCenter servers).

When choosing a target host for the restore, note the following:

m If NetBackup has credentials to access a vCenter server (but does not have
credentials to access a VMware restore ESX server), note: You can restore
the virtual machine through the vCenter server. In this case, the data
movement for the restore passes through the vCenter server. Passing the
virtual machine data through the vCenter server may increase the amount
of time that is needed to complete the restore.

The credentials must give NetBackup full access privileges to the vCenter
server.
See “Adding NetBackup credentials for VMware” on page 40.

m If NetBackup has credentials to access a vCenter server as well as a VMware
restore ESX server, the restore may complete faster. In this case, by default
NetBackup passes the virtual machine data directly to the restore ESX
server, bypassing the vCenter server. You can select a vCenter folder in
which to place the restored virtual machine.

The credentials must give NetBackup full access privileges to the restore
ESX server.

m If NetBackup has credentials to access an ESX server, you can designate
that server as the target for the restore. The credentials must give
NetBackup full access privileges to the ESX server.

Select None for the vCenter Server, and click Search to select the ESX
server.

Note: Due to VMware limitations, NetBackup cannot restore a vStorage virtual
machine backup directly to an ESX server that is earlier than version 3.5.

ESX Server

Specifies the ESX server on which the restored virtual machine is to reside.
To use the original ESX server (the default), verify that the original ESX server
still exists.

Click the Search option to browse for a different ESX server.
See “Select ESX server dialog box (restore to alternate location)” on page 138.
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Datacenter
Shows the VMware datacenter containing the selected ESX server.

Folder

A folder is a logical entity within the vCenter that contains VMware objects,
such as datastores, networks, and virtual machines.

By default, this field shows the VMware folder that contained the virtual
machine when the virtual machine was backed up. If you select a different ESX
server to which to restore the virtual machine, this field changes to None. You
must then click Browse to select a folder within the datacenter for the restored
virtual machine.

See “Select Folder dialog box (restore to alternate location)” on page 138.

Display Name

Specifies the VMware display name for the restored virtual machine. The
default is the display name that the virtual machine had when it was backed
up.

The display name must be unique for the vCenter Server where the virtual
machine is restored.

Note: If a virtual machine with this display name already exists at this location
(or at the original location), you are prompted to click Overwrite the existing
virtual machine. You cannot restore the virtual machine if the result is two
virtual machines with the same display name on the same vCenter server.

Resource Pool/vApp

Use this option to have the restored virtual machine assigned to either a
VMware resource pool or to a vApp. Resource pools manage the host's CPU
and memory. vApps are logical containers for virtual machines, and also share
some functionality with virtual machines.

Datastore/Datastore Cluster

Specifies the VMware datastore or datastore cluster that contains the virtual
machine configuration files. Click Change to make a selection.

This datastore (sometimes called the vimx directory) contains the configuration
files that describe the virtual machine, such as *.vmx files. Active snapshots
of vindk files are also stored on this datastore.
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Note: The Datastore field shows the name of the datastore that contained the
virtual machine data when the virtual machine was backed up. Even if the
datastore was in a datastore cluster, the field shows the name of the datastore,
not the datastore cluster. When the virtual machine is restored, NetBackup
determines how the datastore is currently configured (in a cluster or not) and
configures the virtual machine accordingly.

m Use the same datastore/datastore cluster for all VMDKs
This option assigns all restored virtual machines to the datastore or datastore
cluster that is selected in the Datastore/Datastore Cluster field.
If this option is not selected, you assign the VMDKs to specific datastores or
datastore clusters in a later dialog (the Storage Destination dialog).

Select ESX server dialog box (restore to alternate location)

On the Select ESX server dialog, you can enter the name of the ESX server or drill
down in the list to select a server.

m Specify ESX server
Enter the name of the ESX server in this field. As you type a name, the list of
available servers automatically expands and the nearest match is highlighted.

m Search
If necessary, click Search to locate the server name that you typed.

Note: Some older ESX servers may not support the version of the virtual
machine that you want to restore. Verify that the ESX server is compatible
with the virtual machine.

Select Folder dialog box (restore to alternate location)

The Select Folder dialog shows the vCenter folders that exist on the datacenter
that is shown in the Datacenter field.

Pick a folder from the list of available folders. The restored virtual machine is
placed in this folder.

If two datacenters of the same name exist in the vCenter server, all folders for the
identically named datacenters are displayed. After you select a folder and click
OK, verify that the folder on the Recovery Options dialog contains the destination
ESX server. If the selected folder is on the wrong datacenter, the restore fails.
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Select Datastore or Datastore Cluster dialog box (restore to
alternate location)

Use this screen to select a datastore or datastore cluster for the restored virtual
machine. You can use the search field, or drill down manually into the list.

Note: Only datastores and clusters visible to the ESX server are displayed.

Search

As you type a name, the list of available datastores and datastore clusters
automatically expands and the nearest match is highlighted.

Virtual Machine Options dialog box (restore to alternate
location)

This dialog is described in a previous topic:

See “Virtual Machine Options dialog box” on page 132.

Storage Destination dialog box (restore to alternate location)
Select the datastores where the .vindk files are to be restored.

m Source VMDK File Name
Shows the names of the virtual machine .vindk files that were backed up.

m Datastore/Datastore Cluster
Shows the VMware datastore or datastore cluster where the .vmdk files are to
be restored. Click in this field to select another datastore.
See “Select Datastore or Datastore Cluster dialog box (restore to alternate
location)” on page 139.
If the datastore is in a datastore cluster, NetBackup displays the name of the
datastore (not the name of the cluster).

m Datastore/Datastore Cluster Status
Indicates whether the datastore or datastore cluster has enough space to
contain the selected .vimdk file.

OK The datastore or datastore cluster has enough space to
contain the selected .vmdk file.

Insufficient space The datastore or datastore cluster does not have enough
space to contain the selected .vimdk file.
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Network Connections and other options dialog box (restore to
alternate location)

m Select all network names
This box selects or unselects all the networks that are listed under Network
Names. If a network is selected, the restored virtual machine is automatically
connected to that network.
Place a check mark in this box if you want to select all network connections
for the restored virtual machine.

m Network Names
Select the networks that you want the restored virtual machine to be connected
to. Note that virtual networks are displayed in addition to physical networks.
When the virtual machine is backed up, its network connections (physical or
virtual) are recorded in the NetBackup catalog.

For the restore, NetBackup determines what networks currently exist, and
lists the network names as follows:

m Ifanetwork that was recorded in the backup catalog for the virtual machine
still exists, it is listed on this screen and automatically selected.

m If a network is available that was not listed in the NetBackup catalog, it is
listed on this screen but not selected.

m If a network was recorded in the backup catalog but is not currently
available, it is not listed.

Perform Recovery dialog box (restore to alternate location)

m Recovery settings
Lists the settings that are used for the recovery.

m Run Pre-Recovery Check
Verifies the credentials and appropriate paths and connectivity, determines
whether the datastore or datastore cluster has available space, and reviews
other important requirements. You must run this check at least once. You can
proceed with the restore even if the check fails.

m Start Recovery
Starts the recovery of the virtual machine.

About restore of the virtual machine from a VCB backup

To restore a virtual machine from a NetBackup backup that was made with VCB,
restore all virtual machine files to the VMware recovery host. The recovery host
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is used as a staging host. You must use this approach if NetBackup 6.5.x made the
backup.

After you restore the virtual machine files to the VMware recovery host, do one
of the following:

m Use VMware automated restore
NetBackup integrates with VMware vCenter Converter to restore the virtual
machine to a designated ESX server. The virtual machine files are then removed
from the staging host.
See “Restore Marked Files dialog box (VMware with VCB)” on page 141.
Certain compatibility issues exist between newer and older versions of VMware
ESX server and VMware Converter. Refer to the Support for NetBackup 7.x in
virtual environments tech note for more information:
http://www.symantec.com/docs/TECH127089
See “Restore notes and restrictions” on page 123.

m Use the VMware Converter application to restore the virtual machine from
the staging host to the virtual machine server.

Restore Marked Files dialog box (VMware with VCB)

If the backup was made with VCB, the Restore Marked Files dialog appears when
you click Restore in the Backup, Archive, and Restore interface.
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Restore Marked Files [ x|
General I

Restore Dptions
o Bestore all vitual machine fles to a vitual machine seiver automatically using
Viware Converter

Restores all vitual machine files to the staging machine that vou have specified
below. NetBackup uses the YMware Conwerter and restores all files automatically from the
staging machine to the virtual machine server that you have specified.

[~ Petform identity restore to restore IUID (Universal Unique Identifier)

I Stip netwaork information from the vitual machine that has been restored

Remave backing infarmation for devices ke DVD/CD-ROM drives, senial or
paralle! ports

" Restore all vitual machine fles to the staging machine

Restores all vitual machine files to the staging machine that you have specified
below.Use a conversion solution to restore files from the staging maching to the virtual
maching server.

‘Waning Restore wil fail i the vitual machine already exsts |

~Restore Destination Choices

Wirtual machine server.

[ =]
Staging machine for restoration:

Restore staging location:

|h:\mnt

[~ Override default priodty

Job pioity b &

[higher number is greater prority)

| Stait Restore I Cancel | Help

The Restore Options are as follows:

m Restore all virtual machine files to a virtual machine server automatically
using VMware Converter
Restores all virtual machine files to the staging area that you specify on this
dialog box. NetBackup then issues a VMware-provided script to restore the
virtual machine to the virtual machine server you specify. After the restore is
complete, the restored virtual machine is powered off. The virtual machine
files are then removed from the staging machine.
If the virtual machine display name already exists on the Virtual machine
server, the restore fails.
Note the following options:
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Perform identity Retains the UUID of the original virtual machine (note that the

restoretorestore  UUID is a globally unique identifier). The virtual machine is

UUID (Universal restored with the same UUID that it had before the restore. This

Unique Identifier) option requires that the previous virtual machine (the one that
was backed up) has been deleted, so that the UUID is free.

Note: If the UUID exists, the restore fails.

The default (no identify restore) makes sure that the display
name of the new virtual machine (created by the restore) does
not already exist. The virtual machine that the restore creates
is given a new UUID.

Strip network Verifies that the virtual machine that the restore creates does
information from  not have the same IP address as the virtual machine that was
the virtual machine backed up. The network information is deleted at the time of
that has been the restore.

restored The default is to retain the IP information. Use the default if:

m You have already deleted the virtual machine that was backed
up, and

m You want the restored virtual machine to keep the same IP
information as the original virtual machine.

Remove backing Does not restore hardware backing information from the original
information for image. Default settings are substituted.

devices like

DVD/CD-ROM

drives, serial or

parallel ports

m Restore all virtual machine files to the staging machine
Restores all virtual machine files to the staging host. NetBackup does not
restore the files to the virtual machine server. If not restoring to the original
location, you can use the VMware Converter to restore the virtual machine
from the staging host to the Virtual machine server.
See your VMware documentation.

The Restore Destination Choices are as follows:

m Virtual machine server
By default, this field shows the server that was stored in the backup image
information. You can use that server as the restore destination, or enter a
different virtual machine server as the destination.

m Staging machine for restoration
Select or enter the recovery host to which the VMware files are temporarily
restored. If you chose Restore all virtual machine files to a virtual machine
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server automatically using VMware Converter, the files are restored to the
Virtual machine server and deleted from this staging server.

The default is the backup host that was used for the backup. The name of that
backup host is stored in the backup image information. On this dialog box, the
pull-down list for staging hosts includes the VMware backup hosts that are
defined in existing NetBackup policies.

Restore staging location

Enter a Windows file path on the staging host to which the virtual machine
files are temporarily restored. The default is the VMware backup host mount
point that was stored in the backup image information.

The Override default priority options are the following:

m Override default priority
Place a check mark in this box to override the default priority.

m Job priority
Use this field to set a higher priority.

About restore of individual files

You can use either of the following procedures to restore files individually.

One-stage process Restore individual files to the virtual machine by restoring to the
recovery host. The virtual machine drives that are the destination
for the restore must be configured in one of the following ways:

m Windows only: The virtual machine drives must be shared
through the guest operating system on the virtual machine.
See “Setting up NetBackup Client Service for restore to a
Windows shared virtual machine drive” on page 146.

m  NetBackup client software must be installed on the VMware
virtual machine.

Two-stage process  Restore individual files from the VMware recovery host to a
NetBackup client (not to the virtual machine). See the NetBackup
Backup, Archive, and Restore Getting Started Guide on how to restore
to different locations.

Then manually copy the restored files to the virtual machine.
(NetBackup does not perform this step.)

Note: Individual file recovery is supported from full backups and from incremental
backups, as long as the Enable file recovery from VM backup policy option is
enabled.
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Restoring individual files

If the VMware backup was made with the Enable file recovery from VM backup
option, you can restore individual files.

See “Optimizations options (VMware)” on page 52.
To restore individual files

1 Inthe NetBackup Backup, Archive, and Restore interface, specify the source
client and destination client and the type of policy:

For UNIX systems, on the Restore Files tab, click the Restore icon:

=]

For Windows systems, click Files > Specify NetBackup Machines and Policy
Type.

2 Specify the following:

Server to use for The NetBackup master server that directed the backup.
backup andrestores

Source client for The VMware virtual machine that was backed up.
restores

Enter the type of name that was selected for the Primary VM
identifier option on the policy VMware tab. For example, if
the Primary VM identifier option is set to VM host name, enter
the virtual machine's host name.

Destination client  Specify one of the following:

for restores m The host name of the VMware virtual machine that was

backed up, if NetBackup client software has been installed
on the virtual machine.
Specify the host name even if the policy identified the
virtual machine by its VMware display name, UUID, or DNS
name. Do not enter the VMware display name, UUID, or
DNS name.

m The NetBackup recovery host.

Note: The NetBackup Client Service must be logged on as
Administrator.

See “Setting up NetBackup Client Service for restore to a
Windows shared virtual machine drive” on page 146.
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Policy type for The type of policy that made the backup.
restores

Select the type of restore, as follows:
m For UNIX systems, on the Restore Files tab, select Normal Backups.

m For Windows systems, click Files > Select Files and Folders to Restore >
from Normal Backup

For UNIX systems enter the Browse directory that contains the directories
or files to restore.

See “About restore of individual files” on page 144.
Click the files you want to restore.

Start the restore, as follows:

m On UNIX systems: Click Restore.

m On Windows systems: Click Actions > Restore....

For Windows systems, if NetBackup client software is not installed on the
destination virtual machine, select one of the following:

m Restore everything to a different location

m Restore individual folders and files to different locations
Destinations must be entered as UNC path names that refer to shared
drives on the virtual machine.

For example, to restore the file E: \folder1\filel on virtual machine vm1,
enter the following destination:

\\vml\e$\folderli\filel

The NetBackup Client Service must be logged on under an account that has
Administrator privileges.

See “Setting up NetBackup Client Service for restore to a Windows shared
virtual machine drive” on page 146.

See “About restore of individual files” on page 144.

Setting up NetBackup Client Service for restore to a Windows shared
virtual machine drive

To restore individual files to a Windows virtual machine that has a shared drive,
note: the NetBackup Client Service must be logged on under an account that has
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Administrator privileges (not as the Local System account). An account with
Administrator privileges lets NetBackup write to the directories on the virtual
machine to which the data is restored.

If you try to restore files while the NetBackup Client Service is logged on as the
Local System account, the restore fails.

To log on the NetBackup Client Service as Administrator

1 In Windows Services on the VMware recovery host, double-click the
NetBackup Client Service.

2 Check the Log On tab: if the service is not logged on under an account that
has Administrator privileges, stop the service.

3 Change the logon to the Administrator account, or to an account that has
Administrator privileges.

The account must have Administrator privileges in the domain in which both
the virtual machine and the VMware backup host reside.

4  Restart the service.

Retry the restore.

About the NetBackup.lost+found directory on Linux

Note: You can ignore this section if: you have installed the SYMCquiesce utility
on your virtual machines, and your virtual machines meet the requirements for
the SYMCquiesce utility.

See “About the SYMCquiesce utility” on page 179.
See “Installing the SYMCquiesce utility” on page 180.

Without the SYMCquiesce utility, a snapshot of a Linux virtual machine may be
in an inconsistent state (sometimes called crash-consistent). In other words, the
snapshot data is equivalent to the state of a file system after an abrupt,
uncontrolled shutdown. When the virtual machine is restarted, a file system
consistency check (fsck) reports inconsistencies that need repair.

To handle inconsistent data from backups of crash-consistent Linux virtual
machine snapshots, NetBackup creates a NetBackup. lost+found directory for
each Linux volume. This directory is not a physical directory on the volume but
avirtual directory in the NetBackup catalog. Any inconsistent directories or files
are linked to the NetBackup.lost+found directory. The names of the inconsistent
directories and files cannot be determined: the items in the NetBackup.lost+found
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directory are therefore assigned the names that represent the inode numbers of
the original directories or files.

If a NetBackup.lost+found directory already exists on the virtual machine,
NetBackup appends numbers to the new NetBackup.lost+found directory names,
to keep them unique. The directories are named NetBackup.lost+found.1,
NetBackup.lost+found.2, and so forth.

Note: The NetBackup.lost+found directory is not the same as the standard Linux
lost+found directory that Linux maintains in case of an abnormal system
shutdown.

The following Backup, Archive, and Restore screen shows examples of inconsistent
directories and files in a NetBackup.lost+found directory. This example also shows
the standard Linux lost+found.

;_Tl ackup, Archive, and Restore - NetBackup - [Restore: Server: turba Source Client: grayvml - rh5 Destination Client: turba]
MetBackup History
2010
apr
14 13 12 11 10
sg o @
o @
@

All Folders

=018 grayvm! - ths |
+-[J (3 .automount

Contents of NetBackup.lost-+Found]

[ Time Backed Up [ attributes Size [ Time Modfied |
4f13/2010 6:14:36 PM d-—- 0 2/19/2010 7:02:39 PM
4f13/2010 6:14:36 PM d— 2§22/2010 2:42:06 PM
4f13/2010 6:14:36 PM d-—- 0 3 2010 8:14:15PM
4f13/2010 6:14:36 PM d— 0 3i24/2010 5:14:15 PM
4f13(2010 6:14:36 PM - 808 3 2010 &:14:15PM
4f13/2010 6:14:36 PM 609

hame

O recavered.inode. 2526589
[ [ recovered.inode, 2526595
O recoverad.inade. 2526597
O recovered.inode, 2526599
O[E) recovered.inade. 360463
|2 recovered.inode. 5308444

o

2,
24,
24
24,

J
i
i
i
ﬂ

2/22{2010 2:42:06 PM

b

(23 lost+Found

(21 media

(3 misc

(23 mnt

(Cd net

[ FriekE ackup. lost -+ Found:
(0 recovered.inode. 2526589
[ recovered.inode. 2526595
[ recovered.inode. 2526597
[ recovered.inode. 2526599

[

In the NetBackup Backup, Archive, and Restore interface, you can search the
NetBackup.lost+found directory for any inconsistent items and restore them.
Symantec recommends that you restore them to an alternate location (not to the
original virtual machine). You can then examine their contents to determine their
original names. Any metadata that was captured at the time of the backup may
be helpful in identifying the inconsistent files or directories. Examples of such
metadata are file size, file owner, and file creation and modification dates.
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If the recovery host is not at the same NetBackup
release level as the backup host

Note the following about mixed-level backups and restores:

m To restore from a NetBackup 7.x backup
To restore a virtual machine from a backup that a NetBackup 7.x backup host
performed, a NetBackup 7.x recovery host is required. You cannot use a
NetBackup 6.5.x recovery host to restore a virtual machine that was backed
up by a NetBackup 7.x backup host.

m To restore from a NetBackup 6.5.x backup
To restore a virtual machine (or selected files) from a NetBackup 6.5.x backup,
the VMware Converter must be installed on the NetBackup recovery host. The
recovery host can run NetBackup 6.5.x or 7.x. A staging area is required.
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Best practices and more
information

This chapter includes the following topics:

NetBackup for VMware best practices
More information on VMware

Further assistance with NetBackup for VMware

NetBackup for VMware best practices

The following are best practices for NetBackup for VMware:

For a more efficient backup, the NetBackup media server and the VMware
backup host should be installed on the same host.

When creating virtual machines, use the same name for both host name and
display name. If the policy's Primary VM identifier option is changed, the
existing entries on the policy Clients tab still work.

VMware recommends that you run no more than four simultaneous backups
of virtual machines that reside on the same datastore.

Successful VMware snapshots depend on the following:

m The amount of I/O that occurs on the virtual machine datastore. Backups
should be scheduled when relatively little I/O activity is expected. Reducing
the number of simultaneous backups can also help.

Limit access to the datastore per policy: Use the Limit jobs per policy
attribute in the NetBackup policy.

Limit access to the datastore globally (across all policies): Use the Host
Properties Resource Limit screen.
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See “Setting global limits on the use of VMware resources” on page 44.

m The design of the I/O substructure that is associated with each virtual
machine datastore. For correct I/O design and implementation, consult
your VMware documentation.

m Make sure that the VMware backup host has enough memory to handle the
number of simultaneous backups that occur.

m Include in a single NetBackup policy those virtual machines that use the same
datastore. This practice lets you control the amount of backup-related I/O that
occurs per datastore, to limit the backup effect on the target virtual machines.

m NetBackup supports multiple backup hosts. When a single backup host is
saturated with a backup process, another backup host can be added to increase
backup throughput.

m Upgrade to the latest version of VMware vSphere or Virtual Infrastructure.

m See the Symantec white paper titled NetBackup for VMware Best Practices
Guide.

NetBackup for VMware with deduplication

For a VMware backup to a deduplication storage unit, select the Enable file
recovery from VM backup option on the VMware policy tab. This option provides
the best deduplication rates. Without the Enable file recovery from VM backup
option, the result is a lower rate of deduplication.

More information is available on the VMware options.

See “Backup options on the VMware tab” on page 51.

More information on VMware
VMware Inc. provides an extensive set of manuals on VMware products.

http://www.vmware.com/support/pubs/
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Further assistance with NetBackup for VMware

Table 10-1 Sources of information on NetBackup for VMware
Topic Source
Snapshot Client Refer to the NetBackup Snapshot Client Administrator's Guide.
configuration The guide contains installation and configuration instructions

on Snapshot Client.

list of all supported
combinations of
platforms and snapshot
methods

Refer to the NetBackup 7 Snapshot Client Compatibility
document:

http://www.symantec.com/docs/TECH126901

Support information on
NetBackup for VMware

Up-to-date information on NetBackup support in a virtual
environment is available in the following tech note:

Support for NetBackup 7.x in a virtual environment
http://www.symantec.com/docs/TECH127089

This tech note provides a wide range of support information,
such as a list of supported guest operating systems, file systems,
and required VMware components.

153


http://www.symantec.com/business/support/index?page=content&id=TECH126901
http://www.symantec.com/docs/TECH127089

154 | Best practices and more information
Further assistance with NetBackup for VMware



Troubleshooting

This chapter includes the following topics:

NetBackup logging for VMware

VMware environment—important!

Preventing browsing delays caused by DNS problems
Changing the browsing timeout for virtual machine discovery
Changing timeout and logging values for vSphere

Notes on troubleshooting NetBackup for VMware

Credentials for VMware server are not valid

NetBackup status codes related to VMware

Snapshot error encountered (status code 156)

The restore fails when you restore individual files to a virtual machine that
has NetBackup client software

The restore fails if ESX servers use short host names and backups and restores
use a vCenter server

Backup or restore job hangs

Mount point missing on a restored Windows virtual machine

Mount points not available when restoring files from a Linux virtual machine
Remove the Consolidate Helper snapshot

NetBackup catalog information for virtual machine backups made by 6.5.4 or
earlier may prevent browsing the imported images for restore
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m Invalid client error when you restore files using NetBackup BAR interface
installed on the virtual machine

m VMware virtual machine does not restart after restore

NetBackup logging for VMware

For log messages about VMware backup or VMware restore, see the following
NetBackup log directories.

Table 11-1

NetBackup logs that pertain to VMware backup and restore

Log directory

Contains the messages
on

Resides on

install_path\NetBackup\logs\bpbrm

Backup and restore

NetBackup master or media server

install_path\NetBackup\logs\bptm

Backup and restore

NetBackup media server

install_path\NetBackup\logs\bpfis Snapshot creation and VMware backup host
backup

install_path\NetBackup\logs\bpcd Snapshot creation and VMware backup host
backup

install_path\NetBackup\logs\bpbkar Backup VMware backup host

install_path\NetBackup\logs\bprd Restore NetBackup master server

install_path\NetBackup\logs\tar Restore VMware recovery host

install_path\NetBackup\logs\bpVMutil

Policy configuration and on
restore

VMware backup or recovery host

install_path\NetBackup\logs\bpVMreq

Restore

The client where the Backup, Archive,
and Restore interface is running.

install_path\NetBackup\logs\nbproxy

Policy configuration

VMware backup host

install_path\NetBackup\logs\ncfnbcs
(originator ID 366)

ncfnbcs uses unified logging. See the
NetBackup Troubleshooting Guide for

information on how to use unified logs.

Automatic virtual machine
selection

VMware backup host.

Note: Except for ncfnbcs, these log directories must already exist in order for
logging to occur. If these directories do not exist, create them.
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To create the log directories, run the following command on the NetBackup servers
and backup host:

Windows:

install path\NetBackup\logs\mklogdir.bat
UNIX (on master or media servers):
/opt/openv/netbackup/logs/mklogdir

More detail is available on snapshot logs and logging levels. See the NetBackup
Snapshot Client Administrator’s Guide.

A broader discussion of NetBackup logging is available. See the NetBackup
Troubleshooting Guide.

Other logs for troubleshooting NetBackup for VMware

The following may also contain valuable backup information.

Table 11-2 Other logs for VMware
Log directory Contains the messages on | Resides on
\Program Files\Common File mapping during backup | VMware backup host

Files\VERITAS\VxMS\Logs

See “Enabling VxMS logging
for NetBackup for VMware”
on page 157.

Note: The use of VxMS
logging can reduce the
performance of the backup
host.

More information is available on VxMS logging:

http://www.symantec.com/docs/TECH72862

Enabling VXMS logging for NetBackup for VMware

VxMS logging may require significant resources on the VMware backup host.

To enable VxMS logging

1 Onthe Windows desktop of the backup host, click Start > Run and enter

regedit.

2 Tobe on the safe side, make a backup of the current registry (File > Export).
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Go to HKEY_LOCAL_MACHINE > SOFTWARE > Veritas > VxMS.

Change the Logging DWORD value to 7580 in hexadecimal. The value appears
in the Registry as 0x00007580 (30080).

The next time VXMS is run, it creates a log (for example
VxMS-1832-MMDDYY.log). The log is in \Program Files\Common
Files\VERITAS\VxMS\Logs. The Logs directory is created automatically if it
does not exist.

VMware environment—important!

Unsupported equipment can cause many problems. Ensure that your VMware
environment (including ESX servers, SAN devices, and backup host) conforms to
all requirements and recommendations that are spelled out by VMware. For
instance, if VMware does not support your HBAs, device drivers, or guest operating
systems, NetBackup cannot work.

For support details, see VMware documentation at the VMware support site (for
example, the VMware compatibility guides).

Preventing browsing delays caused by DNS problems

NetBackup may be unable to identify virtual machines when you use the Browse
for Virtual Machines dialog. Virtual machine host names may not be properly
configured in your Domain Name Server system (DNS), or the DNS system may
be slow. A timeout message may appear, or messages similar to the following may
appear in the NetBackup detailed status log:

17:25:37.319 [12452.10360] get vSphere VMs: Processing vm 002-wcms

17:25:37.319 [12452.10360] get vSphere VMs: uuid
42128b46-063d-f4bd-e674-9ad3707ee036

17:25:37.319 [12452.10360] get vSphere VMs: vmxdir [san-05] 002-wcms/
17:25:37.319 [12452.10360] get vSphere VMs: datastore san-05
17:25:37.319 [12452.10360] get vSphere VMs: IpAddress 172.15.6.133

17:25:41.866 [12452.10360] get vSphere VMs: retry gethostbyaddr for
172.15.6.133 failed with The requested name is valid, but no data of
the requested type was found.

Note: NetBackup may be unable to determine the host names of the virtual
machines from their IP addresses (reverse lookup may fail).
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To prevent browsing delays caused by DNS problems

1

On the Windows desktop of the backup host, click Start > Run and enter
regedit.

To be on the safe side, make a backup of the current registry (File > Export).

Go to HKEY_LOCAL_MACHINE > SOFTWARE > Veritas > NetBackup >
CurrentVersion > Config and create a key that is called Backup.

Create a new DWORD under BACKUP, called disableIPResolution.

This registry key causes NetBackup to use the virtual machine's IP address
as the virtual machine's host name.

Use the NetBackup Browse for Virtual Machines screen to rediscover the
virtual machines to show the host names set to the IP addresses.

See “Browse for VMware Virtual Machines” on page 61.

Changing the browsing timeout for virtual machine

discovery

In the NetBackup Administration Console on Windows, you can adjust the time
available for browsing for virtual machines in the NetBackup policy.

To change the browsing timeout value

1

2
3
4

In the NetBackup Administration Console on Windows, click on Policies.
From the main menu, click View > Options, then click the Policies tab.
Adjust the VMware connect timeout value.

Click OK.

Changing timeout and logging values for vSphere

The following are vSphere registry keys and their default values for various

timeouts.

Table 11-3 Registry keys and defaults for vSphere timeouts
DWORD registry key name Default value (in seconds)
jobtimeout 900

poweroptimeout 900
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Table 11-3

Registry keys and defaults for vSphere timeouts (continued)

DWORD registry key name

Default value (in seconds)

snapshottimeout 900
registertimeout 180
browsetimeout 180
connecttimeout 300

The registry key and default for the vSphere API logging level are the following.

Table 11-4

Registry key and default for vSphere API log level

DWORD registry key name

Default value

vmcloglevel

0 (no logging)

To change vSphere timeouts and logging values

1 On the Windows desktop of the backup host, click Start > Run and enter

regedit.

2 Tobe on the safe side, make a backup of the current registry (File > Export).

Go to HKEY_LOCAL_MACHINE > SOFTWARE > Veritas > NetBackup >
CurrentVersion > CONFIG and create a key that is called Backup.

4  Tochange a timeout value, create a new DWORD under BackuPp, using the

appropriate registry name (such as jobtimeout Or poweroptimeout).

Enter a value for the timeout.

5 To change the level of vSphere API logging, create a new DWORD called
vmcloglevel and enter the new logging value.

The allowed values are 0 through 6, where 0 is no logging and 6 is the highest

log level.

Note the following:

Notes on troubleshooting NetBackup for VMware

m Make sure that the VMware Tools are installed on each virtual machine.
Otherwise, communication problems and other issues can result.

m You cannot restore individual VMware files onto the virtual machine itself,

except under certain conditions.
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See “About restore of individual files” on page 144.

m NetBackup for VMware does not work with the VMware NetBackup Integration
Module (VNIM).

Note the following:

m If VNIMis installed, do not configure a NetBackup for VMware policy (with
the VMware snapshot method) to call any scripts that use VNIM. Such a
policy results in a backup that fails.

m Do not run any NetBackup for VMware policy at the same time as a
script-based policy that calls VNIM. If the two policies require access to
the same virtual machine, a conflict may result and the backup may fail.

Credentials for VMware server are not valid

A number of issues can prevent NetBackup from gaining access to the ESX server
or vCenter server. When you add credentials for a VMware server (Add Virtual
Machine Server dialog), NetBackup validates the credentials when you click OK.
If the credentials do not pass validation, a pop-up message appears.

Problems can result for a variety of reasons, including the following:

B Anincorrect virtual machine server name. Make sure that the server name is
entered correctly.
More information is available about changing the server name that is stored
in NetBackup.
See “Changing the host name of a VMware server in NetBackup” on page 42.

® An invalid user name or password. Make sure that a valid user name and
password were entered correctly.

m Anincorrect port number. Make sure that the port number is correct on the
NetBackup Change Virtual Machine Server dialog. If the VMware server uses
the default port, no port specification is required. You can uncheck the Connect
using port number box.

® You do not have enough privileges to perform backups or restores. (Note
however that lack of sufficient privileges may not cause the credential
validation to fail.)
For general guidelines for permissions, see the following:
http://www.symantec.com/docs/TECH128513
For the minimum permissions needed to back up and restore with vStorage,
see the following:
http://www.symantec.com/docs/TECH130493

See “Adding NetBackup credentials for VMware” on page 40.
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NetBackup status codes related to VMware

This topic provides assistance for NetBackup status codes relating to NetBackup
for VMware.

Table 11-5 NetBackup status codes related to VMware

NetBackup
status code

Explanation and recommended action

6, the backup
failed to back up
the requested
files

This error can occur for the following reasons:

m The virtual machine and the alternate client virtual machine may contain too many disks. If
the total is too great for the alternate client SCSI controllers, a backup with the hotadd
transport mode fails. The following appears in the job status log: ERR - Error opening
the snapshot disks using given transport mode: Status 23.

Add more SCSI controllers to the alternate client virtual machine.

m If the VMware backup host cannot access the datastore over the selected transport mode, the

backup fails. The detailed status log on the backup host may contain the following:

12/4/2009 1:12:34 PM - Error bpbrm(pid=21376) from client vm4: ERR -
Error opening the snapshot disks using given transport mode: Status 23.

Select a different transport mode and retry the backup.

m For the backups that use the hotadd transport mode: The backup host was unable to resolve
the host name of the ESX server. This error may occur if DNS is not correctly configured on
the virtual machine where the backup host is installed. On the virtual machine, you can enter
the IP address of the ESX server into the hosts file:
\Windows\System32\drivers\etc\hosts

m For the backups that use the hotadd transport mode: If the virtual machine to back up and
the virtual machine that contains the hotadd backup host do not reside in the same VMware
datacenter, the backup fails. For a successful hotadd backup, the two virtual machines must
be in the same VMware datacenter.

m A previous hotadd backup of the virtual machine may have failed. Certain mount directories
or cloned disks must be manually removed to allow hotadd backups to succeed, as follows:

m During a hotadd backup, VMware creates a linked clone of the virtual machine's disks and
attaches the cloned disks to the backup host. (The attached disks can be seen in the vSphere
Client interface.) If a hotadd backup of the virtual machine fails, NetBackup may be unable
to remove the cloned disks from the backup host. In the backup host, the presence of the
cloned disks prevents subsequent backups from completing.

Remove the cloned disks from the VMware backup host and retry the backup.

® During a virtual machine backup, VMware creates mount directories in the
C:\Windows\Temp folder on the backup host. After the backup, VMware automatically
removes the mount directories. In some cases, such as when the backup uses the hotadd
transport mode, NetBackup may be unable to remove the mount directories.

Remove the mount directories from the \Temp folder and retry the backup. The folder
name contains a string such as VMware-System.
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Table 11-5 NetBackup status codes related to VMware (continued)

NetBackup
status code

Explanation and recommended action

20, invalid
command
parameter

For the Backup Media Server option, the storage unit that is specified in the policy must be
unique to your Windows media servers. If the storage unit is also available on a UNIX media
server, the snapshot job cannot succeed.

156, snapshot
error
encountered

A number of different issues can cause this error.

See “Snapshot error encountered (status code 156)” on page 165.

227, no entity
was found

Torestore selected files (not the entire virtual machine) to the original location, you must specify
the host name of the virtual machine. Do not specify the display name or UUID as the destination.
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Table 11-5 NetBackup status codes related to VMware (continued)

NetBackup
status code

Explanation and recommended action

2817, 2820

A virtual machine restore may fail in the following cases:

m If an .ISO file was presented to a virtual machine as a virtual CD or DVD during backup, note:

The ISO file must be available on the destination host. If the ISO is not available on the host
where you restore the virtual machine, the restore fails. The vCenter interface may include
the message Invalid configuration for Device '1'.

The VMware restore host is on Windows Server 2008 but the SAN LUNs are offline.

The detailed status log that is in the NetBackup Activity Monitor includes the message Virtual
machine restore: file write failed.If the restore host is on Windows Server 2008
and you use the SAN transport mode, you must manually change the SAN LUNs to be online.
For restores that use the hotadd transport mode: If the virtual machine to restore and the
virtual machine that contains the hotadd restore host do not reside in the same VMware
datacenter, the restore fails. For a successful hotadd restore, the two virtual machines must
be in the same VMware datacenter.

For vStorage: The restore host cannot access the VMware datastore over the selected transport
mode. The job log on the restore host may contain messages such as the following:

13:27:36 (19400.001) FTL - Virtual machine restore: VxMS initialization
failed

Select a different transport mode and retry the restore.

You attempted to restore a file that has a path name longer than 1023 characters.

Note that a backup of a Linux virtual machine backs up all files, including those with path
names longer than 1023 characters. A restore of the entire Linux virtual machine recovers
all files. But you cannot restore the long path-name files individually.

If the ESX servers are configured with short host names (not fully qualified), NetBackup may
not find the ESX server for the restore.

See “The restore fails if ESX servers use short host names and backups and restores use a
vCenter server” on page 166.

For the restore, the virtual machine's hardware version (such as 7) is later than the hardware
version that the target server supports. If VMware Tools cannot convert the virtual machine's
hardware version to an earlier version, the restore fails. Messages similar to the following
appear in the bpVMutil log:

09:18:51.717 [5472.4724] <2> createVMwareVM: Create virtual machine
failed for acmehost.com with 6

09:18:51.717 [5472.4724] <2> bpVMutil main: Create VMware VM failed
09:18:51.717 [5472.4724] <2> bpVMutil main: EXIT STATUS 5: the restore
failed to recover the requested files

If possible, restore the virtual machine to a VMware server that supports the virtual machine's
hardware version.
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Snapshot error encountered (status code 156)

The following table describes the VMware issues that relate to NetBackup status

code 156.

Table 11-6 Possible causes of status code 156

Causes of status code
156

Description and recommended action

NetBackup cannot obtain
the volume ID of a drive

NetBackup may not be able to obtain the volume ID of a drive. In that case, none of the
virtual machine drives are backed up. The backup fails with NetBackup status code 156.

The drive may be down.

A backup of the virtual
machine is already active

You cannot run more than one backup per virtual machine at a time. If you start a second
backup of the virtual machine while the first backup is active, the second job fails with
a status 156.

Recommended action: Wait until the first job completes, then run the second one.

Cannot find virtual
machine name

NetBackup cannot find the host name or VMware display name of a virtual machine that
is listed in the backup policy. The detailed status log may include the following error
message:

Critical bpbrm (pid=<pid number>) from client <client name>:
FTL - snapshot creation failed, status 156.)

If the virtual machines do not have static IP addresses, you can configure NetBackup to
identify virtual machines by their VMware display names or UUIDs. Examples of the
environments that do not use static IP addresses are clusters, and the networks that
assign IP addresses dynamically.

Note that NetBackup may have been configured to identify virtual machines by their
VMware display names. In that case, make sure that the display names are unique and
that they do not contain special characters.

See “Primary VM identifier options (VMware)” on page 53.

The virtual machine is
powered off

Through a vCenter server, NetBackup can back up the virtual machines that are powered
off. You must provide credentials for NetBackup to access the vCenter server.

See “Adding NetBackup credentials for VMware” on page 40.

If NetBackup uses credentials for an ESX server instead of vCenter, it may not be able to
identify a powered off virtual machine. Note the following:

m If the policy uses VM hostname or VM DNS name as the Primary VM identifier,
NetBackup may not find the virtual machine. The backup fails.

m If the policy uses VM display name or VM UUID as the Primary VM identifier,
NetBackup can identify the virtual machine. The backup succeeds.

165



166 | Troubleshooting

The restore fails when you restore individual files to a virtual machine that has NetBackup client software

Table 11-6 Possible causes of status code 156 (continued)

Causes of status code
156

Description and recommended action

The virtual machine disk
is in raw mode (RDM)

The RDM is ignored (not backed up) and any independent disk is recreated but empty.
See “Configurations for backing up RDMs” on page 174.

The attempt to create a
snapshot exceeded the
VMware timeout

If the attempt to create a snapshot of the virtual machine exceeds the VMware timeout
of 10 seconds, the snapshot fails with NetBackup status 156. This timeout may occur if
the virtual machine is configured with a large number of volumes. Note that the timeout
may be encountered even if the Virtual machine quiesce option was disabled.

Do one of the following:

m Reduce the number of volumes within the virtual machine.

m Install a NetBackup client on the virtual machine and select another backup method
for the policy (not the VMware snapshot method).

The virtual machine has
no VMDK file assigned

The snapshot fails if the virtual machine has no vindk file.

This situation can occur in a VMware vCenter Site Recovery Manager (SRM) environment.
In an SRM environment, a replicated virtual machine in passive mode may have no vimndk
file. If NetBackup attempts to back up a replicated virtual machine that has no vindk file,
the snapshot fails.

You can enable the Ignore diskless VMs option on the VMware Advanced Attributes
tab of the policy. This option tells NetBackup not to attempt a backup of any virtual
machine that has no vmdk file.

The restore fails when you restore individual files to
avirtual machine that has NetBackup client software

When you restore individual files to a virtual machine that has a NetBackup client,
make sure that a firewall does not interfere with the restore. If a firewall stops
the restore, turn off the firewall and retry the restore.

The restore fails if ESX servers use short host names
and backups and restores use a vCenter server

In the following case, the attempt to restore the virtual machine fails:

m The ESX servers in your VMware environment are configured with short host

names (not fully qualified), and
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m Thebackup was performed through a vCenter server, not directly from an ESX
server, and

m Therestoreis directed through a vCenter server, not directly to an ESX server.

In this case, NetBackup cannot find the ESX server for the restore. Restore of the
virtual machine fails, and the following message appears in the bpvmuti1 log:

FAILED_TO GET_MOR_BY NAME

To restore virtual machines through a vCenter server in environments with short
ESX host names

1 On the Windows desktop of the backup host, click Start > Run and enter
regedit.

To be on the safe side, make a backup of the current registry (File > Export).

Go to HKEY_LOCAL_MACHINE > SOFTWARE > Veritas > NetBackup >
CurrentVersion > Config and create a key that is named Backup.

4  Right-click in the right pane and click New > DWORD Value. Enter
disableFQDN as the name.

Backup or restore job hangs

NetBackup may have exceeded the maximum number of allowed VMware NFC
connections to the ESX server when it used the transport modes nbd or nbdssl.
Note that NetBackup uses one NFC connection per virtual disk on the ESX or ESXi
server.

If NetBackup is configured to access the ESX server directly (not through a vCenter
or VirtualCenter server), fewer connections are allowed. The following are the
maximum connections as set by VMware:

Table 11-7 VMware NFC connection limits for nbd or nbdssl transfers
ESX version Type of access to the ESX | Maximum NFC
server connections allowed

ESX 3.5 Directly to ESX server 9

ESX 3.5 Through vCenter 27

ESX 4 Directly to ESX server 9

ESX 4 Through vCenter 27

ESXi4 Directly to ESX server 11
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Table 11-7 VMware NFC connection limits for nbd or nbdssl transfers
(continued)
ESX version Type of access to the ESX | Maximum NFC
server connections allowed

ESXi4 Through vCenter 23

ESXi5 Directly to ESX server The maximum total for all
NFC connection buffers to an
ESXi host is 32 MB

ESXi5 Through vCenter 52

Try a different transport type (such as SAN or hotadd). If a different transport
type is not available and NetBackup accesses the ESX servers directly, set up
access through a vCenter (or VirtualCenter) server. Use of a server increases the
maximum number of allowed connections. For example: With 27 connections,
NetBackup can access a virtual machine that has up to 27 disks, if the ESX 4 server
is behind a vCenter server.

Note that the connection limits are per-host (that is, per vCenter or ESX server).
For example, assume the following environment:

m An ESX 4.0 server with three virtual machines.

m  Each virtual machine has 10 virtual disks.

m The virtual machines are behind a vCenter 4.0 server.

For a simultaneous backup of the three virtual machines, NetBackup requires 30
NFC connections. With a limit of 27 NFC connections per vCenter server, any of
the three backup jobs may hang.

These limits are described in the VMware Virtual Disk API Programming Guide:
VMware Virtual Disk API Programming Guide
See also the following section of the VMware vSphere 5 Documentation Center:

Virtual Disk Transport Methods

Mount point missing on a restored Windows virtual

machine

A Windows virtual machine may fail to write its mount point configuration to
disk (the mount point configuration remains in RAM). In that case, the mount
point information cannot be backed up. When the virtual machine is restored,


http://www.vmware.com/support/developer/vddk/vddk11_api_programming.pdf
http://pubs.vmware.com/vsphere-50/index.jsp?topic=/com.vmware.vddk.pg.doc_50/vddkDataStruct.5.5.html&path=5_4_0_2_3_1
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the data from the mounted volume is restored, but the mount point is absent from
the restored virtual machine.

Reassign the mount point on the restored virtual machine. To make sure the
mount point is correctly configured, restart the virtual machine.

Mount points not available when restoring files from
a Linux virtual machine

For Linux virtual machines, only the ext2, ext3, and ext4 file systems are supported
for individual file restore. If a partition is formatted with some other file system,
the backup succeeds but NetBackup cannot map the file system addresses of the
files. As a result, NetBackup cannot restore individual files from that partition.
Only the files that were on ext2, ext3, or ext4 partitions can be individually
restored.

Note also: to restore individual files from their original mount points, the "/" (root)
partition must be formatted as ext2, ext3, or ext4. If the "/" (root) partition is
formatted with a different file system (such as ReiserFS), the mount points cannot
be resolved. In that case, you can restore ext2, ext3, or ext4 files from the /dev
level (such as /dev/sdal). You cannot restore the files from their original mount
point level.

Remove the Consolidate Helper snapshot

If a datastore is out of space when you attempt to delete snapshots, VMware
creates a snapshot named Consolidate Helper. You should manually delete this
snapshot before the next backup. Otherwise, change files may accumulate on the
datastore. The accumulation of such files can affect both the backup performance
and the I/O performance of the virtual machine.

For more information, see the following VMware knowledge base article about
deleting the Consolidate Helper snapshot:

http://kb.vmware.com/kb/1003302

NetBackup catalog information for virtual machine
backups made by 6.5.4 or earlier may prevent
browsing the imported images for restore

If you import a NetBackup 6.5.4 or earlier virtual machine backup image to a
NetBackup 7.x system, note: the catalog header file of the imported image may
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have the wrong value for VM_TYPE. The value of the imported image may be
incorrectly reported as 0 even for type 1 (Full VM) and type 2 (Mapped full VM)
backups. As a result, you cannot use the Backup, Archive, and Restore interface
to browse and restore the virtual machine image.

You must change the VM_TYPE value in the header file of the imported image to
correct this problem. For the backups that were made with the Full VM backup
option, set VM_TYPE to 1. For the backups that were made with the Mapped full
VM backup option, set VM_TYPE to 2.

For instructions, see the following tech note:

http://www.symantec.com/docs/TECH63525

Invalid client error when you restore files using
NetBackup BAR interface installed on the virtual

machine

If the virtual machine was backed up by display name or UUID, and the display
name is not the same as the host name, note: You cannot restore individual files
by means of the Backup, Archive, and Restore (BAR) interface if the interface is
installed on the virtual machine itself. The files can be restored if BAR is installed
on the master server or media server. In this case, BAR must not be installed on
the virtual machine that you want to restore to.

To restore files, the Destination client for restores field in the BAR interface
must have a valid host name or IP address.

VMware virtual machine does not restart after restore

The virtual machine may have had SCSI and IDE drives at the time of backup and
the guest OS resided on a SCSI drive. In that case, the virtual machine when
restored may attempt to boot from the IDE drive. The boot attempt fails with the
message "Operating system not found." This problem occurs when NetBackup
uses the VMware vStorage APIs.

VMware has identified this problem and will address it in a future release.

As a workaround, you can reconfigure the BIOS on the virtual machine to boot
from the correct SCSI device.
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This appendix includes the following topics:

m About the Reuse VM selection query results option

About the Reuse VM selection query results option

The NetBackup Test Query screen lists the virtual machines that NetBackup
discovered in your virtual environment. Because the automatic selection feature
is dynamic, later changes in the environment may affect which virtual machines
match the query rules. For example: if virtual machines are added, the test results
may not be identical to the virtual machines that are selected for backup when
the backup runs.

NetBackup caches the current Test Query results for a designated period rather
than rediscovering virtual machines at every backup. The option is called Reuse
VM selection query results for. During the period you specify on this option,
NetBackup reuses the current list of virtual machines as the backup list. It does
not consult the query builder or rediscover virtual machines.

The less often your virtual machine environment undergoes changes, the more
advantageous it may be to reuse the cached list of virtual machines for backups.
Note that in large environments, discovery of virtual machines takes time and
consumes resources on the vCenter server.

Note the following about the Reuse VM selection query results option:

m Determines how long the query results are reused (that is, how often the cache
is refreshed).

m Controls how often NetBackup performs discovery on the vCenter server.
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For the environments that contain many virtual machines, the discovery
process may place a significant load on the vCenter server.

m Has no effect on the NetBackup policy execution schedule.

m Isinvalidated if the query rules are changed or if the policy attributes that
affect discovery are changed. In that case, NetBackup rediscovers virtual
machines the next time the policy runs, and the cache is refreshed.

The following topic describes the policy attributes that affect discovery:
See “Effect of Primary VM identifier parameter on Selection column in Test
Query results” on page 104.

For example: assume that the Reuse VM selection query results for option is set
to eight hours. If additional virtual machines are powered on during the eight
hour period, they are not added to the policy's backup list. The policy backs up
the virtual machines that were last added to the list (such as when the policy was
created). After eight hours, at the next execution of the policy, the recently powered
on virtual machines are discovered and added to the backup list.

Note: The virtual machines that have been selected for backup are not displayed
on the policy Clients tab. To see which virtual machines NetBackup has selected
and backed up, refer to the following topics.

See “Using the Activity Monitor to monitor virtual machine backups” on page 117.

See “Using OpsCenter to report on virtual machine backups” on page 122.
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This appendix includes the following topics:

m About VMware raw device mapping (RDM)

m Configurations for backing up RDMs

m About alternate client backup of RDMs

m Requirements for alternate client backup of RDMs

m Configuring alternate client backup of RDMs

About VMware raw device mapping (RDM)

VMware raw device mapping mode (RDM) allows a virtual machine to directly
access physical disks. With raw device mapping, a VMware virtual machine can
use large storage devices such as disk arrays. Access to the data on an RDM disk
is faster than to a fully virtualized disk (vmdk file). An RDM disk can be locally
attached to the ESX server or configured on a Fibre Channel SAN.

NetBackup supports the disk arrays that are configured on a virtual machine as
RDMs.

Note: NetBackup cannot back up the RDM by means of a VMware backup host.

For notes and restrictions on NetBackup support for VMware RDM, see the
following Symantec tech note:

Support for NetBackup 7.x in virtual environments


http://www.symantec.com/docs/TECH127089
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Configurations for backing up RDMs

You can use either of the following NetBackup configurations to back up disk
arrays as RDMs:

m  Without Snapshot Client: Install a NetBackup client on the virtual machine.

You can configure NetBackup to back up the virtual machine and any RDMs
as if the client was installed on a physical host. Without Snapshot Client
software on the virtual machine, the features of Snapshot Client are not
available. (This configuration is not discussed in this NetBackup for VMware
guide.)

With Snapshot Client: Install a NetBackup client and Snapshot Client software
on the virtual machine. Configure an alternate client backup.

About alternate client backup of RDMs

Alternate client backup of an RDM consists of the following:

m The RDM disk array contains the data to be backed up. Another host containing

NetBackup client software and Snapshot Client software must have access to
the disk array. This host is the alternate client. In this configuration, the virtual
machine is called the primary client.

A snapshot of the data is created on the disk array and is mounted on the
alternate client. The alternate client creates a backup image from the snapshot,
using original path names, and streams the image to the NetBackup media
server.

The alternate client handles the backup I/O processing; the backup has little
or no effect on the virtual machine. The media server reads the snapshot data
from the alternate client and writes the data to storage.

The virtual machine and alternate client must be running the same operating
system, volume manager, and file system. For each of these I/O system
components, the alternate client must be at the same level as the primary
client, or higher level.

For complete requirements on alternate client backup, refer to the Policy
configuration chapter of the NetBackup Snapshot Client Administrator's Guide.

Requirements for alternate client backup of RDMs

To use NetBackup Snapshot Client to back up an RDM, note the following:
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m RDM devices must be configured in physical compatibility mode. You select
this mode when you create the RDM. Physical compatibility mode is not
configured in NetBackup.

For an introduction to RDM, refer to your VMware documentation. For example,
see the following VMware document:
ESX Server 3 Configuration Guide

m NetBackup may require certain OS and array configuration, depending on the
guest OS and the array. For details, see the disk arrays chapter of the NetBackup
Snapshot Client Administrator's Guide.

m NetBackup client software must be installed on the virtual machine.

m The requirements for the NetBackup for VMware feature (a backup host and
the VMware snapshot method) do not apply to backups of RDM disk arrays.
To back up RDM disk arrays, you must configure a Snapshot Client alternate
client backup.

Configuring alternate client backup of RDMs

This procedure highlights key points in creating a NetBackup alternate client
backup of a disk array that is configured as an RDM. For broader details on disk
array configuration, refer to the NetBackup Snapshot Client Administrator's Guide.
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To create an alternate client policy for a disk array that is configured as an RDM

1

Select a policy type that is appropriate for the OS of the virtual machine and
for the type of data to back up.

Refer to the Policy configuration chapter of the NetBackup Snapshot Client
Administrator's Guide.

On the policy Attributes tab in the Administration Console, click Perform
snapshot backups and Perform off-host backup.

The following is a detail from the Attributes tab.

— Snapzhot Client
™ | Ferform block leve! incremental backups
¥ Perform snapshot backups Options. ..
[ Retain shapshats for Instant Recovery
™ Hyper semver: I
¥ Perform off-host backup
Usze: If—‘«ltemate Client j
M achine: I

Select Alternate Client from the Use pull-down. Do not select VMware backup
host.

In the Machine field, enter the name of the host that is configured as an
off-host backup computer (the alternate client).

Click Options.
Select a snapshot method.

The VMware method does not apply to alternate client backup and is not
available in the list.

Select a snapshot method that is appropriate for the volume or array. For
example:

m The HP_EVA Snapclone method or other EVA method for an HP EVA
array.

m The EMC_CLARiiON_Snapview_Clone or other CLARiiON method for an
EMC CLARIiON array.
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m FlashSnap.
For FlashSnap, the following must be installed: VxVM 3.2 or later for
UNIX, VXVM 4.0 or later for Linux and AIX, or VxVM 3.1 or later for
Windows. Also, volumes must be configured over the primary host’s disks.
The VxVM FlashSnap license must also be installed.

m VSS (for Windows guest operating systems only).

The array may require additional OS and NetBackup configuration as
described in the disk arrays chapter of the NetBackup Snapshot Client
Administrator's Guide. The same guide contains more details on snapshot
methods.

If required by an array snapshot method that you selected in the previous
step, specify the Snapshot Resources.

In the policy’s Clients list, select the virtual machine on which the array is
configured as an RDM.

In the policy’s Backup Selections list, specify the disk that you want to back
up, or the files or volumes that reside on the disk.
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SYMCquiesce utility for
Linux virtual machines

This appendix includes the following topics:

m About the SYMCquiesce utility

m Requirements for the SYMCquiesce utility

m Installing the SYMCquiesce utility

m Configuration options for the SYMCquiesce utility

m SYMCquiesce logging and troubleshooting

About the SYMCquiesce utility

The SYMCquiesce utility allows NetBackup to quiesce the Linux file system.
Without this utility, NetBackup cannot guarantee that all required data has been
flushed to disk when the snapshot occurs. Any data that has not been flushed to
disk (still in memory) is not included in a snapshot. In that case, the data that is
captured in the snapshot is incomplete.

The SYMCquiesce utility quiesces the Linux file system, to guarantee that all data
has been flushed from memory to disk. Quiescing the file system allows any
pending data changes to finish before the snapshot occurs. The data in the
snapshot is complete.

The latest information on supported platforms and file systems is available in a
separate document, Support for NetBackup 7.x in virtual environments:

http://www.symantec.com/docs/TECH127089
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Note: The SYMCquiesce utility is not required for Windows virtual machines.

Requirements for the SYMCquiesce utility

Note the following requirements for the SYMCquiesce utility:

The SYMCquiesce utility supports the following Linux operating systems:
m Red Hat Enterprise Linux version 5.4 and later.
m SUSE Linux Enterprise Server 11 Update 1 and later.

The SYMCquiesce utility supports the ext3 and ext4 file systems and the LVM2
volume manager.

VMware Tools must be installed in the virtual machine.
The VMware Tools services must be running during the backup.

The NetBackup Virtual machine quiesce parameter must be enabled.
This option is in the NetBackup policy, Snapshot Client Options dialog, under
Configuration parameters.

The SYMCquiesce utility must be installed in the virtual machine.

Installing the SYMCquiesce utility

To install SYMCquiesce in Linux virtual machines

1

Make sure that VMware Tools are installed and that the VMware Tools services
are running in the virtual machine.

On the virtual machine, run the ps command as follows:
ps —e | grep vmtoolsd

If VMware Tools are running, the command returns something similar to the
following:

3068 ? 00:00:00 vmtoolsd

For assistance with installation of VMware Tools, refer to your VMware
documentation.

Copy the SYMCquiesce ISO image into the virtual machine's ESX datastore.

On the installed NetBackup packages for Windows (master server and client),
the ISO image is located in the following folder:

\NetBackup\bin\goodies\vmware-quiesce
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Attach the SYMCquiesce ISO as a CD-ROM device on the virtual machine.
The guest OS should mount the CD-ROM automatically.

From the mounted CD-ROM, install the SYMCquiesce rpm version that is
appropriate for the virtual machine platform.

The SYMCquiesce utility is installed in /opt/SYMCquiesce/.

In the NetBackup policy for the virtual machine, make sure that the Virtual
machine quiesce parameter is enabled.

VMware must be selected as the policy type. Then, on the policy VMware
tab, click Advanced.

If the Virtual machine quiesce parameter is not enabled, NetBackup cannot
quiesce the file system before the snapshot occurs. As a result, the data that

is captured in the snapshot may not be complete.

See “VMware - Advanced Attributes dialog” on page 57.

See “Configuring a VMware policy from the Policies utility” on page 48.

Configuration options for the SYMCquiesce utility

The SYMCquiesce utility includes a configuration file (/opt/SYMCquiesce/config)
that contains the following options. By default, the options are commented out
with a # character at the start of the line.

Table C-1

SYMCquiesce configuration options

Configuration option

Description

fail snapshot on failure=true/false

By default, this option is disabled. The snapshot does not fail even if
quiescence fails on a volume in the virtual machine. Enable this option to
cause the snapshot job and the backup job to fail if quiescence fails.

timeout=timeout value in

seconds

By default, this option is disabled. The SYMCquiesce utility freezes the
virtual machine volumes for three seconds during the snapshot. Enable
this option to change the timeout period.

You may need to change this timeout if the virtual machine snapshot on
the ESX server does not complete within the 3-second window.

For example:

#fail snapshot_on_failure=true

timeout=20
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In this example, the fail snapshot on failure option is commented out
(disabled), and the timeout is set to 20 seconds.

SYMCquiesce logging and troubleshooting

SYMCquiesce logs indicate whether quiescence of the Linux virtual machine
volumes was successful. SYMCquiesce logs are written to /opt /SYMCquiesce/logs.

Logging is enabled by default (no configuration step is required) and cannot be
disabled.

Log file names are of the form mmddyy.10g. When a backup runs, a new log is
created if one does not already exist for that date. A backup that runs on the 22nd
of October 2010 creates a log named 102210. 1og.

An example from a SYMCquiesce log:

Stats - Thu Oct 28 18:51:58 2010

Freeze of volume [/] returned status [0]
Thaw of volume [/] returned status [0]
Freeze of volume [/boot] returned status [0]

Thaw of volume [/boot] returned status [0]

Where:
Stats :shows the time of the log entry when volumes where being quiesced.

status [0]:no error. The freeze operation or the thaw operation completed
successfully.

status [-1]:error. The freeze operation or the thaw operation did not complete
successfully.

If the freeze and the thaw completed successfully, the volume was successfully
quiesced.

Note the following:

m You can use the logs with the fail snapshot on failure option in
/opt/SYMCquiesce/config file. If that option is enabled and snapshots fail,
consult the SYMCquiesce logs to see which volume’s quiescence fails.

m If the virtual machine has both ext2 and ext3 volumes (or ext2 and ext4), and
the fail snapshot on failure optionisenabled, the snapshot fails. ext2 file
systems do not support quiescence. You must disable the
fail snapshot on_failure option to getasuccessful snapshot of the volumes.
Note however that the ext2 volume cannot be quiesced. As a result, any data
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changes to that volume that had not been flushed to disk before the snapshot
are not included in the snapshot.
See “About the NetBackup.lost+found directory on Linux” on page 147.
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